ViewBuilder v7.0
Help
Verify that you have the most current version of this document from www.hvacpartners.com or your local Carrier office.

Important changes are listed in Document revision history at the end of this document.

CARRIER CORPORATION © 2018. All rights reserved throughout the world. i-Vu is a registered trademark of Carrier Corporation. All other trademarks are the property of their respective owners.

The contents of this guide and the associated Carrier software are property of Carrier Corporation and its respective licensors, and are protected by copyright. For more information on the software and licensing, see the About section in the software's Help menu.

The content of this guide is furnished for informational use only and is subject to change without notice. Carrier Corporation assumes no responsibility or liability for any errors or inaccuracies that may appear in the informational content contained in this guide. This document contains no technical data controlled by the EAR or ITAR.
# Contents

## What is ViewBuilder? ................................................................................................................................. 1
## What's new in ViewBuilder v7.0 ................................................................................................................... 3

### GRAPHICS .................................................................................................................................................. 5

## Working with graphics ................................................................................................................................. 6

### Getting to know ViewBuilder's Graphics Interface .................................................................................. 7
   To select objects ... ........................................................................................................................................... 8
   To move objects ............................................................................................................................................ 8
   To align, group, or layer objects .................................................................................................................... 8
   To copy an object ......................................................................................................................................... 9
   To lock or unlock objects ............................................................................................................................. 9
   To undo or redo actions ................................................................................................................................. 9

### Editing a graphic ....................................................................................................................................... 10
   To edit a graphic from the i-Vu® application in ViewBuilder .................................................................. 10
   To upload a graphic in the i-Vu® interface ................................................................................................. 11

### Creating a graphic ................................................................................................................................... 12
   To change the graphic size .......................................................................................................................... 13
   To change a graphic’s background color ..................................................................................................... 13

### Working with images on a graphic .......................................................................................................... 14
   To add an image to your graphic ................................................................................................................ 14
   To resize an image ...................................................................................................................................... 14

### Creating a CCN Universal or Comfort Controller graphic .................................................................... 15
   To map points from custom equipment files ............................................................................................ 15

### Associating Equipment Color ovals on a graphic to equipment .............................................................. 16
   To associate ovals to equipment ................................................................................................................ 16
   To link to a page other than the equipment graphic ............................................................................... 17
   To remove an association ........................................................................................................................... 18

### Editing an image on a graphic .................................................................................................................. 19
   To import an image ..................................................................................................................................... 19
   To export an image ..................................................................................................................................... 19
   To add hover text ....................................................................................................................................... 20

### Working with graphic controls ............................................................................................................... 21
   To add a control ......................................................................................................................................... 21
   Controls and their properties .................................................................................................................... 22
   To use an Equipment Color control ......................................................................................................... 30
   To add variable color to a text control ....................................................................................................... 31
   To set a control to enable/disable ............................................................................................................ 31

### Working with tables on a graphic ............................................................................................................ 33
   To add a table ............................................................................................................................................. 33
   To add text to a table .................................................................................................................................. 33
   To add a control to a table cell .................................................................................................................. 34
   Using the Table Editor ............................................................................................................................... 34

### Working with gauges on a graphic ......................................................................................................... 36
   To add an Angular gauge to a graphic ....................................................................................................... 36
   Examples of Angular Gauges ..................................................................................................................... 39
   To add a Linear Gauge to a graphic ........................................................................................................... 44
   Examples of Linear Gauges ........................................................................................................................ 46
   To use variable color expressions for gauges ......................................................................................... 51
Working with symbols on a graphic
To add a symbol to your graphic
To create a symbol in ViewBuilder

Working with grouped objects
To group objects
To edit an object in a group

Working with layers on a graphic
To show/hide a layer in the i-Vu® interface

Drawing lines and shapes on a graphic
To define drawing attributes
To draw a line
To draw a polygon
To draw a rectangle, square, ellipse, or circle
To resize or reshape a drawing

Adding links to a graphic
To add a link
To add a link to an external file
To add a link to an i-Vu® add-on

Setting objects on a graphic to show/hide in the i-Vu® interface
To set an image or control to show/hide
To set a table row to show/hide

Finding and replacing text

Editing an image in a graphic
To export an image

Creating a data table, chart, or color map from an i-Vu® report
To produce a data table
To produce a chart
To produce a color map

Miscellaneous ViewBuilder menu commands and features

Defining i-Vu® paths
Absolute path
Relative path
To have ViewBuilder write microblock path
Determining a path or microblock property

Conditional expressions in a graphic
Show/hide or enable/disable expressions
Variable color expressions
Variable text expressions
Combining expressions
Operators

Using local variables
To set objects to show/hide based on radio button selection
To set an object to show/hide based on toggle button selection
To use a local variable to test the setup of a control

Troubleshooting graphics
To find an expression or path in ViewBuilder
Error: Cannot be evaluated
Error: Path is invalid
Error: Wrong data type
Error: Set definition for location not found
Error: PrimitiveExpr - Cannot evaluate expression
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language features for i-Vu® Pro only</td>
<td>97</td>
</tr>
<tr>
<td>Creating a non-English graphic in ViewBuilder</td>
<td>97</td>
</tr>
<tr>
<td>Setting the language font</td>
<td>97</td>
</tr>
<tr>
<td>To create a Non-English graphic</td>
<td>98</td>
</tr>
<tr>
<td>Equipment Touch screens</td>
<td>100</td>
</tr>
<tr>
<td>Getting to know ViewBuilder’s Equipment Touch interface</td>
<td>102</td>
</tr>
<tr>
<td>To move objects</td>
<td>102</td>
</tr>
<tr>
<td>To align, group, and layer objects</td>
<td>103</td>
</tr>
<tr>
<td>To copy an object</td>
<td>103</td>
</tr>
<tr>
<td>To lock or unlock controls</td>
<td>103</td>
</tr>
<tr>
<td>To undo or redo actions</td>
<td>103</td>
</tr>
<tr>
<td>Creating a new Equipment Touch screen file or open an existing file</td>
<td>104</td>
</tr>
<tr>
<td>Equipment Touch screen types</td>
<td>104</td>
</tr>
<tr>
<td>To customize the Home screen</td>
<td>106</td>
</tr>
<tr>
<td>To create additional screens</td>
<td>107</td>
</tr>
<tr>
<td>To add navigation</td>
<td>107</td>
</tr>
<tr>
<td>To save, assign, and download the touchscreen file</td>
<td>107</td>
</tr>
<tr>
<td>Adding controls to Equipment Touch screens</td>
<td>108</td>
</tr>
<tr>
<td>Selecting controls on the workspace</td>
<td>109</td>
</tr>
<tr>
<td>Equipment Touch screen controls and their properties</td>
<td>110</td>
</tr>
<tr>
<td>Text and images on Equipment Touch screens</td>
<td>112</td>
</tr>
<tr>
<td>Text</td>
<td>112</td>
</tr>
<tr>
<td>Images</td>
<td>112</td>
</tr>
<tr>
<td>Conditional items in a list</td>
<td>113</td>
</tr>
<tr>
<td>Number control on Equipment Touch screens</td>
<td>115</td>
</tr>
<tr>
<td>Duration control on Equipment Touch screens</td>
<td>115</td>
</tr>
<tr>
<td>Linked button on Equipment Touch screens</td>
<td>116</td>
</tr>
<tr>
<td>On-Off-Auto control on Equipment Touch screens</td>
<td>117</td>
</tr>
<tr>
<td>Timed Local Override control on Equipment Touch screens</td>
<td>118</td>
</tr>
<tr>
<td>Checkbox control on Equipment Touch screens</td>
<td>118</td>
</tr>
<tr>
<td>Time control on Equipment Touch screens</td>
<td>119</td>
</tr>
<tr>
<td>Text Toggle control on Equipment Touch screens</td>
<td>119</td>
</tr>
<tr>
<td>View Port on Equipment Touch screens</td>
<td>120</td>
</tr>
<tr>
<td>To add a View Port</td>
<td>121</td>
</tr>
<tr>
<td>To navigate in the View Port window</td>
<td>122</td>
</tr>
<tr>
<td>To customize a View Port</td>
<td>122</td>
</tr>
<tr>
<td>Setpoint control on Equipment Touch screens</td>
<td>122</td>
</tr>
<tr>
<td>Radio buttons on Equipment Touch screens</td>
<td>123</td>
</tr>
<tr>
<td>Date control on Equipment Touch screens</td>
<td>123</td>
</tr>
<tr>
<td>Multi-State control on Equipment Touch screens</td>
<td>124</td>
</tr>
<tr>
<td>Working with tables on Equipment Touch screens</td>
<td>125</td>
</tr>
<tr>
<td>To add a table</td>
<td>125</td>
</tr>
<tr>
<td>To add a control to a table cell</td>
<td>126</td>
</tr>
<tr>
<td>To align objects in a table</td>
<td>127</td>
</tr>
<tr>
<td>To hide objects in a table</td>
<td>127</td>
</tr>
<tr>
<td>Primary Value control on Equipment Touch screens</td>
<td>128</td>
</tr>
<tr>
<td>Changing a property on multiple items of the same control type</td>
<td>129</td>
</tr>
<tr>
<td>Linking Equipment Touch screens</td>
<td>130</td>
</tr>
<tr>
<td>Defining paths for an Equipment Touch screen</td>
<td>131</td>
</tr>
<tr>
<td>To define paths for .touch file</td>
<td>131</td>
</tr>
</tbody>
</table>
Setting Items on an Equipment Touch to show/hide................................................................. 133
  To set items to show/hide........................................................................................................ 133
  To add a condition to an Equipment Touch screen file......................................................... 134
  To edit a show/hide condition .............................................................................................. 134
  To remove a condition from a control .................................................................................. 134
  Operators ................................................................................................................................ 135

Password-protecting an Equipment Touch............................................................................... 136
  To allow password management on a touchscreen ............................................................. 137
  To lock passwords on a touchscreen...................................................................................... 138

Setting up alarms for Equipment Touch devices..................................................................... 139

Creating non-English Equipment Touch screens.................................................................. 140
  To add non-English text in the ViewBuilder interface......................................................... 140
  To export/import language files............................................................................................ 141

CUSTOM EQUIPMENT TOUCH SCREENS.................................................................................. 143

Working with Custom Equipment Touch screens ................................................................. 144

Getting to know ViewBuilder’s custom touchscreen interface ............................................... 145

Creating screens for custom-sized devices .......................................................................... 146
  To set the screen size.............................................................................................................. 146

Creating a new Custom Equipment Touch screen file or opening an existing file............... 147
  Custom Equipment Touch screen types.................................................................................. 147
  To customize the Home screen ............................................................................................ 149
  To add a Custom Button to the screen header ................................................................. 149
  To create and apply a theme ................................................................................................ 150
  To create additional screens.................................................................................................. 152
  To add navigation .................................................................................................................. 152
  To prevent the .touch file from downloading to a controller.............................................. 152

Adding controls to Custom Equipment Touch screens.......................................................... 154

Selecting controls on the workspace...................................................................................... 155

Custom Equipment Touch screen controls and their properties .......................................... 156
  Hotspot control on Custom Equipment Touch screens ...................................................... 158

Changing a property on multiple items of the same control type......................................... 159

Supporting .svg files ............................................................................................................. 160
  .svg examples...................................................................................................................... 160
  .svg file specifications.......................................................................................................... 161

SYSTEM TOUCH SCREENS....................................................................................................... 164

Working with System Touch screens ...................................................................................... 165

Getting to know ViewBuilder’s System Touch interface......................................................... 166
  To move objects .................................................................................................................. 166
  To align, group, and layer objects ....................................................................................... 167
  To copy an object ................................................................................................................ 167
  To lock or unlock controls .................................................................................................. 167
  To undo or redo actions ....................................................................................................... 167

Creating a new System Touch screen file or open an existing file ...................................... 168
  System Touch screen types................................................................................................ 168
  To customize the Home screen ........................................................................................ 170
  To create additional screens.............................................................................................. 171
  To add navigation ................................................................................................................ 171

Adding controls to System Touch screens............................................................................ 172
Selecting controls on the workspace ................................................................. 173
System Touch screen controls and their properties ....................................... 174
  Text and images on System Touch screens ................................................. 175
    Text ............................................................................................................. 176
    Images ......................................................................................................... 177
  Conditional items in a list ............................................................................... 178
Number control on System Touch screens .................................................... 178
Text Toggle control on System Touch screens .............................................. 179
View Port on System Touch screens ............................................................... 180
  To add a View Port ....................................................................................... 181
  To navigate in the View Port window ........................................................ 181
  To customize a View Port ............................................................................ 182
Checkbox control on System Touch screens .................................................. 182
Time control on System Touch screens .......................................................... 182
Multi-State control on System Touch screens .............................................. 183
Working with tables on System Touch screens .......................................... 184
  To add a table ............................................................................................. 184
  To add a control to a table cell ................................................................. 185
  To align objects in a table ........................................................................... 186
  To hide objects in a table ........................................................................... 186
Radio buttons on System Touch screens ...................................................... 187
Date control on System Touch screens ......................................................... 187
Linked button control on System Touch ....................................................... 188
Primary Value control on System Touch screens ........................................ 189
Changing a property on multiple items of the same control type .................. 190
Linking System Touch screens ...................................................................... 191
Defining paths for a System Touch screen .................................................... 192
  To define paths for .stv file ...................................................................... 192
Setting Items on a System Touch to show/hide .......................................... 193
  To set items to show/hide ......................................................................... 193
  To add a condition to a System Touch screenfile .................................... 194
  To edit a show/hide condition .................................................................. 194
  To remove a condition from a control ...................................................... 194
Operators ...................................................................................................... 195
Password-protecting a System Touch ............................................................ 196
  To allow password management on a touchscreen .............................. 197
  To lock passwords on a touchscreen ...................................................... 198
Creating a non-English System Touch screen .............................................. 199
  To add non-English text in the ViewBuilder interface.............................. 199
  To export/import language files .............................................................. 200

BACVIEW SCREENS ....................................................................................... 202
Working with BACview® screens ................................................................. 203
Getting to know ViewBuilder's BACview® Interface .................................. 205
  To move the cursor in a screen ............................................................... 206
  To add lines to a screen ........................................................................... 206
  To select or move objects ....................................................................... 206
  To copy an object .................................................................................... 207
  To undo or redo actions ........................................................................ 207
  To create a new BACview® file or open an existing file ......................... 208
Making BACview® screens

Default screens
To add new screens

Adding text, controls, headers, and footers to BACview® screens
To add text
To add a BACview control
BACview controls and their properties
To have ViewBuilder insert object names
To add headers and footers

Setting items on a BACview screen to show/hide
To set items to show/hide
To edit or remove a show/hide condition

Adding navigation to BACview® screens
To add a link
To add a softkey link
To assign a hotkey to a screen
To test the navigation

Password-protecting a BACview® screen
To create the Admin password
To create the User password

Setting up alarms for a BACview® device
To save, assign, and download the BACview® file

Document revision history
What is ViewBuilder?

ViewBuilder is a tool used as an adjunct to create graphics and drawings that i-Vu® does not already have in its Library, or to change existing graphic views. Operators can use these graphics to monitor and control their building automation system.

You can also:

- Create Equipment Touch screens (page 101). An Equipment Touch is an interactive device that you can attach to a controller to view or change its property values or its real-time clock without having to access the system's server.

  or

- Create System Touch screens (page 165). A System Touch is an interactive device that can act as a front-end interface to controllers on a BACnet network.

- Create Custom Equipment Touch screens (page 144). Custom-sized Equipment Touch screens can be created to display on mobile devices, such as a cellphone of tablet.
• Create BACview® screens (page 203). A BACview device is a combination keypad/display that you can attach to a controller to view or change its property values or its real-time clock without having to access the system's server.
### What's new in ViewBuilder v7.0

<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associations (page 16)</td>
<td>The new Associations window lets you:</td>
</tr>
<tr>
<td></td>
<td>• Add color ovals more efficiently to a floorplan or campus map.</td>
</tr>
<tr>
<td></td>
<td>• Tie the color ovals on a floorplan or campus map to an i-Vu® Pro custom report.</td>
</tr>
<tr>
<td>Data tables (page 65) and charts (page 69)</td>
<td>These new controls on a Graphics page pull data from an i-Vu® Pro report. The chart control allows you to specify a line chart, pie chart, horizontal bar chart, or vertical bar chart.</td>
</tr>
</tbody>
</table>

**Static Pressure**

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Static Pressure</th>
<th>Static Pressure Setpoint</th>
<th>Pressure Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAV/MAJ 1</td>
<td>13</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>VAV/MAJ 2</td>
<td>13</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>VAV/MAJ 3</td>
<td>63</td>
<td>15</td>
<td></td>
</tr>
</tbody>
</table>

**Vertical bar chart**

**Data table**

![Image of a static pressure data table and a vertical bar chart]
<table>
<thead>
<tr>
<th>Feature</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color maps (page 73)</strong></td>
<td>A Graphics page color map shows specified colors for various conditions that are defined in an i-Vu® Pro report.</td>
</tr>
<tr>
<td><strong>Default graphic size (page 13)</strong></td>
<td>The default graphic size in ViewBuilder is now 1666 x 849 pixels.</td>
</tr>
<tr>
<td><strong>Local Variables (page 88)</strong></td>
<td>ViewBuilder now preserves local variables through cut/copy and paste, as well as when importing a .viewsymbol.</td>
</tr>
<tr>
<td><strong>Layers (page 54)</strong></td>
<td>• ViewBuilder now preserves layers when importing a .viewsymbol.</td>
</tr>
<tr>
<td></td>
<td>• If cutting/copying a selection assigned to layers, you must hold Shift while pasting in a new file to preserve layer assignments.</td>
</tr>
<tr>
<td><strong>Downloading a Custom Equipment Touch file (page 152)</strong></td>
<td>If a .touch file contains many screens or large images that cause the file to become too large for the controller's memory, you can download only the name of the .touch file to the controller instead of the entire file. You will then need to manually copy the .touch file to your device.</td>
</tr>
</tbody>
</table>
Although Carrier provides graphics for i-Vu® systems, you can use ViewBuilder to edit existing graphics (page 10) or create new graphics (page 12). On custom graphics, you can add an Equipment Color oval to indicate the temperature of a specified area.
Getting to know ViewBuilder's Graphics interface

TIPS

- ViewBuilder has a right-click menu that includes keyboard shortcuts for most commands.
- To show or hide the Tools, Control Properties, or System windows, click the toolbar button that matches the window's icon.
- To make the Tools, Control Properties, and System windows fade to transparent when not in use, select Configure > Preferences > Application.
• Hold down the space bar and the left mouse button, then move the graphic around in the workspace using the hand tool.
• Press Home on the keyboard to align the top left corner of the graphic with the top left corner of the workspace.
• Hold down F9 to hide all handles and lock icons.

To select objects

You must select an object to perform any action on it.

• To select a single object, click it.
• To select multiple objects, hold down Shift while you click them. Or, click and drag a rectangle around the objects, then release the mouse button.
• To select every object, select Edit > Select All.
• To clear all selections, select Edit > Deselect All.
• To deselect a single object from a group of selected objects, hold down Ctrl as you click the object.

To move objects

To move a selected object(s):

• Click and drag the object to the new location. Hold down Shift as you drag an object to constrain its movement to horizontal or vertical.
• Use the arrow keys to nudge the selected object one pixel at a time, or hold down Shift while using the arrow keys to move the object ten pixels at a time.
• Select Edit > Move to move the object to specific coordinates. The coordinates of the cursor and the selected object are shown at the bottom of ViewBuilder’s window.

To align, group, or layer objects

Select the object(s) you want to align, group, ungroup, or arrange (front to back), then use the right-click menu commands or the options on the tab in the Tools window.

NOTES

• Objects align in relationship to the last selected item, the one with the green handles.
• See To edit an object in a group (page 53).
To copy an object

Click ⌃ to copy the selected object, then click ⌘ to paste the object in the existing view or a different view. Or, hold Alt while dragging an object to create a duplicate object.

To lock or unlock objects

- To lock a selected object(s) so you cannot select or move it, right-click the object, then select Lock.
- To unlock an object, Ctrl+right-click the object, then select Unlock.
- To unlock a table, Ctrl+right-click on the small grid above the table.
- To unlock all locked objects simultaneously, right-click anywhere in the workspace and select Unlock All.

NOTES

- You can also lock and unlock objects on the Layers tab in the Tools window. See Working with layers (page 54).
- Hold down the F9 key to hide the lock icons.

To undo or redo actions

Click ⌃ as many times as necessary to undo actions that you performed in the current session of ViewBuilder, beginning with the most recent action. Click ⌘ to redo the action.

You can also click the drop-down arrow to the right of the Undo or Redo button to select an action from a list that begins with the most recent action. Selecting an action will undo or redo that action, plus all actions above it in the list.

⚠️ CAUTION An entire Associations session is considered one action. Clicking Undo one time will undo the entire session.
**Editing a graphic**

To edit a graphic that was created in ViewBuilder, browse to and open the graphic file.

<table>
<thead>
<tr>
<th>To edit...</th>
<th>1</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>An Equipment Color oval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double-click the Equipment Color oval on the graphic to open the <strong>Associations</strong> window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select the oval that you want to edit.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit any of the settings on the <strong>General</strong> or <strong>Advanced</strong> tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A hotspot's link destination on an area graphic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double-click the Equipment Color oval on the graphic to open the <strong>Associations</strong> window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select the oval whose hotspot you want to edit.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change the location that the hotspot links to in the <strong>Path</strong> field on the <strong>General</strong> tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>An image</td>
<td></td>
<td></td>
</tr>
<tr>
<td>See <em>Editing an image on a graphic</em> (page 19).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A drawing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use the <strong>Alignment/Draw</strong> window. See <em>Drawing lines and shapes</em> (page 56).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select the control.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit any properties in the <strong>Control Properties</strong> window. See <em>Working with graphic controls</em> (page 21).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A link</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Right-click the control that is a link.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select <strong>Link</strong>.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit the fields in the dialog box as needed. See <em>Adding links to a graphic</em> (page 58) or a description of each field.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>See <em>Working with tables on a graphic</em> (page 33).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**To edit a graphic from the i-Vu® application in ViewBuilder**

1 In the i-Vu® interface, double-click the controller in the navigation tree or right-click and select **Configure**.
2 Click **Edit Existing** button under **Views**.
3 Click **Save as** and place the file in an appropriate folder.
4 Open ViewBuilder.
5 Select **File > Open**. Browse to your saved graphic and click to open.
6 Edit and save with a new name - the original system name is locked and cannot be used for an edited graphic.

**NOTE** Names are case sensitive and should not have spaces and/or special characters.
To upload a graphic in the I-Vu® interface

1. Double-click the controller in the navigation tree or right-click and select **Configure**.
2. Click the **Add New** button under **Views**.
3. Browse to your .view graphic file that you created in ViewBuilder.
4. Click **Continue**.
5. Click **Close** when message appears **File added successfully**.
6. Click **Close** again. The graphic should appear on your I-Vu® screen.

**Multiple graphics in I-Vu® Pro application**

1. If you have multiple graphics for one equipment in the I-Vu® Pro interface, follow steps 1-5, select the new .view in the **Available** window and click **Attach**.
2. In the **Attached** window, double-click the .view and fill in the fields below the window.

**Field Assistant application**

Field Assistant can **upload** and display multiple graphics (.views) that were downloaded to a controller. However, Field Assistant can only **download** a single .view to the controller. If you edit one of the .views and download to the controller, you will only download the edited .view. Information for the other .views are removed from the controller. You can reattach and re-download those .views from your I-Vu® system.
Creating a graphic

A graphic can be created to display the status of multiple zones or equipment from a single view. The area or floorplan graphics can be set up with **Equipment Color** controls to provide a visual representation of the comfort level in each zone.

Values, text, and links can also be added to area and floorplan graphics. Clicking on a link zooms in on an individual zone or individual piece of equipment for closer examination.

To create a graphic:

1. In a graphics program, **create any custom images** (page 14) such as floorplans.
2. In ViewBuilder, click **File > New** and then select **Area**.
3. Select **File > Save As** and browse to a convenient location on your computer.
4. Name the .view file.
5. Click **Save**.
6. **Add a beginning image** (page 14), such as a duct or floorplan.

   **CAUTION** Keep items within the gray lines that define the graphic size. If the items exceed the gray lines, **change the graphic's size** (page 13).
7. **Add images** (page 14), **controls** (page 21), and **symbols** (page 52) as needed.

   **NOTE** Use the **Equipment Color** ovals to display the temperature in an area relative to the designated setpoints for that area. Use the **Associations** (page 16) window or the **Control Panel** (page 30).
8. Test your graphic in the i-Vu® interface.

**NOTES**
- Save your work often.
- To record information about the graphic, select **Configure > View Properties**, then type your name and comments on the **Summary** tab. **Revision History** shows each time the graphic was saved, the computer it was saved on, and the version of ViewBuilder it was saved in.
To change the graphic size

The gray lines in the ViewBuilder interface show the size of the graphic. The default size of a new graphic is 1666 x 898 pixels. This size graphic fits in the i-Vu® action pane when the navigation tree is displayed, the screen resolution is set at 1920 x 1080, and the web browser is maximized with the toolbars and status bar hidden. A graphic that is 1886 x 898 pixels fits the action pane when the tree is hidden.

To change the size of your graphic:

1. Select Configure > View Properties.
2. Under View Size, select the size you want or enter a custom size (in pixels).
   
   **NOTE** If you enter a size greater than the i-Vu® action pane, i-Vu® will display scroll bars.
3. Click OK.

To change a graphic’s background color

1. Select Configure > View Background Color.
2. Select the color you want.
3. Click OK.
Working with images on a graphic

You can add images, such as areas, floorplans, or site maps, to your graphic. In a graphics program, create an area image as a .gif or .png; create any other image as a .gif, .png, or .jpg.

To add an image to your graphic

1. Click the Add Image tab in the Tools window.
2. In the Look in field, browse to the folder that contains the image you want.
   - TIP: Click one of the five buttons at the left of the file list to jump to a location quickly. Hold the cursor over a button to see its destination.
3. Select the image.
4. Click in the workspace to place the image.
   - TIP: You can also double-click a file name in the Tools window to add the image to the workspace.
5. Enter an image in the Mouseover Image field in the Control Properties window if you want the i-Vu® interface to display a different image when the cursor is over the image.
   - NOTE: The mouseover image must be the same size as the other image.

NOTES
- To add the image multiple times, select the image, then Shift+click the workspace for each image.
- To set an image to show or hide in the i-Vu® interface based on the value of a microblock property, see Setting objects on a graphic to to show/hide in the i-Vu® interface (page 61).
- To make an image link to another page in the i-Vu® interface or to the Internet, see Adding links to a graphic (page 58).

To resize an image

To resize an image, you can type the desired Width and Height (in pixels) in the Control Properties window or do the following:
1. Select a single, ungrouped image.
2. Click and drag one of the green handles.

NOTES
- Hold down the Shift key as you drag to maintain the image's proportions.
- Adding equipment associations to an image will force it back to its original size.
Creating a CCN Universal or Comfort Controller graphic

A graphic can be created to display links to the points in your Universal or Comfort Controller. An image that you create can also be added. Add as many points as you would like to connect to.

To create a graphic for your Universal or Comfort Controller:

1. In ViewBuilder, click to start a new graphic file.
2. Place images, symbols, drawings, and controls.
3. Save the file as a .view in a folder you will remember or place on your desktop.
   
   **NOTE** Save your work often.
4. See the following section to map the points.

**NOTE** To record information about the graphic, select Configure > View Properties, then type your name and comments on the Summary tab. Revision History shows each time the graphic was saved and the workstation it was saved on.

To map points from custom equipment files

1. Use EquipmentBuilder to make your custom equipment file. Save the file in a convenient folder.
2. Open ViewBuilder and prepare your graphic.
3. If you do not already see the System window, click on the toolbar.
4. Click next to Equipment File.
5. Browse to the .equip file that you made in EquipmentBuilder, then click Select and Next. You will see a list of the points that you mapped in EquipmentBuilder.
6. Select the item whose path you want.
7. Open the Control Properties window by selecting Window > Control Properties.
8. Right-click the Microblock Path field in a Control Properties window, then click on Set Microblock Path Expression.
9. Click Show Prime Variable to display that value on your graphic. (If using an Equipment Color control, select a large oval.)
Associating Equipment Color ovals on a graphic to equipment

Use Associations to add Equipment Color ovals to a graphic, linking each oval to equipment. In the i-Vu® interface, the oval changes colors to indicate the status of the equipment.

In the Associations window in ViewBuilder, you can choose to enlarge the oval, show the Prime Variable, and add a Hotspot to your graphic. A hotspot links the oval to the equipment graphic or to another specified location.

When you use the Associations window to place multiple color ovals on a graphic, you can see the details of every oval in the one window. The Associations window has a tree with the paths or the names of the equipment that each oval is assigned to. When you do not use Associations and you individually place each Equipment Color oval from the Add Control tab, you have to click on each oval one at a time to see its equipment or path.

To associate ovals to equipment

Use the following for one area graphic at a time. All Equipment Color ovals on that graphic are displayed in the Associations window.

⚠️ CAUTION You cannot use the Associations window to place color ovals on a .jpg image. You must use a .png or .gif image. Use a graphic editing program to save a .jpg as a .png or .gif.

If you cannot reformat a .jpg, you can place an oval on it by using the Control Panel. See To use an Equipment Color control (page 30).

The i-Vu® Standard or Plus application

1. In the ViewBuilder workspace, double-click the area graphic to open the Associations window. (Ctrl+double-click a locked image.)
2. In the Associations window, on the Unknown tab, select Unknown on the tree.
3. Right-click the area in the graphic where you want the oval and select Create Association. This creates an association to a placeholder item on the tree.
4. Enter the correct path to the equipment on the General tab > Path field so that the colors and link will work correctly in the i-Vu® interface.
   
   **NOTE** To find the path, open the i-Vu® application and right-click the controller in the navigation tree. Select Copy Path from the drop-down list, copy (Ctrl+C), and paste (Ctrl+V) into the Path field.
5. Repeat steps to continue associating more ovals on the same graphic.
6. Click Save and Close.

Creating associations using an i-Vu® Pro system

You must have the i-Vu® Pro Server running on your computer in order to access the system in ViewBuilder. If you have remote access, follow the directions above for the i-Vu® Standard or Plus application.
1. In the ViewBuilder workspace, double-click the area graphic to open the **Associations** window. (Ctrl+double-click a locked image.)

   If you have the i-Vu® Server running on your computer and you still do not see the system's navigation tree in the Associations window:
   a) Close the **Associations** window.
   b) Click on the toolbar.
   c) Select the system in the drop-down list.
   d) Click **Next**, enter Name: and Password:.
   e) Click **Next**. Leave this window open while you work in **Associations**. Click **Close System** when you are finished.

2. In the **Associations** window, expand the items in the **User** tree to show all the equipment you want to link to an oval.

   **NOTE** To display more of the navigation tree, pull down on the double line above **Action Button** on the **Advanced** tab.

3. Select the first equipment in the tree to be associated to an oval.

4. Ctrl+click the area on the graphic where you want the oval.

5. If the next tree item is equipment, Ctrl+click the next area on the graphic.
   If not, select the equipment, then Ctrl+click the area on the graphic.

6. Repeat step 5 to continue associating ovals.

7. Click **Save and Close**.

**NOTES**

- The default settings for every oval, shown on the **General** tab, are **Is Large** and **Hotspot**. To change the defaults, you can check or uncheck the settings after each association or at another time. To adjust after making multiple associations, click the oval and adjust as needed on the **General** and **Advanced** tabs. For details on a **Hotspot**, see the next topic "To link to a page other than the area graphic".
- To delete an oval from your graphic, see **To remove an association** (page 18).
- Press F3 or F4 to jump from one associated equipment to another on the tree.
- To change an image after making associations, see **Editing an image on a graphic** (page 19).

---

**To link to a page other than the equipment graphic**

**Create a hotspot to link to the default equipment graphic**

1. In the **Associations** window, select the Equipment Color oval you wish to link to the equipment graphic.

2. Select the **General** tab and check the **Hotspot** box.

   **NOTE** Hotspot is checked by default.
To link the hotspot to a different page than the default equipment graphic

1. In the Associations window, select the oval you wish to link to.
2. On the General tab, verify that Hotspot is checked.
3. Click the Advanced tab.
4. Select an Action Button from the drop-down list.
5. Enter a Category Reference Name, Instance, and Tab.

**TIP** To find Category Reference Name, Instance, and Tab, go to the location in the i-Vu® interface that you want to link to and use the whereami manual command. See “Manual Commands” in i-Vu® Help.

**NOTE** To delete a hotspot created by this method, select the oval and uncheck Hotspot on the General tab.

To create two different hotspots for the same equipment

1. Associate two different ovals to the same equipment.
2. Click the Advanced tab and on the Action Button drop-down list, select the location where you want the oval to link to.
3. Enter a Category Reference Name, Instance, and Tab.
4. You must also check Work Independently.

To remove an association

In the Associations window, select the associated tree item on the User tab, then click on the toolbar, or right-click the oval, and press Remove Association.

**NOTE** To remove the hotspot uncheck the item on the General tab.
Editing an image on a graphic

1. Edit the original image (.gif, .png, or .jpg) in a graphics application.

   **NOTES**
   - To use the Associations window, your images must be either .png or .gif format.
   - If you do not have the original image, follow the procedure below in “To export an image”.

2. Add the edited image to your graphic by one of the following methods:
   - If the image on your graphic has no functionality in ViewBuilder, such as show/hide, linking, or associations, delete the image, then add the revised image.
   - If the image has functionality in ViewBuilder that you want to retain, follow the procedure below in “To import an image”.

To import an image

You can replace an image with another image and retain any functionality that the first image had.

1. Double-click the image to open the **Associations** window.

2. Click `../`.

3. Browse to your image file and click **Open**.

4. If you are importing an image into a graphic that has associations, select **File > Import Image**.
   - **Merge** - ViewBuilder attempts to reassign all existing associations to the new image.
   - **Clear** - Removes all existing associations so that you can redefine them.

5. If you selected **Merge**, check the image to make sure ViewBuilder reassociated all ovals.

6. Click **Save and Close**.

To export an image

To export an image from your .view file:

1. Do one of the following
   - Right-click the image in the workspace, select **Export Image**.
   - Double-click the image to open the **Associations** window, then select **File > Export Image**.

2. Save the file in any folder.
To add hover text

You can add hover text that will appear in the i-Vu® interface when you hold the cursor over an oval.

1. In the **Associations** window, select the oval that you want to have hover text.
2. Type the text in the **Hover Text** field on the **General** tab.
Working with graphic controls

You can add controls to a graphic that can retrieve and allow editing of data in the system’s controllers, for example, status values, the date and time, trend graphs, or setpoint graphs.

**NOTES**

- To set a control to show or hide in the i-Vu® interface based on the value of a microblock property, see Setting objects on a graphic to show/hide in i-Vu® interface (page 61).
- To make some controls link to other pages in the i-Vu® interface or to the Internet, see Adding links to a graphic (page 58).
- Hold down F8 to see an indicator beside all controls that need to have a microblock path defined in the Control Properties window.

To add a control

1. Click the Add Control tab in the Tools window.
2. Select the control you want to add. See Controls and their properties (page 22) for a description of each control.
3. Click in the workspace where you want to add the control.
   **NOTE** To cancel the action, press Esc before clicking the workspace.
4. Edit properties for the control in the Control Properties window. See Controls and their properties (page 22).
5. Click anywhere in the workspace to apply the properties.

**TIPS**

- To add a control multiple times, select the control, then press Shift+click the workspace for each copy.
- Hold Alt while dragging a control to create a copy of it.
Controls and their properties

When you add a control to a graphic, you define properties in the Control Properties window to define what data the control will retrieve or how the control will behave in the i-Vu® interface. Most controls have the following three properties.

**Microblock Path**
The path to the microblock you want the control to read from or write to. You can determine the path yourself (page 81).

**NOTES**
- If this field is outlined in red, you entered invalid syntax or characters.
- See Defining i-Vu® paths (page 79) for more information on paths.

**Property**
The microblock property you want to read from or write to. Click the down arrow to select a common property (usually present_value) or type the property you want. Editable microblocks usually require the relinquish_default property. See Microblock Reference help for a complete list of properties.

**Editable**
Check to make the control editable in the i-Vu® interface. The microblock must have editable properties.

The following table lists all the controls you can add to a graphic and any other properties besides the three described above.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Static Text</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Display text that does not change. Example: A description of a control</td>
<td>Text—The text you want the control to display in the i-Vu® interface.</td>
</tr>
<tr>
<td><strong>Single-line Text</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[]</td>
<td>Display text from the character string field in a microblock. Example: Point name</td>
<td>Preview Text—Text that is displayed only in ViewBuilder to help you place the control. Type the preview text or select from the drop-down list. NOTE To display the Notes defined in the i-Vu® application for an area or piece of equipment, enter the path to the area or piece of equipment in the Microblock Path field, then type .notations in the Property field.</td>
</tr>
<tr>
<td><strong>Multi-line Text</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[]</td>
<td>Place a multi-line text box on a page. Example: Long text of an alarm</td>
<td>Wrap text—Wraps text from line to line inside the text area box. Provide Scrolling—Includes scrollbars. Visible Row Count—The number of rows the text area will display. Visible Column Count—The estimated number of characters a row will display. This estimate helps you avoid overlapping other page elements when positioning the control in ViewBuilder.</td>
</tr>
<tr>
<td>Use this control...</td>
<td>To...</td>
<td>Properties</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Text Toggle</strong></td>
<td>Display active and inactive text values for a binary microblock. When editable, can be toggled between multiple states by clicking on it. Example: Chiller is enabled or disabled</td>
<td>Preview Text—Text that is displayed only in ViewBuilder to help you place the control. Type the preview text or select from the drop-down list.</td>
</tr>
<tr>
<td><strong>Droplist</strong></td>
<td>Display the text values for BACnet multi-state microblocks. A droplist can also display the active and inactive text values for a binary microblock. When editable, appears as a droplist with multiple options. Example: Units of measure (°F)</td>
<td>General Preview Text—Text that is displayed only in ViewBuilder to help you place the control. Type the preview text or select from the drop-down list. Advanced The fields on this tab provide a method of substituting the microblock property values with different text. For example, display Yes/No in the droplist instead of the On/Off values defined in the Snap application.</td>
</tr>
<tr>
<td><strong>Toggle Button</strong></td>
<td>Display two different images to represent the on and off states of a microblock property. Example: The control reads a fan status value, then displays a static image of a fan to indicate the fan is off and an animated image to indicate it is on.</td>
<td>General Images—To use images other than a checkbox, click ![image] to locate the On and Off image files. Advanced If you want to display custom images for the following conditions, click ![image] to locate the image. Mouseover Image—The image to be displayed when the cursor is over the button to indicate a clickable link. Pressed Images—The images to be displayed when the cursor is on the button and the mouse button is pressed down, but not yet released. Disabled Images—The images to be displayed when buttons are not editable.</td>
</tr>
<tr>
<td>Use this control...</td>
<td>To...</td>
<td>Properties</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>0.0 Number</td>
<td>Display any numerical value from an analog microblock. Example: Zone temperature</td>
<td><strong>General</strong>&lt;br&gt;Max Right Digits—The maximum number of digits to be displayed to the right of the decimal. Type 0 to display whole numbers. Min Left Digits—The minimum number of digits to be displayed to the left of the decimal (usually 1). Expected Left Digits—The number of digits that might appear to the left of the decimal. These digits are only displayed in ViewBuilder to help you position the control. Create Units Control—Adds a Droplist control to the right of the Number control. The microblock must have a units field that identifies the number (for example, RPM). The Microblock Path is the same as the Number control. Type or select a Preview Text option. This text is only displayed in ViewBuilder to help you place the control. <strong>Advanced</strong>&lt;br&gt;Scaling Factor—To display a microblock property value in a different format, type the necessary multiplication factor. For example, to display watts as kilowatts, type .001 in this field. Show plus sign—Displays a plus sign when the value is positive. <strong>NOTE</strong> You can use the Number control to display the number of alarms pending a return-to-normal state for an area or equipment. To do this, enter the path to the area or equipment in the Microblock Path field, then type .alarm_count in the Property field.</td>
</tr>
<tr>
<td>Image List</td>
<td>Show various states of an analog microblock using images. Example: A closed damper is shown when the analog value is 0; a half-open damper is shown when the value equals 50; and a fully open damper is shown when the analog values equals 100.</td>
<td>Default image—Click <img src="image" alt="image" /> to locate the image you want the control to display when a communication problem or error occurs. Use a different image from the others in the image list so that the i-Vu® operator will know when an error occurs. For example, some symbols that use image lists have default images with <img src="image" alt="image" /> in the center of the image. Click <img src="image" alt="image" /> to add the images the control displays under normal conditions. Use <img src="image" alt="image" /> and <img src="image" alt="image" /> to reorder the list. Click <img src="image" alt="image" /> to delete an image from the list. Expression—Enter an expression for each image (except the default image) to define the condition for displaying the image. See Conditional expressions (page 83). When the graphic is displayed in the i-Vu® interface, each expression is evaluated in the order of your list and the first image whose expression returns true is displayed. If no expression returns true, the default image is displayed.</td>
</tr>
<tr>
<td>Use this control...</td>
<td>To...</td>
<td>Properties</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>Slider</td>
<td>Display a horizontal or vertical slider bar that can be used to adjust an editable point. Example: Editing a setpoint</td>
<td><strong>General</strong>&lt;br&gt;<strong>Display Orientation</strong>—Displays the slider horizontally or vertically.&lt;br&gt;<strong>Minimum Value</strong>—The minimum value on the slider.&lt;br&gt;<strong>Maximum Value</strong>—The maximum value on the slider.&lt;br&gt;<strong>Tick Interval</strong>—The number of units from one tick to another.&lt;br&gt;<strong>Slide By This Increment</strong>—The number of units the slider jumps when you move it.&lt;br&gt;<strong>NOTE</strong> To have the slider divisions appear correctly, the slider range (maximum value minus minimum value) should be evenly divisible by the tick interval.</td>
</tr>
</tbody>
</table>

Example of control properties and the results in WebCTRL

![Slider Measurements](image)

<table>
<thead>
<tr>
<th>Images</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use custom images for the slider, click <img src="image" alt="image" /> to locate the image files.</td>
</tr>
</tbody>
</table>

| Date | Display a date, typically read from a History microblock. Example: Date of the highest zone temperature | **Show day of week**—Adds the day to the right of the date.<br>**NOTE** To display a controller's current date on:
- the equipment graphic, type `~device/driver/device/local_date` in the Microblock Path field.
- an area graphic, type `<equipment_ref_name>/~device/driver/device/local_date` in the Microblock Path field. In either case, delete the text in the Property field. |

| Time | Display a time of day, typically read from a History or Wire Lock microblock. Example: Time of the day's highest temperature | **Display Format**—Choose how to display time.<br>**NOTE** To display a controller's current time on:
- the equipment graphic, type `~device/driver/device/local_time` in the Microblock Path field.
- an area graphic, type `<equipment_ref_name>/~device/driver/device/local_time` in the Microblock Path field. In either case, delete the text in the Property field. |
<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>h:mm:ss Duration</td>
<td>Display a time period. Example: Override time remaining</td>
<td>Select the microblock value's unit in the Microblock Unit field. Check Show Hours and Show Seconds to display these with the minutes. <strong>NOTES</strong>&lt;br&gt;• The Duration control must reference an analog value.&lt;br&gt;• This control's Microblock Unit must match the unit of the microblock value.&lt;br&gt;• Digital and analog wirelock microblocks output a value in milliseconds.</td>
</tr>
<tr>
<td>Trend Graph</td>
<td>Place a BACnet trend on a graphics page. Example: Trend graph of zone temperature</td>
<td>Trend location—To add a point or wire trend graph, type the microblock path. To add a trend graph that shows multiple points, type the reference name of the graph. To find the reference name, navigate to the graph in the i-Vu® interface, then click the Configure tab. The reference name appears at the top of the page.</td>
</tr>
<tr>
<td>Panel</td>
<td>Serve as a backdrop for other objects.</td>
<td>Move the handles to adjust the shape of the panel.</td>
</tr>
<tr>
<td>Table</td>
<td>Align multiple controls in rows and columns. Example: Fan status table</td>
<td>See Working with tables on a graphic (page 33).</td>
</tr>
<tr>
<td>Flow Layout</td>
<td>Add text, controls, or images to a resizable container that wraps the objects to fit the container.</td>
<td>To add content to the Flow Layout control:&lt;br&gt;• Double-click it to type text. <strong>NOTE</strong> Press Esc to exit the control without saving the text.&lt;br&gt;• Drag and drop other controls or images into it. <strong>NOTE</strong> You cannot insert a Panel, Table, HTML, or another Flow Layout control. Click and drag the Flow Layout's handles to resize it. Use the options in the Control Properties window to:&lt;br&gt;• Align the contents in the Flow Layout control&lt;br&gt;• Wrap the text&lt;br&gt;• Change the border's thickness&lt;br&gt;• Change the border or background color</td>
</tr>
</tbody>
</table>
On-Off-Auto

Provide a method to lock a piece of equipment on, lock it off, or let the control program control it (Auto).

Example: To control fans or pumps

Microblock Path—Type the path in this field only if this control is to read one microblock.

Type: Select...

Dial

Vertical Panel

Horizontal Panel

Order—Select the order of the control labels. The order is left to right for Dial and Horizontal Panel, or top to bottom for Vertical Panel.

Use State Text—Check to use the binary microblock's Active text and Inactive text instead of the control's defaults.

Use Advanced Path—Check if you want this control to read two microblocks, one for Auto and one for On/Off (Hand/Off). Enter the microblocks in the following fields.

Automatic Microblock Path and Property—The microblock that contains the Auto values.

Manual Microblock Path and Property—The microblock that contains the On/Off values.

Radio Button

A set of radio buttons provide a method to view or edit the various states of a microblock property.

Example: Manual and Auto

Enter the same Microblock path and Property for each radio button in the set.

Radio Button Value—if the button is not editable, type the value that will turn the button on. If the button is editable, type the value that the property will change to if an operator selects the button.

For an analog microblock, type the specific value the button is to represent.

For a binary microblock, type true or 1 (depending on the property) for one button's value and false or 0 for the other button's value.

The remaining fields for this control are the same as those for the Toggle Button.
### Setpoint

Provide a method to view or edit setpoints.

**Setpoint Type**—The control's appearance depends on the following:

**Select...**

**To display...**

**Actual**

Occupied and unoccupied setpoints programmed into the setpoint microblock.

In ViewBuilder, you see

![Setpoint ViewBuilder](image)

In the i-Vu® interface, you see

![Setpoint i-Vu](image)

**Effective**

Effects of factors such as overrides, adjustments, and hysteresis.

In ViewBuilder, you see

![Effective ViewBuilder](image)

In the i-Vu® interface, you see

![Effective i-Vu](image)

### Interactive Zone Sensor

Provide a method to adjust or override a setpoint.

**Zone Sensor Type**—Select whether the image is to be an **SPT Sensor** or **ZS Sensor**. The control in the workspace will show your selection.

### BACnet Object ID

Place a BACnet object ID on a graphics page.

**Instance Number Only**—Check to allow an operator to edit only the instance number of the BACnet object ID on a graphic.

### HTML

Add any Standards-compliant HTML to the graphic. For example, to embed:

- Video
- Flash movie
- Flash application
- Live video feed from security cameras

Move the handles to adjust the shape of the HTML control.

**General**

**Preview image**—Click ![Image Icon](image) to locate an image that will display only in ViewBuilder.

**Insert HTML**—Enter any HTML and resource file references that are acceptable within the HTML `<body>` tag. Add any resource file on the Resources tab. In the HTML, type the file path as `resources/filename.extension`.

**Resources**

Click ![Add Files](image) to add files to the Resources list. Click ![Delete Files](image) to delete files from the list.

To embed a video, see http://www.w3schools.com/html/html5_videos.asp.

To embed Flash files, see http://www.w3schools.com/tags/tag_embed.asp.

To embed live video feed from security cameras, see the camera system's manual.
<table>
<thead>
<tr>
<th><strong>Chart</strong></th>
<th>Add content from a custom report to a chart</th>
<th>See To produce a chart (page 69).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Table</strong></td>
<td>Add content from a custom report to a table</td>
<td>See To produce a data table (page 65).</td>
</tr>
</tbody>
</table>
| **Add-on Content** | Add content from an i-Vu® add-on application to a graphic | **Add-on Name**—Get this from the i-Vu® interface on the **System Options** or **System Settings** > **Add-ons** tab. Use value in the **Path** column, minus the leading /. For example, if the **Path** column shows /TenantBilling, type TenantBilling in the **Add-on Name** field.  
**Content Path**—If the add-on's documentation specifies a content path, enter it in this field. Otherwise, leave this field blank.  
**Location**—Where the add-on application will retrieve i-Vu® data. Select:  
- **Attached** if the data will come from the location where the graphic is attached.  
- **Alternate** if the data will come from an alternate location, and then type the path to the alternate location.  
**Size**—Type the desired width and height of the Add-on Content box, or drag its corners to resize it.  
**Parameters**—If the add-on specifies parameters, you can add them as described below. Otherwise, leave this section blank.  
1. Click + to add a row.  
2. Click the **Name** cell and type the name of the parameter.  
3. Click the **Value** cell, and then type the new value.  
**NOTE** To delete a row, select the row, and then click - |  |
| **Equipment color** | To view the state of the Prime Variable | In i-Vu®, the oval will display colors to indicate the status of the equipment in relation to its prime variable (for example, ideal, warm, occupied, etc.).  
**Equipment Path** - To determine equipment path:  
1. Open i-Vu®.  
2. Right-click on equipment in navigation tree and click **Copy Path**.  
3. Open ViewBuilder.  
4. Paste.  
**Size** - Choose the size of the oval that you wish to appear on your graphic.  
**Show Prime Variable** - Displays the prime variable. For more information, See To use an Equipment Color control (page 30). |
Angular Gauge

Display a circular gauge that graphically shows a value.

See Working with gauges on a graphic (page 36).

Linear Gauge

Display a horizontal or vertical bar that graphically shows a value.

See Working with gauges on a graphic (page 36).

TIPS

- The symbol library contains preconfigured, commonly used controls. See Working with symbols on a graphic (page 52).
- To change the font color, size, or style for any control that displays alphanumeric characters, right-click the control, then select 📝.
- Several controls let you select an image file that the control will display. To quickly locate an image that you previously added to your graphic, click 📦, then select the image on the Resources tab.
  NOTE Use this feature if you need to swap the Off/On images of a control such as the Toggle Button.
- You can enter the full path to a microblock property in the Microblock Path field and then leave the Property field blank. Example of full path: #oa_conditions/oa_humidity/present_value

To use an Equipment Color control

When you add an Equipment Color control to a graphic, you link the oval to the equipment, choose the size of the oval, and select the Prime Variable in the Control Properties window in ViewBuilder. In the i-Vu® interface, the oval will display colors to indicate the status of the equipment (for example, ideal, warm, occupied, etc.).

Use an Equipment Color control to place a single oval. Use Associations (page 16) to place multiple ovals on a graphic.

1. Open the i-Vu® application.
2. Right-click the controller in the navigation tree and select Copy Path from the drop down list.
3. Open ViewBuilder. Create a new graphic or open an existing one.

   **NOTE** To place an Equipment Color control in your graphic, open the Add Control tab in the Tools window. Click the 🎨 and then click in the view to place it.

4. Open the Control Properties window (Window > Show Control Properties).
5. Paste (Ctrl+V) in the Equipment Path field.
6. Select a large or small oval to appear on your graphic.
7. Optional: Check Show Prime Variable to display the prime variable in i-Vu®.
   **NOTE** You must choose a large oval to display the Prime Variable.
8. Save your view.
9 In i-Vu®, right-click on the site or area in the navigation tree and select **Configure** from the drop-down menu.

10 Select your view and click **Add**.

---

**To add variable color to a text control**

For any control that displays alphanumeric characters, you can enter an expression that causes the text to change color in the i-Vu® interface based on the value of a microblock property.

1 Select the control.

2 Click on the toolbar.

3 Enter the expression. See *Conditional expressions* (page 83) and examples below.

   **NOTE** Click a color in the **Color Insertion Tool** to add its hexadecimal value in the expression.

4 Click **OK**.

   **NOTE** To remove the conditional expression, delete the text in the **Expression** field.

**EXAMPLES:**

<table>
<thead>
<tr>
<th>To...</th>
<th>Enter the expression...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a Text Toggle control that will determine a filter status and show the word Clean in green or Dirty in red</td>
<td>($filter/present_value$==true)?'FF0000':'00FF00')</td>
</tr>
<tr>
<td>Add a Static Text control that displays red text to indicate an alarm or white text to indicate a normal condition</td>
<td>($alarm/present_value$==true)?'FF0000':'FFFFFF')</td>
</tr>
</tbody>
</table>

---

**To set a control to enable/disable**

You can enter a conditional expression that determines whether the i-Vu® interface enables or disables a control based on another control’s microblock property value.

1 Select the control that you want to enable/disable.

2 Click on the toolbar.

3 Enter the expression. See *Conditional expressions* (page 83) and example below.

4 Select **Enable When True** or **False**.

5 Click **OK**.

   **NOTE** To remove the conditional expression, delete the text in the **Expression** field.
**EXAMPLE:**

<table>
<thead>
<tr>
<th>To...</th>
<th>Enter the expression...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an editable Number control after Lock value at: that will be enabled only when an operator clicks the checkbox</td>
<td>$m006/locked$ == true and select <strong>Enable when True</strong> to enable when true.</td>
</tr>
</tbody>
</table>

**TIPS**

- You can simultaneously set multiple controls to enable/disable using the same conditional expression. Each of the controls must have enable/disable capability. Select the controls, then click ![Enable/Disable](image).  
- You can use *local variables in conditional expression* (page 88) to enable/disable objects.
### Working with tables on a graphic

You can add a table to a graphic and then add controls or images in the table cells. The table maintains the alignment of the objects in the cells.

#### To add a table

1. Click the **Add Control** tab in the **Tools** window.
2. Select the **Table** control.
3. Click in the workspace where you want to add the table.
4. Do one of the following:
   - Select **Pre-Defined Table**, then select the style you want to add.
   - Select **Custom Table**, then enter the initial number of rows and columns. You can add or delete rows later in the **Table Editor** (page 34).
5. Click **OK**.

#### To add text to a table

Do one of the following:

- Add a static text control in a table cell.
- Double-click a table cell, then type the text.
  Optional: Double-click the table icon at the top of the table to open the **Table Editor**, then align the text.
To add a control to a table cell

1. Click the control in the Tools window.
2. Click the cell where you want to add the control.
3. Enter the control's properties.

**NOTE** You can add multiple objects to a table cell, then click and drag an object to rearrange them.

**TIP** To prevent a table from overlapping nearby objects as its content expands in the i-Vu® interface, set preview text or expected digits for each control in the table to be as wide as the widest value the i-Vu® interface might display. Then position your table. Or, set a minimum row height or a minimum column width in the Table Editor.

Using the Table Editor

<table>
<thead>
<tr>
<th>Use this menu command...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table</strong></td>
<td>Align the table. A table can expand or shrink in the i-Vu® interface based on the values in its cells. You can align a table so that the left, right, or center of the table remains in a fixed position, regardless of the cell contents.</td>
</tr>
</tbody>
</table>
| **Table > Table Attributes** | • Set a fill color  
• Set a border thickness, color, and style |

**TIP** To create padding between the contents of a squared table and the edges of the table:

1. Set **Border Thickness** to the padding depth that you want.
2. Set **Border Color** and **Background Fill Color** to the same color.
<table>
<thead>
<tr>
<th>Use this menu command...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table &gt; Use Automatic Column Spacers</strong></td>
<td>Maintain a fixed amount of unused space between each column. <strong>TIP</strong> To increase or decrease the amount of space, turn off this option, add a column as a spacer, then set a minimum column width.</td>
</tr>
<tr>
<td><strong>Row &gt; Show/Hide</strong></td>
<td>Show or hide the selected row in the i-Vu® interface based on the value of a microblock property. See Setting objects on a graphic to show/hide in the i-Vu® interface (page 61).</td>
</tr>
</tbody>
</table>
| **Cell > Cell Attributes** | • Align the cell contents  
• Wrap text  
• Set a fill color  
• Set a border thickness and color |
Working with gauges on a graphic

ViewBuilder has two controls that let you create angular and linear gauges.

**Angular gauge**

**Linear gauge**

See:
- To add an Angular gauge to a graphic (page 36)
- Examples of Angular Gauges (page 39)
- To add a Linear Gauge to a graphic (page 44)
- Examples of Linear Gauges (page 46)

To add an Angular gauge to a graphic

1. Click the **Add Control** tab in the **Tools** window.
2. Select the **Angular Gauge** control.
3. Click in the workspace where you want to add the gauge.
4. Define the following information for the gauge in the **Properties** window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Type the width and then press Enter, or drag the gauge's corners to resize it.</td>
</tr>
<tr>
<td><strong>Reverse Direction</strong></td>
<td>Check to reverse:</td>
</tr>
<tr>
<td></td>
<td>• The direction that the bar grows</td>
</tr>
<tr>
<td></td>
<td>• The direction the needle moves</td>
</tr>
<tr>
<td></td>
<td>• The labels</td>
</tr>
<tr>
<td>Field</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Minimum** and **Maximum** | To define the range that the gauge is to display, you can enter:  
  • Absolute values, or  
  • Expressions. For example:  
    `$#io_menu/ai/min_pres_value$`  
    `$#io_menu/ai/max_pres_value$` |
| **Tick Increment**          | If you have **Ticks** checked under **Display Options**, enter one of the following to define the number of units between each tick:  
  • An absolute value, or  
  • An expression. For example:  
    `$#io_menu/ai/max_pres_value$ / 10`  
    (meaning divide maximum value by 10) |
| **Display Options**         | Check the items that you want the gauge to show:  
  • If you checked **Show Numbers**, select the **Number Orientation**.  
  • For any other item that you checked, click its color box to select a color.  
  • **Text Style**—Select **Automatic** to let the gauge determine the font, size, and color of the numbers. To create a different style, select **Custom**, and then click **A** on the toolbar to choose your options. |
| **NOTE** beside the Needle or Bar colors indicates that you can create a variable color expression (page 51) that changes the color of that item based on the control's value. |
| **Bar Thickness %**         | Enter a number between 1 and 100. This setting affects the bar, bar background, and color band thickness. Examples:  
  40%  
  100%  
  ![Bar Thickness Examples](image-url) |
### Field | Notes
--- | ---
**Gauge Angles** | Select the layout that best represents the gauge you want, or enter **Start** and **End** values. You can use the image below to pick a **Start** value, then add the number of degrees that you want the gauge to span to get the **End** value.

![Gauge Angles Diagram](image)

For example, if you enter 270 as the **Start** value and you want the gauge to be a half circle, add 270 + 180. The **End** value is 450.

### NOTES
- Maximum **End** value is 720.
- **End** value must be greater than **Start** value.
- From **Start** to **End** value is clockwise.

**TIP** You can pick a layout similar to the one you want and then tweak the **Start** and **End** values to achieve a custom layout.

**Use Background Color Bands** | Check to have the gauge show multiple colors, each color representing a range of values. Select whether you want each color band to be based on specific values or percentages. Click + to define the Start-Stop values and color for each color band.

**NOTE** Click - to remove a color.

### NOTE
If an angular gauge in the ViewBuilder workspace shows **Preview Error**, this indicates an internal error has occurred in ViewBuilder. The control's properties are still valid, and the graphic will display correctly in a running system. To remove the error in ViewBuilder, save the graphic, and then restart ViewBuilder.
Examples of Angular Gauges

Below are examples of angular gauge variations that can be created with ViewBuilder tools and images created in a graphics program.

Gradient bar color

**EXAMPLE 1**

This gradient color effect is achieved by placing a semi-transparent gradient image on top of the basic gauge.

1. Place an angular gauge in ViewBuilder's workspace, and:
   - Set the **Tick Increment** to 5.
   - Set the **Number Orientation** to **Radial**.
   - Keep the remaining default settings.

2. In a graphics program, create a semi-transparent gradient image the same size as the bar.

3. Place the image on top of the gauge. The bar should show through the transparent gradient.
**EXAMPLE 2**

You can use a thinner overlay so that the gradient and bar color show.

![Example 2 Image]

**Overlays**

The gauges above are achieved by overlaying a semi-transparent image over the basic gauge.

1. Place an angular gauge in ViewBuilder's workspace.

![Angular Gauge Image]

2. In a graphics program, create a semi-transparent image the same size as the gauge.

![Semi-Transparent Image]
3. Place the image on top of the gauge. The gauge should show through the transparent gradient.

### Glass lens effects

You can use the overlays shown below to create different lighting effects.

<table>
<thead>
<tr>
<th>Glass Lens Effect</th>
<th>Image 1</th>
<th>Image 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bubble</strong></td>
<td><img src="image1" alt="Bubble Image" /></td>
<td><img src="image2" alt="Bubble Gauge" /></td>
</tr>
<tr>
<td><strong>Crescent 1</strong></td>
<td><img src="image3" alt="Crescent 1 Image" /></td>
<td><img src="image4" alt="Crescent 1 Gauge" /></td>
</tr>
<tr>
<td><strong>Crescent 2</strong></td>
<td><img src="image5" alt="Crescent 2 Image" /></td>
<td><img src="image6" alt="Crescent 2 Gauge" /></td>
</tr>
<tr>
<td><strong>Flat lens</strong></td>
<td><img src="image7" alt="Flat lens Image" /></td>
<td><img src="image8" alt="Flat lens Gauge" /></td>
</tr>
</tbody>
</table>
The above pie chart is achieved by placing 4 angular gauges on top of each other, one gauge for each value that you want to show.

1. Add 4 angular gauges of the same size to ViewBuilder's workspace.

2. Turn off all Display Options except the Bar, and give each gauge a different bar color.

3. On the Properties > General tab, enter the following in the Microblock Path field for each gauge:
4. On the **Properties > Advanced** tab:
   * Set each gauge's **Bar Width** to 100%
   * Set the **Start** field to 0 and the **End** field to 360 so that the gauge is a complete circle.

5. Place the gauges on top of each other, align them horizontally and vertically, and then group them.

6. Select the group, then open the Group Viewer.

7. Select the first gauge in the Group Viewer and enter the following in the Minimum and Maximum fields on the **Properties > General** tab:
   
   ```
   Minimum: 0
   Maximum: $refname1/present_value$==0?0:$refname1/present_value$+ $refname2/present_value$+ $refname3/present_value$+ $refname4/present_value$
   ```

   Repeat this step for the other 3 gauges, replacing the red text with the appropriate expression for each gauge. For example, for gauge B, you would enter $refname2/present_value$==0?1:($refname1/present_value$+ $refname2/present_value$+ $refname3/present_value$+ $refname4/present_value$)

8. Add a mathematical expression to the **Microblock Path** field that will calculate what percentage of the circle each gauge will fill.

<table>
<thead>
<tr>
<th>Gauge</th>
<th>Microblock Path</th>
<th>Adds...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>$refname1/present_value$==0?0:$refname1/present_value$</td>
<td>A only</td>
</tr>
<tr>
<td>B</td>
<td>$refname2/present_value$==0?0:$refname1/present_value$+ $refname2/present_value$</td>
<td>A + B</td>
</tr>
<tr>
<td>C</td>
<td>$refname3/present_value$==0?0:$refname1/present_value$+ $refname2/present_value$+ $refname3/present_value$</td>
<td>A + B + C</td>
</tr>
</tbody>
</table>
The image below shows how the gauges overlay each other. The actual result in i-Vu® will look like this.

\[
\begin{align*}
A &= A \\
B &= A + B \\
C &= A + B + C \\
D &= A + B + C + D \\
\end{align*}
\]

### To add a Linear Gauge to a graphic

1. Click the **Add Control** tab in the **Tools** window.
2. Select the **Linear Gauge** control.
3. Click in the workspace where you want to add the gauge.
4. Define the following information for the gauge in the **Properties** window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Orientation</td>
<td>Select <strong>Horizontal</strong> or <strong>Vertical</strong>.</td>
</tr>
<tr>
<td>Reverse Direction</td>
<td>Check to reverse the direction that the bar grows.</td>
</tr>
<tr>
<td>Size</td>
<td>Type the desired width and height, or drag the gauge's corners to resize it.</td>
</tr>
<tr>
<td>Field</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Minimum and Maximum</strong></td>
<td>To define the range that the gauge is to display, you can enter:</td>
</tr>
<tr>
<td></td>
<td>• Absolute values, or</td>
</tr>
<tr>
<td></td>
<td>• Expressions. For example:</td>
</tr>
<tr>
<td></td>
<td>$#io_menu/ai/min_press_value$</td>
</tr>
<tr>
<td></td>
<td>$#io_menu/ai/max_press_value$</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> ViewBuilder shows only an absolute value. Check your graphic in the i-Vu® interface to see the results of entering an expression.</td>
</tr>
<tr>
<td><strong>Tick Increment</strong></td>
<td>If you have <strong>Ticks</strong> checked under <strong>Display Options</strong>, enter one of the following to define the number of units between each tick.</td>
</tr>
<tr>
<td></td>
<td>• An absolute value, or</td>
</tr>
<tr>
<td></td>
<td>• An expression. For example:</td>
</tr>
<tr>
<td></td>
<td>$#io_menu/ai/max_press_value$ / 10</td>
</tr>
<tr>
<td></td>
<td>(meaning divide maximum value by 10)</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> ViewBuilder shows only an absolute value. Check your graphic in the i-Vu® interface to see the results of entering an expression.</td>
</tr>
<tr>
<td><strong>Display Options</strong></td>
<td>Check <strong>Bar</strong>, <strong>Gauge Border</strong>, <strong>Gauge Background</strong>, or <strong>Ticks</strong> to show that item, then click the color box to select a color.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> beside the <strong>Bar</strong> color indicates that you can create a variable color expression (page 51) that changes the color of the bar based on the control's value.</td>
</tr>
<tr>
<td><strong>Bar Thickness %</strong></td>
<td>Enter a number between 1 and 100. Less than 100% reduces the bar and color bands within the gauge. For example, 20% would show the following in ViewBuilder:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Bar Thickness Example" /></td>
</tr>
<tr>
<td><strong>Use Background Color Bands</strong></td>
<td>Check to have the gauge show multiple colors, each color representing a range of values. Select whether you want each color band to be based on specific values or percentages. Click <img src="image" alt="Button" /> to define the <strong>Start/Stop</strong> values and color for each color band.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Click <img src="image" alt="Button" /> to remove a color.</td>
</tr>
</tbody>
</table>
Examples of Linear Gauges

Below are examples of linear gauges that can be created with ViewBuilder tools and images created in a graphics program.

Gradient gauge

This gradient color effect is achieved by overlaying a semi-transparent gradient image over the basic gauge.

1. Place a linear gauge in ViewBuilder's workspace.
2. In a graphics program, create a semi-transparent gradient image (the example above is 40% visible) with the same dimensions as the gauge.
3. Place the image on top of the gauge. The gauge should show through the transparent gradient.

Fuel gauge

This gauge is achieved by placing a triangular mask over the gauge.

1. Place a linear gauge in ViewBuilder's workspace and set its bar color to white and border color to gray
2. In a graphics program, create a black triangle and make the background transparent.
3. Place the mask on top of the gauge in ViewBuilder. Resize the mask so that it is just inside the gauge's borders.
4. Add Static Text controls for E and F.

Battery meter

This gauge is achieved by drawing basic shapes in ViewBuilder and overlaying several images.
1. Draw the battery shape in ViewBuilder, and add a Static Text control below it.

2. Place a linear gauge on top of the battery drawing and resize it to match the battery shape.

3. In a graphics program, create a semi-transparent gradient image (the example above is 40% visible). Place it on top of the linear gauge, and resize it to match the battery shape.

4. In a graphics program, create a semi-transparent hollow image. Place it on top of the gradient image, and resize it to match the battery shape.

5. Draw an outline the size of the battery and add vertical lines. Place it on top of the hollow image.

**TIP** Add a variable color statement to the linear gauge so the battery goes red if it is below 20%, yellow if it is below 50%, and green if it is over 50%.

**Advanced battery meter**

This meter is ten vertical gauges inside a battery outline. All point to the same value, but represent different ranges of the value.

1. Place a vertical linear gauge in ViewBuilder's workspace, and then set its properties. Make 10 copies of the control and place them side-by-side.

2. Draw a white rectangle to cover the border of the gauges, and draw a second rectangle to act as the battery terminal.

3. Set the Minimum and Maximum values for the first gauge on the left to 0 to 10, the next gauge's Minimum and Maximum to 11 to 20, and so on. The last gauge will be 91 to 100.
Small battery meter

This small battery gauge is achieved by drawing shapes and using variable color expressions.

1. Place a linear gauge in ViewBuilder's workspace, set its orientation to vertical, and its size to 12 x 25.

2. Draw a white rectangle large enough to have 1 pixel of black between the rectangle and the gauge. Draw a second rectangle to act as the battery terminal.

3. Add a number control for the value and a static text control for %.

 Thermometer

This thermometer is achieved by placing a mask over a vertical gauge, and using variable color and show/hide expressions.

1. Place a linear gauge in ViewBuilder's workspace, set its orientation to vertical, and its size to 25 x 100.

2. Create a mask in a graphics program.

3. Place it on top of the gauge in ViewBuilder.

4. Add a number control for the value and a static text control for %.

5. Select the linear gauge and add the following variable color expression to turn the gauge red when it reaches 80 degrees: 
   $ai/present_value$>80?'#FF0000':,'#FFFFFF'
6. Add the static text "MELTDOWN WARNING!", and then define the following show/hide expression to show it at 90 degrees:
   \$ai/present\_value\$ > 90

**Bar graph with a fixed maximum value**

This bar chart is achieved by placing individual vertical linear gauges on a background that you draw in ViewBuilder. Each gauge has a maximum value of 100.

**Bar graph with a calculated maximum value**

The bar chart below shows the same values as the one above, but the maximum value is calculated.
1. Use a linear gauge to create the X axis, Y axis, and ticks.
   ○ On the Properties > General tab, give the gauge any valid Microblock Path. This will not be used.
   ○ Enter the following:
     
     **Minimum:** 0
     **Maximum:** Math.max($refname1/present_value$, $refname2/present_value$, $refname3/present_value$, $refname4/present_value$)
     **Tick Increment:** Math.max($refname1/present_value$, $refname2/present_value$, $refname3/present_value$, $refname4/present_value$)/4
   ○ Under Display Options, check only Gauge Border and Ticks, and give them a color.

2. Place 4 linear gauges on the background in ViewBuilder's workspace, and set each gauge's orientation to vertical.

3. Add Number controls for the X and Y axis values. Use a Static Text control for 0.

4. For both the linear gauges and the Number controls below each gauge, enter the following in their Microblock Path field:

<table>
<thead>
<tr>
<th>Gauge</th>
<th>Microblock Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>$refname1/present_value$</td>
</tr>
<tr>
<td>B</td>
<td>$refname2/present_value$</td>
</tr>
<tr>
<td>C</td>
<td>$refname3/present_value$</td>
</tr>
<tr>
<td>D</td>
<td>$refname4/present_value$</td>
</tr>
</tbody>
</table>

5. For each gauge, set the Minimum field to 0 and the Maximum field to the following:

<table>
<thead>
<tr>
<th>Gauge</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>$refname1/present_value$==0?1:Math.max($refname1/present_value$, $refname2/present_value$, $refname3/present_value$, $refname4/present_value$)</td>
</tr>
<tr>
<td>B</td>
<td>$refname2/present_value$==0?1:Math.max($refname1/present_value$, $refname2/present_value$, $refname3/present_value$, $refname4/present_value$)</td>
</tr>
<tr>
<td>C</td>
<td>$refname3/present_value$==0?1:Math.max($refname1/present_value$, $refname2/present_value$, $refname3/present_value$, $refname4/present_value$)</td>
</tr>
</tbody>
</table>
D $refname4/present_value$==0?1:Math.max($refname1/present_value$,
$refname2/present_value$,$refname3/present_value$,$refname4/present_value$)

6. Starting at the top of the Number controls on the Y-axis, enter the following in
their Microblock Path field:

<table>
<thead>
<tr>
<th>Microblock Path</th>
<th>Expression</th>
</tr>
</thead>
</table>
| 1st             | Math.max($refname1/present_value$,$refname2/present_value$,
              $refname3/present_value$,$refname4/present_value$) |
| 2nd             | Math.max($refname1/present_value$,$refname2/present_value$,
              $refname3/present_value$,$refname4/present_value$)/4*3 |
| 3rd             | Math.max($refname1/present_value$,$refname2/present_value$,
              $refname3/present_value$,$refname4/present_value$)/4)*2 |
| 4th             | Math.max($refname1/present_value$,$refname2/present_value$,
              $refname3/present_value$,$refname4/present_value$)/4 |

**To use variable color expressions for gauges**

You can use variable color expressions to change the color of the following items based on microblock property values:
- Linear gauge's bar
- Angular gauge's bar or needle

1. Select the gauge.
2. Click on the toolbar.
3. Enter the expression. See Conditional expressions (page 83) and examples below.
   **NOTE** Click a color in the Color Insertion Tool to add its hexadecimal value in the expression.
4. Click OK.
   **NOTE** To remove the conditional expression, delete the text in the Expression field.

**EXAMPLE:** To add a linear gauge that will display green if the microblock property's value is from 0 to 24, yellow if 25 to 49, orange if 50 to 74, red if greater than 75, or red if less than 0.

<table>
<thead>
<tr>
<th>To...</th>
<th>Enter the expression...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a linear gauge that will display green if the microblock property's value is from 0 to 24, yellow if 25 to 49, orange if 50 to 74, red if greater than 75, or red if less than 0.</td>
<td>$damper/present_value$&gt;=0 ? ($damper/present_value$&lt;25 ? '#00FF00' : ($damper/present_value$&lt;50 ? '#FFFF00' : ($damper/present_value$&lt;75 ? '#FF8800' : '#FF0000'))))</td>
</tr>
</tbody>
</table>
Symbols are commonly used combinations of images, controls, and text that have been preconfigured and grouped. You can create your own symbols. See To edit an object in a group (page 53).

To add a symbol to your graphic

1. Click the **Add Symbol** tab in the **Tools** window.
2. In the **Look in** field, browse to the folder that contains the symbol you want.
   - **TIP** Click one of the five buttons at the left of the file list to jump to a location quickly. Hold the cursor over a button to see its destination. Click the last button to jump to the symbol library.
3. Select the symbol and then click in the workspace where you want to add the symbol.
   - **TIP** You can also double-click a symbol's name in the **Tools** window to add it to the workspace.
4. In the **Control Properties** window, edit properties as needed for the individual controls in the symbol.
   - **TIP** To add a symbol multiple times, select the symbol, then Shift+click the workspace for each symbol.

To create a symbol in ViewBuilder

1. In ViewBuilder, click **Area**, then select **Area**.
2. Add the objects to the workspace that you want to include in your symbol.
3. Enter control properties, if needed.
4. Select **File > Save As**.
5. In the **Files of type** field, select **Symbol (*.viewsymbol)**.
6. Type a **File name**, then click **Save**.
   - **TIP** When adding a symbol you created, double-click the symbol in the **Tools** window to have it added at the same location in the workspace that it was in when you created it.
Working with grouped objects

You can group objects so that you can handle them as if they were one object.

A symbol (page 52) is a collection of grouped objects.

To group objects

Select the objects in the workspace, and then use the right-click Group menu command or the Group option on the tab in the Tools window.

NOTES
• You can add a group to another group.
• To ungroup objects, select the group, and then use the right-click Ungroup menu or the Ungroup option in the Tools window.

To edit an object in a group

You can edit an object in a group without ungrouping it.

1. Select the group in the workspace.

2. Click on the toolbar to open the Group Viewer window that shows the group’s objects in the same order (top to bottom) as they are in the group in the workspace.

3. Select an object in the Group Viewer window. This will select it in the workspace and display its attributes in the Properties window so that you can edit them.

NOTE If you change something that affects the appearance of the object, the Group Viewer window will update the image for that object.
Working with layers on a graphic

You can create a graphic with multiple layers. By adding objects to different layers, you can:

- Turn off a layer in ViewBuilder to simplify the workspace.
- Lock a layer so that its objects cannot be edited or moved.
- Show or hide a layer’s objects in the i-Vu® interface based on a single microblock’s value.

**NOTES**

- Locked items cannot be edited or moved.
- To move an object to a different layer, right-click the object, and then select **Move To Layer**. The status bar at the bottom of the ViewBuilder window shows the layer of the selected object, the one with the green handles.
• If you attempt to delete a layer that contains objects, ViewBuilder will ask you which layer you want to merge the objects into.
• Layers are preserved when importing a .viewsymbol.
• If cutting/copying a selection assigned to layers, you must hold Shift while pasting in a new file to preserve layer assignments.

**To show/hide a layer in the i-Vu® interface**

If you have multiple items on a graphic that you need to show or hide based on a single microblock's value or on a *local variable* (page 88), you can place all of those items on a layer and then define a show/hide condition for the layer.

1. Select the layer on the **Layers** tab in the **Tools** window.
2. Click **Layers** tab.
3. Enter a conditional expression. See *Conditional expressions* (page 83).
4. Select **Show When True** or **False**.
5. Click **OK**.

**NOTE** To remove the conditional expression, delete the text in the **Expression** field.

<table>
<thead>
<tr>
<th>EXAMPLE</th>
<th>Expression example</th>
</tr>
</thead>
<tbody>
<tr>
<td>You may want to reuse a graphic with reheat for multiple locations in your system, but one of the locations does not support reheat. To hide the reheat objects at that location, you would put those objects on a separate layer in your graphic and then enter a Show/Hide conditional expression for the layer.</td>
<td>??hw_valve?? and select <strong>Show when True</strong></td>
</tr>
</tbody>
</table>
Drawing lines and shapes on a graphic

ViewBuilder’s drawing tools let you draw vector lines and shapes. These tools are on the tab in the Tools window.

To define drawing attributes

On the tab, set the following Default Attributes that ViewBuilder will use for each new line or shape. After you draw the line or shape, you can change its attributes in the Control Properties window.

Check any of the following:

- **Line Thickness** if drawing a line or giving a shape a border. Select the thickness and **Line Color**.
- **Background Fill Color** to fill a shape with a color. Select the color.
- **Fill Pattern** to fill a shape with a pattern. Select the pattern. The **Background Fill Color** is the pattern’s first color. Select a **Fill Pattern Color** as the second color.

To draw a line

1. Select .
2. Click in the workspace, but do not release the left mouse button. Drag the cursor to draw.
   
   **NOTE** Hold down the Ctrl key as you draw to restrict the line to vertical or horizontal.
3. Optional: To add a line segment: While still holding the left mouse button, click and release the right mouse button, then drag in a new direction.
4. Release the left mouse button to complete the drawing.
5. If needed, change the line’s attributes (page 56) in the Control Properties window.
To draw a polygon

1. **Select** 

2. Click in the workspace, but do not release the left mouse button. Drag the cursor to draw the first side of the polygon.

3. While still holding the left mouse button, click and release the right mouse button, then drag in a new direction to draw the next side of the polygon.
   **NOTE** Hold down the **Ctrl** key as you draw to restrict angles to right angles.

4. Repeat step 3 as many times as needed.

5. Release the left mouse button to complete the shape.

6. If needed, change the shape’s attributes (page 56) in the **Control Properties** window.

To draw a rectangle, square, ellipse, or circle

1. **Select** to draw a rectangle or square, or select to draw an ellipse or circle.

2. Click in the workspace, but do not release the left mouse button. Drag the cursor to draw.
   **NOTE** Hold down the **Ctrl** key as you draw to form a square or circle.

3. Release the left mouse button to complete the shape.

4. If needed, change the shape’s attributes (page 56) in the **Control Properties** window.

To resize or reshape a drawing

1. Select the line or shape in the workspace.

2. Double-click the shape, or click **Edit Drawing** button in the **Control Properties** window. The drawing’s points change from to.

3. Edit the line or shape.
   - To resize a rectangle, square, ellipse, or circle, click a corner point and drag it.
     **NOTE** To maintain a circle or square, hold down **Ctrl** while dragging.
   - To reshape a line or polygon:
     - To move a point, click it and drag it.
     - To delete a point, right-click it.
     - To add a point, move the cursor on top of a line or border until the cursor changes to +, then right-click.
     **NOTE** You can press **Esc** to remove your edits.

4. Left-click in the workspace to save edits.
Adding links to a graphic

You can link images and some controls to other pages in the i-Vu® interface or to the Internet.

To add a link

1. Select the object that is to be a link.
   
   **NOTE** You can select multiple objects to link them to the same destination. The objects must all have linking capability.

2. Click🔗 on the toolbar.

3. Enter the requested information. See table below.

4. Click OK.
   
   **NOTE** To remove the link from the control, delete the text in the **Link** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Link</strong></td>
<td>Enter one of the following:</td>
</tr>
<tr>
<td></td>
<td>• The <strong>path</strong> (page 79) to an item on the navigation tree</td>
</tr>
<tr>
<td></td>
<td>• A <strong>URL</strong> to link to an Internet web page</td>
</tr>
<tr>
<td></td>
<td>• The path to an external file. See <strong>To add a link to an external file</strong> (page 59).</td>
</tr>
<tr>
<td></td>
<td>• An * if you are linking from one graphic to another graphic for the same tree item</td>
</tr>
<tr>
<td><strong>Scope</strong></td>
<td>Select:</td>
</tr>
<tr>
<td></td>
<td>• <strong>system</strong> to link to another page in the i-Vu® interface</td>
</tr>
<tr>
<td></td>
<td>• <strong>external</strong> to link to a URL address or an external file. An external link opens in a separate window.</td>
</tr>
<tr>
<td><strong>Action Button</strong></td>
<td>Choose the action button to be selected when the operator clicks the link.</td>
</tr>
</tbody>
</table>
Field | Notes
--- | ---
**Advanced tab** | Enter the reference name for the Tab and Category that the i-Vu® interface will display when the operator clicks the link. To find these names, go to the location in the i-Vu® interface that you want to link to and use the `whereami` manual command. See “Manual Commands” in i-Vu® Help.

If the location that you want to link to does not have categories, type `default` in the Category field.

**Instance** | If you are linking to a graphic and the tree item has more than one graphic, type the name of the .view file that you want the i-Vu® interface to display, omitting the .view file extension. For example, second_floor_1801.

**Type** | Navigation—links to an item on the navigation tree.  
Source—links to heat or cool source.  
Interactive-popup—opens a pop-up window such as a microblock pop-up.

**Underline Link** | Check to underline the link. Uncheck to remove the underline.

---

To add a link to an external file

i-Vu® Pro application only:

You can add a link that opens an external file such as a PDF or an XLS spreadsheet. External links open in a separate window.

1. Put the file you want to link to in the `webroot\<system_name>\linked_resources` folder.
2. In ViewBuilder, select the object you want to be a link.
3. Click on the toolbar.
4. In the **Link** field, type: `\%system\linked_resources\<file name>`  
   For example, `\%system\linked_resources\ac12.pdf`

   **NOTE** This field is case-sensitive and requires the file extension (.pdf in the example).
5. In the **Scope** field, select external.
6. Click **OK**.
To add a link to a i-Vu® add-on

You can add a link that opens a i-Vu® add-on application such as Tenant Override Billing.

1. Select the object that is to be a link.
2. Select Edit > Add-on Link.
3. Enter the requested information. See table below.
4. Click OK.

<table>
<thead>
<tr>
<th>Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link</td>
<td>Type the part of the add-on’s web browser address that follows the i-Vu® server's address. For example, if the add-on's web browser address is <a href="http://172.16.2.163/TenantOverrideBilling">http://172.16.2.163/TenantOverrideBilling</a>, type /TenantOverrideBilling in the Link field.</td>
</tr>
<tr>
<td>Open In</td>
<td>Select Current Window to have the add-on replace the i-Vu® interface in the web browser, or select New Window to open a new web browser window.</td>
</tr>
<tr>
<td>Underline Link</td>
<td>Select to underline the linking object in the graphic.</td>
</tr>
</tbody>
</table>
### Setting objects on a graphic to show/hide in the i-Vu® interface

You can set images, most controls, and table rows on a graphic to show or hide in the i-Vu® interface based on the value of a microblock property.

#### TIPS
- To show/hide multiple objects based on a single microblock value, add the objects to a layer. See To show/hide a layer in the i-Vu® interface (page 55).
- You can use local variables (page 88) in conditional expressions to show/hide objects.

#### To set an image or control to show/hide

1. Select the image or control.
2. Click ![show/hide icon](image) on the toolbar.
3. Enter a conditional expression. See Conditional expressions (page 83) and examples below.
4. Select **Show When True** or **False**.
5. Click **OK**.

**NOTE** To remove the conditional expression, delete the text in the **Expression** field.

#### EXAMPLES:

<table>
<thead>
<tr>
<th>To...</th>
<th>Enter the expression...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a Static Text control that shows “freezestat” when freezestat is in alarm</td>
<td>$\text{air_flow/full_open}===\text{true}$ and select <strong>Show when True</strong></td>
</tr>
<tr>
<td>Add a Toggle Button control that shows an alarm reset button (up and down image) only when an alarm occurs</td>
<td>$\text{alarm/present_value}===\text{true}$ and select <strong>Show when True</strong></td>
</tr>
<tr>
<td>Add a hot water valve image to an AHU graphic that appears only if the associated control program has a microblock called hw_valve</td>
<td>??\text{hw_valve}?? and select <strong>Show when True</strong></td>
</tr>
</tbody>
</table>

#### TIPS
- If you do not see an object when you test your graphic in the i-Vu® interface, look for the show/hide icon to the left of the object in ViewBuilder. This icon helps you quickly determine that the object is hidden, not missing.
- To simultaneously set multiple objects to show/hide using the same conditional expression, select the objects, then click ![show/hide icon](image).

**NOTE** Each of the objects must have show/hide capability.
To set a table row to show/hide

1. Open the Table Editor. See Working with tables (page 33).
2. Click in the row.
3. Select Row > Show/Hide.
4. Enter a conditional expression. See Conditional expressions (page 83).
5. Select the Show or Hide when True option.
6. Click OK.

**NOTE** To remove the conditional expression, delete the text in the Expression field.
You can search for every instance of specific text that you entered in expressions and control properties. You can then replace selected instances with other text.

1. Select **Edit > Find/Replace**.

2. Type the word or phrase in the **Find What** field, or click the drop-down arrow to select from text recently entered in this field.

3. Click **Find**.

4. Select which **Found items** you want to change.

5. Enter the replacement text in the **Replace With** field.

6. Click **Replace**.
Editing an image in a graphic

1. Edit the original image (.gif, .png, or .jpg) in a graphics program.
   
   **NOTE** If you do not have the original image, follow the procedure below in “To export an image”.

2. If the image in your graphic has no functionality in ViewBuilder, such as show/hide or linking, delete the image, then add the revised image.

To export an image

To export an image from your .view file:

1. Right-click the image in the workspace, select **Export Image**.

2. Save the file in any folder.
Creating a data table, chart, or color map from a i-Vu® report

An i-Vu® Pro custom report can be the data source for the following items on a Graphics page:

- A data table
- A chart
- A color map

For example, this report...

...supplies data to the chart and data table on this graphic

To produce a data table

To produce a data table like the example below, first create the report in the i-Vu® interface and then create the corresponding graphic in ViewBuilder.
To create the report in the i-Vu® interface

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Reports</strong> drop-down arrow, and then select <strong>Report Manager</strong>.</td>
<td><img src="https://example.com/example1.png" alt="Example" /></td>
</tr>
<tr>
<td>2. Click <strong>Add</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. On the Report Editor’s <strong>Type</strong> tab, type a <strong>Display name</strong> and <strong>ID</strong> for the report.</td>
<td><img src="https://example.com/example2.png" alt="Example" /></td>
</tr>
<tr>
<td>4. In the <strong>Primary column</strong> field, select the type of information that you want the report to be based on (<strong>Control Programs</strong> in this example).</td>
<td><img src="https://example.com/example3.png" alt="Example" /></td>
</tr>
<tr>
<td>5. On the Type tab, enter the criteria for the option that you selected in step 4.</td>
<td><img src="https://example.com/example4.png" alt="Example" /></td>
</tr>
<tr>
<td>6. In the <strong>Primary column header</strong> field, enter the heading that you want for that column (<strong>Equipment</strong> in this example).</td>
<td><img src="https://example.com/example5.png" alt="Example" /></td>
</tr>
<tr>
<td>7. Define each column in the report on the <strong>Columns</strong> tab. See the examples on the right.</td>
<td><img src="https://example.com/example6.png" alt="Example" /></td>
</tr>
<tr>
<td>8. Define any other information you may want, and then click <strong>Accept</strong>.</td>
<td><img src="https://example.com/example7.png" alt="Example" /></td>
</tr>
</tbody>
</table>
### Instructions

<table>
<thead>
<tr>
<th>Type</th>
<th>Columns</th>
<th>Variables</th>
<th>Where</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path</td>
<td>Path</td>
<td>Path</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Example

**Display Name**: Static Pressure Setpoint
**ID**: static_pressure_setpoint
**Render data as**: Value
**Column format**: Align: Left, Width: 0, Digits: 0.0
**Path**: $static_pressure_setpoint$
**Show value as text?**: Yes

**Display Name**: Difference
**ID**: static_delta
**Render data as**: Hidden
**Column data from**: Expression
**Expression**: $static_pressure_setpoint - static_pressure$

**Display Name**: Pressure Status
**ID**: status
**Render data as**: Icon
**Column format**: Align: Center, Width: 0
**Column data from**: Expression
**Expression**: if(static_delta < 0, 'light_on_red.png', 'light_on_green.png')
To create the graphic in ViewBuilder

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select <strong>File &gt; New &gt; Graphic</strong>, and then click <strong>OK</strong>.</td>
<td><img src="data_table.png" alt="Image of Data Table control" /></td>
</tr>
<tr>
<td>2. Click the <strong>Add Control</strong> tab in the <strong>Tools</strong> window.</td>
<td></td>
</tr>
<tr>
<td>3. Click the <strong>Data Table</strong> control and then click in the workspace.</td>
<td></td>
</tr>
<tr>
<td>4. In the Properties window, enter the <strong>Report ID</strong> exactly as it appears in the i-Vu® Report Editor.</td>
<td><img src="data_table_properties.png" alt="Image of Data Table with properties" /></td>
</tr>
<tr>
<td>5. Resize the control so that it is at least the size that the table will be in the i-Vu® interface. To resize, enter a specific size in the Properties window or drag the handles on the control. <strong>NOTE</strong> If the table is cut off when you view the graphic in the i-Vu® interface, increase the size of the data table control in ViewBuilder.</td>
<td></td>
</tr>
<tr>
<td>6. If you defined variables in the Report Editor and you want to use a different default value for the Data Table, click <img src="add_variable.png" alt="Image of add variable" /> in the Properties window, type the variable's ID (from the Report Editor), and then type the new default value. <strong>NOTE</strong> To have the data table show data for a location other than the graphic's location, add a variable and type <strong>location</strong> in the <strong>ID</strong> column. Type the path to the location in the <strong>Value</strong> column.</td>
<td></td>
</tr>
<tr>
<td>7. Save the graphic.</td>
<td></td>
</tr>
</tbody>
</table>
To produce a chart

To produce a bar chart like the example below, first create the report in the i-Vu® interface and then create the corresponding graphic in ViewBuilder.

**NOTE** When a chart that is based on a report is displayed on a Graphics page, you can hover over various points on the chart to see values. You can also click on each item in the legend to turn that information on and off. See Using a custom report as the source for a Graphics page for more information on a chart.
To create the report in the i-Vu® interface

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Reports</strong> drop-down arrow, and then select <strong>Report Manager</strong>.</td>
<td><img src="image1" alt="Report Manager" /></td>
</tr>
<tr>
<td>2. Click <strong>Add</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. On the Report Editor’s <strong>Type</strong> tab, type a <strong>Display name</strong> and <strong>ID</strong> for the report.</td>
<td></td>
</tr>
<tr>
<td>4. In the <strong>Primary column</strong> field, select the type of information that you want to report based on (<strong>Date Range</strong> in this example).</td>
<td><img src="image2" alt="Primary column" /></td>
</tr>
<tr>
<td>5. On the <strong>Type</strong> tab, enter the criteria for the option that you selected in step 4.</td>
<td></td>
</tr>
<tr>
<td>6. In the <strong>Primary column header</strong> field, enter the heading that you want for that column (<strong>Date Range</strong> in this example).</td>
<td><img src="image3" alt="Primary column header" /></td>
</tr>
</tbody>
</table>
### Instructions

7. Define each column in the report on the Columns tab.

   **NOTE** In the example to the right, all four columns have the same criteria.

8. Define the **Chart** options on the Output tab.

9. Define any other information you may want, and then click **Accept**.

### Example

- **Display Name**: E1
- **ID**: q1
- **Random data as**: Value
- **Column format**: Align: Right, Width: 0, Digits: 0.0
- **Trend path**: #01/kw_usage
- **Operation**: Aggregate Consumption
- **Midnight sample**: Include 00/24:00
- **Database trends only**: unchecked
- **Show time of sample**: unchecked
- **Time range**: From primary column
- **Axis label**: Consumption (kWh)
- **Data series**: By column
- **Show title**: checked
- **Show legend**: checked
- **Show chart border**: checked
To create the graphic in ViewBuilder

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select <strong>File &gt; New &gt; Graphic</strong>, and then click <strong>OK</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Click the <strong>Add Control</strong> tab in the <strong>Tools</strong> window.</td>
<td><img src="chart.png" alt="Chart" /></td>
</tr>
<tr>
<td>3. Click the <strong>Chart</strong> control and then click in the workspace.</td>
<td></td>
</tr>
<tr>
<td>4. In the Properties window, enter the <strong>Report ID</strong> exactly as it appears in the i-Vu® Report Editor.</td>
<td></td>
</tr>
<tr>
<td>5. Select the <strong>Type</strong> of chart you want.</td>
<td></td>
</tr>
<tr>
<td>6. Resize the control so that it is at least the size that the chart will be in the i-Vu® interface. To resize, enter a specific size in the Properties window or drag the handles on the control.</td>
<td><img src="variables.png" alt="Variables" /></td>
</tr>
<tr>
<td><strong>NOTE</strong> If the chart is cut off when you view the graphic in the i-Vu® interface, increase the size of the chart control in ViewBuilder.</td>
<td></td>
</tr>
<tr>
<td>7. If you defined variables in the Report Editor and you want to use a different default value for the chart, click + in the Properties window, type the variable's ID (from the Report Editor), and then type the new default value.</td>
<td><img src="variables.png" alt="Variables" /></td>
</tr>
<tr>
<td><strong>NOTE</strong> To have the chart show data for a location other than the graphic's location, add a variable and type <strong>location</strong> in the <strong>ID</strong> column. Type the path to the location in the <strong>Value</strong> column.</td>
<td><img src="variables.png" alt="Variables" /></td>
</tr>
<tr>
<td>8. Save the graphic.</td>
<td></td>
</tr>
</tbody>
</table>
To produce a color map

A Graphics page color map shows specified colors for various conditions that are defined in an i-Vu® Pro report. For example, a floorplan could show the percentage of time each zone is occupied. See image below. NOTE For this type of color map, the control program must have a means of trending occupancy.

A color map can also have an option that lets a user switch between different kinds of information. For example, in the image below, a user could click on the MTD kWh drop-down list and select YTD kWh.

To produce a color map:

1. Create the graphic in ViewBuilder.
2. Create the corresponding report in the i-Vu® interface.
3. Edit the graphic to add information specific to the i-Vu® report.

See instructions below.
Create the graphic in ViewBuilder

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Add an image (floorplan, campus map, etc.) to the graphic, and then double-click the image to open the <strong>Associations</strong> window.</td>
<td>![Associations Window]</td>
</tr>
<tr>
<td>2. Associate each item on your image (zone, building, etc.). See &quot;Associating zones on a floorplan to equipment&quot; in ViewBuilder Help.</td>
<td>![Variable Color]</td>
</tr>
<tr>
<td><strong>NOTE</strong> The <strong>Variable Color</strong> checkbox in the Associations window must be checked.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Save and Close</strong>.</td>
<td>![Save and Close]</td>
</tr>
</tbody>
</table>

Create the report in the i-Vu® interface

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Reports</strong> drop-down arrow, and then select <strong>Report Manager</strong>.</td>
<td>![Report Manager]</td>
</tr>
<tr>
<td>2. Click <strong>Add</strong>.</td>
<td>![Add]</td>
</tr>
<tr>
<td>3. On the Report Editor's <strong>Type</strong> tab, type a <strong>Display name</strong> and <strong>ID</strong> for the report.</td>
<td>![Type Tab]</td>
</tr>
<tr>
<td>4. Uncheck <strong>Show in Reports menu</strong>.</td>
<td>![Show in Reports menu]</td>
</tr>
<tr>
<td>5. In the <strong>Primary column</strong> field, select <strong>Color Map</strong>.</td>
<td>![Primary column]</td>
</tr>
<tr>
<td>6. Type a location in your system so that you can preview the report (<strong>#floor_1</strong> in the example). This location is only for testing your entries in the Report Editor. Associations to actual locations in the system will be made in ViewBuilder. <strong>NOTE</strong>: You can add more than one location if you want to see more in the preview.</td>
<td>![Preview Locations]</td>
</tr>
<tr>
<td>7. Click <strong>Add</strong>.</td>
<td>![Add]</td>
</tr>
</tbody>
</table>
8. Define each column in the report on the Columns tab. See examples of the first two columns on the right.

A color map can retrieve color information only from a column that has the **Render data as** field set to **Color**.

9. Define any other information needed on the Report Editor tabs, and then click **Accept**.
Edit the graphic in ViewBuilder to add report information

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow steps 1 through 5 if the colormap will show information from more than one report column. If not, skip to step 6.</td>
<td></td>
</tr>
<tr>
<td>1. Select <strong>Configure &gt; View Properties</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
| 2. On the **Local Variables** tab, click ![icon](https://via.placeholder.com/15). | ![image](https://via.placeholder.com/150x150)
| 3. Double-click **Boolean** in the **Type** column, and then select **Report column** in the drop-down list. | ![image](https://via.placeholder.com/150x150)
| 4. Double-click **variable** in the **Name** column, and then replace **variable** with **colormap_column**. **NOTE** If the Graphic has multiple images that will pull data from different reports, add one variable called **colormap_column1**, another called **colormap_column2**, etc. | ![image](https://via.placeholder.com/150x150)
| 5. Click **OK**. | ![image](https://via.placeholder.com/150x150)
| 6. Double-click the image to open the **Associations** window. | ![image](https://via.placeholder.com/150x150)
| 7. Click ![icon](https://via.placeholder.com/15). and then enter the following information: | ![image](https://via.placeholder.com/150x150)
| • **Report ID**: Get the report ID from the i-Vu® Report Editor. | ![image](https://via.placeholder.com/150x150)
| • **Default Column ID**: This is the column whose color is displayed when the graphic first appears. Get the Column ID from the i-Vu® Report Editor. Leave blank if the graphic will pull data from only one report column. | ![image](https://via.placeholder.com/150x150)
| • **Column Name Local Variable**: Type the name of the variable that you created in step 5 above. Leave blank if the graphic will pull data from only one report column. | ![image](https://via.placeholder.com/150x150)
### Instructions | Example
--- | ---
8. If a report uses a variable and you want the colormap to use a different default value than what is defined in the i-Vu® Report Editor, click + in the **Report Properties** window, type the variable’s ID (defined in the Report Editor), and then type the new default value.

9. If the colormap will show information from more than one report column, add a control (droplist or radio buttons) that will allow the user to select the information they want to see.

10. In the **Microblock Path** field, enter the local variable that you defined in step 4, enclosing it in $$.

11. Finish the graphic and then test it in the i-Vu® interface.
### Miscellaneous ViewBuilder menu commands and features

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tools &gt; Configure</strong></td>
<td>Use this command if directed by Technical Support to install an added ViewBuilder feature.</td>
</tr>
<tr>
<td><strong>Help &gt; Apply Update</strong></td>
<td>Use this command to install service packs or patches.</td>
</tr>
</tbody>
</table>
A path tells the i-Vu® application the route through the system hierarchy to an item in the system. For example, a path tells the i-Vu® application where to find a microblock property value to display on a graphic or where to jump to when the operator clicks a link on a graphic.

In ViewBuilder, you use paths in:

- Controls (page 21)
- Links (page 58)
- Conditional expressions (page 83)

In i-Vu®, you use paths in:

- The source field code in alarm actions and messages
- An Equipment Values report
- The go manual command
- i-Vu® Pro only: Autopilot

You can do one of the following to get the path:

- In ViewBuilder, let ViewBuilder write the path (page 80).
- In the i-Vu® interface, determine the path yourself (page 81).

A path consists of the reference name of each tree item included in the path, separated by a forward slash (/). For example, first_floor/zone_1/rs.

A path can be absolute (page 79) or relative (page 80).

i-Vu® paths are based on parent-child hierarchy.

### Absolute path

An absolute path begins at a specific point in the system hierarchy and is followed by the children below it down to the object or property of interest. An absolute path can begin with either of the following:

- A global reference name—a reference name that is unique within the entire system and begins with a # sign. **EXAMPLE** If OA Conditions has a global reference name of #oa_conditions, the absolute path to OA Conditions is simply #oa_conditions. The absolute path to any child of OA Conditions, such as OA Temperature, begins with #oa_conditions. For example, #oa_conditions/oa_temp.

- The top of the i-Vu® tree.
Relative path

A relative path is useful for items such as graphics or alarm messages that you will reuse in multiple i-Vu® locations because the path is relative to the item that contains the path.

A relative path going down the tree

A relative path going down the tree begins with the reference name of the item below the location where the path is used. Examples using the system shown above:

- To display the Lobby’s zone temperature on the Lobby’s graphic, the path is rs.
- To display the Lobby’s zone temperature on the Atlanta-R&D Facility graphic, the path is first_floor/zone_1/rs.

A relative path going up the tree

A relative path going up the tree begins with a ~ followed by one of the options below:

<table>
<thead>
<tr>
<th>Use...</th>
<th>To go...</th>
<th>Examples using the system shown above</th>
</tr>
</thead>
<tbody>
<tr>
<td>~parent</td>
<td>Up one level</td>
<td>1 To put a link on the Lobby graphic that goes to the First Floor graphic, the path is ~parent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 To put a link on the Lobby graphic that goes to the Atlanta R&amp;D Facility (up 2 levels), the path is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>~parent/~parent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 To display the Lobby’s zone temperature on the Boiler graphic, the path is ~parent/~parent/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>first_floor/zone_1/rs/present_value.</td>
</tr>
<tr>
<td>~equipment</td>
<td>To the microblock’s control program</td>
<td>To display the Lobby zone temperature in a High Temp alarm message, the path is ~equipment/rs/present_value.</td>
</tr>
<tr>
<td>~device</td>
<td>From a control program to its device</td>
<td>To show the device name on an equipment graphic, use ~device.display-name.</td>
</tr>
</tbody>
</table>

To have ViewBuilder write microblock path

ViewBuilder can create the path for a control, link, or conditional expression.

1 If you do not see the System window, click ☐ on the toolbar.
2 Select Database, then select the system you want from the drop-down list.
3 Click Next.
4 In the Name field, select your user name from the drop-down list.
5 Type your Password.
6 Click Next.
7 To get a relative path (page 80), right-click the area or piece of equipment whose graphic you are creating or editing, select Set Base Path.
8 Select the item whose path you want.

9 Do one of the following:
   ○ If the path is for a link or conditional expression, copy the path shown in the field below the system tree.
   ○ If the path is for a control, right-click the control in the workspace or the **Microblock Path** field in a **Control Properties** window, then select **Set Microblock Path Expression**.

---

**Determining a path or microblock property**

A path tells the i-Vu® application the route through the system hierarchy to an item in the system. Paths are used in graphics, links, alarm messages, alarm actions, network microblock address, and other items.

**To get the path to an area, equipment, or microblock**

In the i-Vu® interface, right-click the item on the tree, then select **Copy Path**. Paste the path where you need it.
To get the path to a microblock property value

1. In the i-Vu® interface, right-click the value, then select **Global Modify**.

2. Click **Show Advanced** to see the full path to the property value.
Conditional expressions in a graphic

You can type a conditional expression in ViewBuilder to do one of the following based on a microblock property value or the existence of a path:

- Show or hide an object
- Enable or disable an object
- Display text in variable colors
- Display variable text

You can also use local variables in conditional expressions (page 88) to make various controls react to user interaction in a running system.

Show/hide or enable/disable expressions

The following scenario shows how you could use an expression to show or hide a control on a graphic. Enable/disable works the same way.

1. In ViewBuilder, you right-click a control, select **Show/Hide**, then type the following expression in the **Show/Hide** dialog box.

   **Expression:** $zone_temp/present_value$<70
   **Translation:** The present value of the zone temperature is less than 70.

2. You select **Show When True**.

3. When the graphic is displayed in the i-Vu® interface, the actual zone temperature is 75. Because the expression is false, i-Vu® hides the control.

Breakdown of the above expression

1. **$zone_temp/present_value$**
   - A path to a microblock property (enclosed in dollar signs)
   - Example: $zone_temp/present_value$
   - The path can be relative, absolute, or global. See Defining i-Vu® paths (page 79).

2. **<**
   - An operator
   - Example: <
   - A character that represents the relationship between the value of the microblock property and the literal value. See Operators (page 87) for a complete list of operators.
A literal value  Example:  70
Either a number, as in the above example, or true or false, as in $zone_temp/locked$==true.

Variable color expressions

The following example shows how you could enter an expression to cause a text control to change color in the i-Vu® interface based on the value of a microblock property.

1. In ViewBuilder, select a control that displays alphanumeric characters, and then click  on the toolbar.

2. Type the following expression.

   Expression:  

   Translation:  

   NOTE  Click a color in the Color Insertion Tool to add its hexadecimal value in the expression.

3. When the graphic is displayed in the i-Vu® interface, the actual zone temperature is 75. Because the expression is false, the control is yellow in the i-Vu® interface.

Breakdown of the above expression

1. A path to a microblock property  (enclosed in dollar signs)  Example:  $zone_temp/present_value$
   The path can be relative or absolute. See Defining i-Vu® paths (page 79).

   NOTE  You can select the microblock in ViewBuilder's System window to display the path, which you can then copy and paste into your conditional expression. To use a relative path, right-click the area or piece of equipment whose graphic you are creating, then select Set Base Path.

2. An operator  Example:  <
   A character that represents the relationship between the value of 1 the microblock property and 3 the literal value. See Operators (page 87) for a complete list of operators.

3. A literal value  Example:  70
   Either a number, as in the above example, or true or false, as in $zone_temp/locked$==true.

4. A result  Example:  ?'#FF0000':'#FFF660'
   Variable color expressions include a color if the expression is true (#FF0000) and another color if the expression is false (#FFF660). The format of this part of the equation is ?'true color':'false color'.
NOTE In a variable color expression, you enter a hexadecimal value for a color, such as #FF0000 for the color red. Color values must be enclosed in single quotation marks. For example, ‘#FF0000’.

To find the hexadecimal value of a color
1 Right-click on any text control and select Variable Color.
2 Click Custom.
3 Select the color you want.
4 Click OK.
5 Copy the hexadecimal value in the Expression field.

Variable text expressions

The following example shows how you can use a single-line text control to display varying text in the i-Vu® interface based on the value of a microblock property.

1 In ViewBuilder, type the following expression in the Microblock Path field of the Control Properties window, and clear the Property field.

<table>
<thead>
<tr>
<th>Expression:</th>
<th>Translation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>(($sfan/present_value$==true)?&quot;Running&quot;:&quot;Not running&quot;)</td>
<td>If the statement &quot;The supply fan's present value is true (on)&quot; is true, show Running. If false, show Not running.</td>
</tr>
</tbody>
</table>

2 When the graphic is displayed in the i-Vu® interface, the supply fan is off. Because the expression is false, Not running is displayed.

Breakdown of the above expression

1 A path to a microblock property (enclosed in dollar signs) Example: $sfan/present_value$
   The path can be relative or absolute. See Defining i-Vu® paths (page 79).
2 An operator Example: ==
   A character that represents the relationship between the value of 1 the microblock property and 3 the literal value. See Operators (page 87) for a complete list of operators.
A literal value  Example:  true
A value such as true as in the above example, or a number such as 70 in the example
$zone_temp/present_value$<70.

A result  Example:  ?'Running':'Not running'
Variable text expressions include the text to show if the expression is true (Running) and text to show if the
expression is false (Not running). The format of this part of the equation is ?'true text':'false text'.

Combining expressions

Below are three methods, with examples, that you can use to combine expressions.

Method 1: Use the And (&&) or the Or (||) operator
Expression using  $zone_temp/locked$==false
the And operator:  &&$zone_temp/present_value$>75
                  ?'FF0000':'FFF660'
Translation:  The zone temperature is not locked and the current value of the zone temperature
              is greater than 75. If both of these statements are true, show red ('FF0000'); if
              either is false, show yellow ('FFF660').

Method 2: Use the Ternary (? :) operators
Expression:  $zone/M001/present_value$==1
            ?'FF0000':$zone/M001/present_value$==2
            ?'FFF660':$zone/M001/present_value$==3
            ?'FFFFFF':#FF00FF'
Translation:  The present value of M001 is 1. If this is true, show red ('FF0000). If false,
              evaluate the next statement. The present value of M001 is 2. If this is true, show
              yellow ('FFF660'). If false, evaluate the next statement. The present value of
              M001 is 3. If this is true, show white ('FFFFFF'). If false, show magenta
              ('FF00FF').

Method 3: Nest expressions
Expression:  $zone_temp/locked$==true
            ?($zone_temp/locked_value$>75?'FF0000':'FFF660')
            :'#00FF00'
Translation:  The zone temperature is locked. If this statement is false, show green
              ('#00FF00'). If true, evaluate the nested statement that the locked value is
              greater than 75. If this statement is true, show red ('FF0000'); if false, show
              yellow ('FFF660').
Operators

An operator defines how each piece of an expression is to be handled. For example, an operator can compare or perform an action between the value of a microblock property, a literal value, or the result of an expression. The following table lists operators that can be used in expressions.

<table>
<thead>
<tr>
<th>Path Operators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$path$</td>
<td>Get value</td>
</tr>
<tr>
<td>$??path??$</td>
<td>Check for presence</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operators that return true/false</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>!</td>
<td>Not</td>
</tr>
<tr>
<td>==</td>
<td>Equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>And</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operators that return a numeric value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Add</td>
</tr>
<tr>
<td>-</td>
<td>Subtract</td>
</tr>
<tr>
<td>*</td>
<td>Multiply</td>
</tr>
<tr>
<td>/</td>
<td>Divide</td>
</tr>
<tr>
<td>%</td>
<td>Modulus</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other operators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>? :</td>
<td>Ternary</td>
</tr>
<tr>
<td>()</td>
<td>Parentheses</td>
</tr>
</tbody>
</table>

Path Operators

- **$path$**: Gets the value of the path.
- **$??path??****: Checks for the existence of the path. If it exists, the expression is true. If it does not, the expression is false.

Operators that return true/false

- **<**: Compares numeric data. Returns true if the value to the left of the operator is smaller than the value to the right.
- **>**: Compares numeric data. Returns true if the value to the left of the operator is larger than the value to the right.
- **<=**: Compares numeric data. Returns true if the value to the left of the operator is smaller than or equal to the value to the right.
- **>=**: Compares numeric data. Returns true if the value to the left of the operator is larger than or equal to the value to the right.
- **!****: Evaluates the expression and returns the opposite. Example: !$zone_temp/locked$
  - If $zone_temp/locked$ is true, the expression is false. If $zone_temp/locked$ is false, the expression is true.
- **==**: Compares data. Returns true if the value on both sides of the operator are equal.
- **!=**: Compares data. Returns true if the value to the left of the operator does not match the value to the right.
- **&&**: Combines expressions. Returns true if the expressions on both sides of && result in true. See Combining expressions (page 86), Method 1 for an example of using this operator.
- **||**: Combines expressions. Returns true if the expression on either side or both sides of the operator results in true. See Combining expressions (page 86), Method 1.

Operators that return a numeric value

- **+**: Adds numeric data, expressions, or values.
- **-**: Subtracts numeric data, expressions, or values.
- *****: Multiplies numeric data, expressions, or values.
- **/**: Divides numeric data, expressions, or values.
- **%**: Finds the remainder in the division of numeric data, expressions, or values.

Other operators

- **? :** Ternary
  - See Combining expressions (page 86), Method 2 for an example of using this operator.
- **()**: Parentheses
  - Use to nest expressions. Operations in parentheses are evaluated before those outside parentheses.
Using local variables

You can use local variables in conditional expressions (page 83) to make various controls react to user interaction in i-Vu®. For example, you could have a panel show or hide in the i-Vu® interface based on a checkbox.

Although local variables can be used in any type of conditional expression, the following examples show how to:
Set objects to show/hide based on radio button selection (page 88)
Set an object to show/hide based on checkbox selection (page 90)

You can also use a local variable to test the setup of a control in your graphic before the graphic is in a live system. See:
To use a local variable to test the setup of a control (page 92)

Local variables are preserved through cut/copy and paste, as well as when importing a .viewsymbol.

To set objects to show/hide based on radio button selection

Using a variable in a conditional expression, you can show/hide objects based on the value of a radio button.

**EXAMPLE** In the image below, the i-Vu® operator can show zone temperature or airflow by choosing the appropriate radio button.
Step 1: Create the variable in ViewBuilder
1. Select **Configure > View Properties > Local Variables** tab.
   
   **TIP** Use the shortcut **Alt+V** to open the **View Properties** window > **Local Variables** tab.
2. Click .
3. On the row that was added, double-click the **Type** column, then select **Integer**.
4. Double-click the **Name** column and type a name for the variable. For example, zonetemp_airflow.
   
   **NOTE** The name must be lowercase letters, numbers, hyphens, and underscores (no spaces), and it cannot begin with a number.
5. Click **OK**.

![View Properties](image)

Step 2: Define the properties for the radio buttons
1. Add the radio buttons to the workspace.
2. For each radio button, select the button and in the **Microblock Path** field, type: $$<the\ variable>$$$. See the image below.
3. For each radio button, enter a value for the button in the **Radio Button Value** field. For example, enter 0 for the first button, 1 for the second button, etc.

![Radio Button](image)

Step 3: Create a show/hide conditional expression for the objects that you want to show/hide
1. Select the object that you want i-Vu® to show when the first radio button is selected.
2. Click on the toolbar.
3 In the **Expression** field, type: `$$<the variable>$$==$<the radio button's value that you assigned in the Properties window>`. See the image below.

4 Select **Show When True**.

5 Repeat steps 1 through 4 for the second radio button.

![Show/Hide Condition](image)

---

**To set an object to show/hide based on toggle button selection**

Using a variable in a conditional expression, you can show/hide objects based on the selection of a toggle button.

**EXAMPLE** The i-Vu® operator can select a checkbox (toggle button control) to show an object or clear the checkbox to hide the object.

![Checkbox examples](image)

**Step 1: Create the variable in ViewBuilder**

1 Select **Configure > View Properties > Local Variables** tab.

   ![TIP](image) **TIP** Use the shortcut `Alt+V` to open the **View Properties** window > **Local Variables** tab.

2 Click .

3 On the row that was added, double-click the **Type** column, then select **Boolean**.
4 Double-click the **Name** column and type a name for the variable. For example, `toggle_panel`.

**NOTE** The name must be lowercase letters, numbers, hyphens, and underscores (no spaces), and it cannot begin with a number.

5 Click **OK**.

---

**Step 2: Define the properties for the toggle button**

1 Add the toggle button to the workspace.

2 In the **Microblock Path** field, type: `$$<the variable>$$`. See the image below.

---

**Step 3: Create a show/hide conditional expression for the objects that you want to show/hide**

1 Select the object that you want i-Vu® to show when the checkbox is selected.

2 Click **on the toolbar.

3 In the **Expression** field, type: `$$<the variable>$$`. See the image below.

4 Select **Show When True**.
To use a local variable to test the setup of a control

You can use a local variable to test the configuration of a control. For example, you could test the configuration of an angular gauge as described below.

**Step 1: Create the variable in ViewBuilder**

1. Select **Configure > View Properties > Local Variables** tab.
   
   **TIP** Use the shortcut **Alt+V** to open the **View Properties** window > **Local Variables** tab.

2. Click **+**.

3. On the row that was added, double-click the **Type** column, then select **Integer**.

4. Double-click the **Name** column and type a name for the variable. For example, aa.
   
   **NOTE** The name must be lowercase letters, numbers, hyphens, and underscores (no spaces), and it cannot begin with a number.

5. Click **OK**.
Step 2: Add an angular gauge and a slider control

1. Add the 2 controls.

2. In each of their Microblock Path fields, type $$aa$$.

3. Delete present_value from the Property field.

4. Give both controls the same Minimum and Maximum values.

5. Configure the remaining fields the way you want.

6. Save your graphic and add it to your i-Vu® system.

Step 3: Test the graphic in the i-Vu® interface

1. Go to the graphic in the i-Vu® interface.

2. Move the slider back and forth to see how the angular gauge looks at different values.

TIP To see how the gauge reacts to a value that exceeds the minimum and maximum limits, go back to ViewBuilder and make the slider’s minimum/maximum range larger than the gauge’s, then retest in the i-Vu® interface.
Troubleshooting graphics

Graphic errors are displayed when running the i-Vu® application. The error may be indicated by a small red triangle ▲ in the lower right corner of the i-Vu® action pane. Click the triangle to see the error.

Many error messages contain an expression or path that is incorrect, so you must determine which control in the .view file has the incorrect expression or path. See To find an expression or path in ViewBuilder (page 94) below.

i-Vu® Pro only: Make sure your graphic is in the \Vu_Pro\webroot\<system_name>\views\graphics folder.

Common errors and their solutions are listed below.

To find an expression or path in ViewBuilder

1. Select Edit > Find/Replace.
2. Type the expression or path in the Find What field, or click the drop-down arrow to select from recent entries in this field.
3. Click Find.
4. Select a Found Item to have ViewBuilder select the control in the workspace.

Error: Cannot be evaluated

Indicates the microblock path for a control is incorrect.

Solution: Correct the path. See Determining a path or microblock property (page 81).
Error: Path is invalid

Indicates that a path in the Link dialog box is invalid.

Solution: Correct the path. See Determining a path or microblock property (page 81).

Error: Wrong data type

Indicates that you used a non-binary control to read a binary value. For example, a number control to read a binary value.

Solution: Determine if you need to change the control or the microblock property value.
Error: Set definition for location not found

Indicates that you used a non-analog control to read an analog value. For example, a droplist to read an analog value.

Solution: Determine if you need to change the control or the microblock property value.

Error: PrimitiveExpr - Cannot evaluate expression

Indicates an invalid variable color or show/hide expression.

Solution: Correct the expression. See Conditional expressions (page 83).
Creating a non-English graphic in ViewBuilder

To create a non-English graphic in ViewBuilder:

1. Install the non-English language pack(s). See "Installing a language pack" in i-Vu® Help.
2. Set the language font (page 97).
3. Create the graphic. (page 98)
4. Save the .view file.

**NOTE** The names of your .view file and any inserted image files must contain only ASCII characters.

Setting the language font

If your system has language packs installed, you can select a font for each language. Your selection affects only how text in your graphic appears in ViewBuilder.

To set the font for each language

1. Select Configure > Preferences > Graphic (.view).
2. On the Language tab, check the language that you want to be the default for all new graphics.

To select the default language font for all new graphics

In the Preview Font column, click the font name to select a different font.

To select the active language when creating a view

If you will use multiple language fonts in a single view, you can switch to a different language font as follows:

1. Select Configure > View Properties.
2. In the Language field, select the language you want to use.
3. Click OK.
To create a Non-English graphic

The method you use to create a graphic that will be displayed in a non-English i-Vu® system depends on the following:

- If the i-Vu® system will display only a single non-English language, create the graphic in that language.

- If the i-Vu® system will display multiple non-English languages, use either of the following methods:
  - Create the graphic in layers (one layer for each language), and then assign a show/hide conditional expression (see format below) to each layer so that it displays in i-Vu® based on the operator language. See "To show/hide a layer in the i-Vu® interface (page 55)" in ViewBuilder Help.
  - Create each piece of the graphic in the different languages, and then assign a show/hide conditional expression (see format below) to each piece so that it displays in i-Vu® based on the operator language. See "Setting objects on a graphic to show/hide in the i-Vu® interface (page 61)" in ViewBuilder Help.
Show/Hide conditional expression format

```operator_language```='language'

where language is the language code from the list below.

For example, the conditional expression to display French would be:
```operator_language```=='fr_FR'

<table>
<thead>
<tr>
<th>Language</th>
<th>Language code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazilian Portuguese</td>
<td>pt_BR</td>
</tr>
<tr>
<td>English</td>
<td>en</td>
</tr>
<tr>
<td>Canadian French</td>
<td>fr</td>
</tr>
<tr>
<td>French</td>
<td>fr.FR</td>
</tr>
<tr>
<td>German</td>
<td>de</td>
</tr>
<tr>
<td>Italian</td>
<td>it</td>
</tr>
<tr>
<td>Japanese</td>
<td>ja</td>
</tr>
<tr>
<td>Korean</td>
<td>ko</td>
</tr>
<tr>
<td>Russian</td>
<td>ru</td>
</tr>
<tr>
<td>Spanish</td>
<td>es</td>
</tr>
<tr>
<td>Swedish</td>
<td>sv</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>zh</td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td>zh_TW</td>
</tr>
<tr>
<td>Thai</td>
<td>th</td>
</tr>
<tr>
<td>Vietnamese</td>
<td>vi</td>
</tr>
</tbody>
</table>
EQUIPMENT TOUCH SCREENS
The Equipment Touch is a touchscreen device that you can attach to a controller to view or change its property values, schedule equipment, view trends, and more, without having to access the system's server.

In ViewBuilder, you:

- Create the screens that the touchscreen displays
- Test the navigation between screens
- Save the screens in a single .touch (for Equipment Touch) file that will be downloaded to the controller

Perform as many of the actions below, as needed, to create your screens.

1. Make a new touchscreen file or open an existing file (page 104).
2. Edit the Home screen (page 106).
3. Make additional screens (page 107).
4. Add controls (page 108).
5. Add navigation (page 107).
6. Password-protect the screens (page 136).
7. Set up alarms (page 139).
8. Add support for multiple languages (page 140).
9. Save, assign, and download the touchscreen file (page 107).
Getting to know ViewBuilder's Equipment Touch interface

You make a touchscreen file in ViewBuilder using a simulation of the touchscreen device. You design your screens directly in the display area, and you set up linked buttons to navigate between the screens.

To move objects

To move a selected object(s):

- Click and drag the object to the new location. Hold down **Shift** as you drag an object to constrain its movement to horizontal or vertical.
- Use the arrow keys to nudge the selected object one pixel at a time, or hold down **Shift** while using the arrow keys to move the object ten pixels at a time.
To align, group, and layer objects

Select the objects that you want to align or reorder (front to back), then use the right-click menu commands or the options on the Add Control tab in the Tools window.

NOTES

• Objects align in relationship to the last selected object, the one with the green handles.
• You can select an individual control in a group to edit its properties in the Control Properties window.

To copy an object

Alt+click and drag a control to create a copy of it on the same screen.

To copy a selected object(s) from one screen to another:

1 Select the object(s), then click.
2 On the new screen, click.
3 Click and drag the object(s) to the desired location.

To lock or unlock controls

To lock a selected object(s) so you cannot select or move it, right-click the object, then select Lock.

To unlock an object, Ctrl+right-click the object, then select Unlock.

NOTE To unlock all locked objects simultaneously, right-click anywhere in the workspace and select Unlock All.

To undo or redo actions

Click on the toolbar as many times as necessary to undo actions that you performed, beginning with the most recent action. Click to redo the action.

You can also click the drop-down arrow to the right of the Undo or Redo button to select an action from a list that begins with the most recent action. Selecting an action will undo or redo that action, plus all actions above it in the list.
Creating a new Equipment Touch screen file or open an existing file

1. Do one of the following:

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new touchscreen file</td>
<td>File &gt; New, then select Touchscreen.</td>
</tr>
<tr>
<td>Open an existing touchscreen file created in ViewBuilder</td>
<td>File &gt; Open, then select the file.</td>
</tr>
<tr>
<td>NOTE</td>
<td>If the file is not listed, verify that the Files of Type selection lists Touchscreen files.</td>
</tr>
</tbody>
</table>

2. Select File > Save As.

NOTE If using i-Vu® Pro, browse to i-Vu_Pro_x.x\webroot\<system_name>\views\touchscreens.

3. Type a File name, then click Save. ViewBuilder adds the .touch extension to your file name.

NOTES
- To record information about the file, select Configure > View Properties, then type your name and comments on the Summary tab. Revision History shows each time the file was saved and the workstation it was saved on.
- A .touch file (including all text, screens, images, and controls) is comprised of a set of compressed files and cannot exceed 512 KB. In addition, the total size of the uncompressed files cannot exceed 1MB and the size of any single uncompressed file cannot exceed 512KB.

Equipment Touch screen types

Every touchscreen file contains both custom and system screens. To navigate between the screens, you must provide a Button, Text, or Image control to act as a screen link. See Equipment Touch controls and their properties (page 110).

NOTE The Home and custom screens are editable; system screens are not editable. System screens are easily identified by their name appearing in blue in the Screens list.

Custom screens

<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby</td>
<td>If included in the touchscreen file, the Standby screen displays when the Equipment Touch has had no user activity for the time specified on the Inactivity Timeout screen. This screen is not interactive, and as soon as the user touches the screen, the Home screen displays. To include this screen in your file, check Include Standby Screen on the Screen Properties window.</td>
</tr>
<tr>
<td>NOTE</td>
<td>If you do not include a Standby screen, the Home screen displays after a period of inactivity.</td>
</tr>
<tr>
<td>Screen name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>untitled</td>
<td>A blank screen that you design, configure, and name. Add controls and buttons that link to the other screens.</td>
</tr>
<tr>
<td><strong>Home</strong></td>
<td>A screen that you design and configure. If you do not include a Standby screen (see above), the Home screen displays after a period of inactivity.</td>
</tr>
</tbody>
</table>

### System screens

<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System</strong></td>
<td>Displays the BACnet device instance number, the controller's time, temperature read from the Equipment Touch sensor, and zone color, and provides links to the Module Status, Alarms, Trends, Schedules, Setup, and Browser screens.</td>
</tr>
<tr>
<td><strong>Module Status</strong></td>
<td>Displays the following sections of a Module Status report: Device Data, Driver Data, Reset Counters, System Errors, Warnings, Information, Hardware, Database, Network.</td>
</tr>
</tbody>
</table>
| **Schedule** | Lets the user view, add, edit, or delete BACnet schedules in the controller.  
**NOTE** The controller firmware has a setting to disallow adding, editing, or deleting schedules from the touchscreen device, limiting the user to only viewing schedules entered in the server. |
| **Setup**    | Displays links to the Module Setup, Touchscreen Setup, and Login screens. |
| **Login**    | Displays if the screen the operator selected requires a password. |
| **Alarm**    | Lets the user view alarms from the controller.  
You must define the alarms in ViewBuilder to have them display. See Setting up alarms (page 139). |
| **Browser**  | Provides links to the following network-visible BACnet object types found in the controller: AI, AO, AV, BI, BO, BV, MSI, MSO, MSV. Each list shows the BACnet Object Name, Current Value, and BACnet Object Instance number. |
| **IP**       | Lets the user view or edit network addresses, if enabled by the driver.  
**NOTE** If the controller's driver does not support this screen, the button on the Module Setup screen will be inactive. |
| **Router**   | Lets the user view or edit the router's ARC156, MS/TP, or Ethernet network number.  
**NOTE** If the controller's driver does not support this screen, the button on the Module Setup screen will be inactive. |
| **Communication** | Lets the user edit the following:  
BACnet Device Instance number  
Base BACnet Device ID number  
Auto Generate Device ID - Yes/No  
Number of Max Masters  
Number of Max Info Frames |
| **Time Master** | If the controller can be a BACnet Time Master, this screen lets a technician configure how it sends time synchronization broadcasts.  
**NOTE** If the controller's driver does not support this screen, the button on the Module Setup screen will be inactive. |
<p>| <strong>Module Setup</strong> | Displays links to the Set Time and Date, Communication, Router, IP, and Time Master screens. |</p>
<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touchscreen Setup</td>
<td>Screen links:</td>
</tr>
<tr>
<td>Inactivity Timeout</td>
<td>Lets the user define the time it will take for the touchscreen device to return to the Standby screen and log out the user when no activity is detected.</td>
</tr>
<tr>
<td>About</td>
<td>Displays information about the touchscreen firmware.</td>
</tr>
<tr>
<td>Clean Screen</td>
<td>Displays a screen with a one-minute countdown timer so that the user can clean fingerprints from the display window without touching something that would affect the operation of the controller.</td>
</tr>
<tr>
<td>Key Click Off/On</td>
<td>A toggle button that turns the sound for screen touches off and on.</td>
</tr>
<tr>
<td>Alarm Sound Off/On</td>
<td>A button that turns the sound for a critical alarm off.</td>
</tr>
<tr>
<td>Reload Firmware</td>
<td>Erases the current firmware so that the user can load new firmware through the USB port.</td>
</tr>
<tr>
<td>Language</td>
<td>If optional languages are defined in ViewBuilder when the touchscreen file is created, the Language screen lets the user select the language for displaying system screens. If custom screens are included in the touchscreen file, they will display in the language in which they are created.</td>
</tr>
<tr>
<td>Passwords</td>
<td>Lets the user change the Admin or User password.</td>
</tr>
<tr>
<td>Calibrate Touch Panel</td>
<td>Lets the user recalibrate the screen by touching targets.</td>
</tr>
<tr>
<td>Trends</td>
<td>Lets the user view trends for points that have trending enabled.</td>
</tr>
</tbody>
</table>

**NOTE** System screens are a part of the touchscreen firmware. If a screen in the firmware is changed between releases of ViewBuilder, the ViewBuilder screen may look different than the actual touchscreen screen.

---

**To customize the Home screen**

1. Click the **Screens** tab in the **Tools** window.
2. Select **Home** from the list of screens.
3. Arrange the header items in the **Header Aspects** list:
   - Add or delete items by selecting or clearing the checkbox; all can be removed except the **Back** button.
   - Re-order the selected items as they appear on the header using the up and down arrows.
   - The **Alarm** button on the touchscreen appears red if in alarm state and gray if not.
4. **Password-protect** (page 136) this screen, if necessary.
5. **Add controls** (page 108) to the screen as necessary.
6. Edit the font and alignment in the **Control Properties** window for the currently selected control. If no control is selected, the properties window is empty.
To create additional screens

1. Click the Screens tab in the Tools window.
2. Do one of the following:
   - In the Screens list, double-click untitled, then type a descriptive screen name.
   - Click + to add a new blank screen, then change its name.
   - Select an existing screen, click + to make a copy of it, then change the copy's name.
   **NOTE** You cannot copy a system screen.
3. Edit the header and password level at the bottom.
4. Add controls.

**NOTES**
- To delete a screen, select the screen name, then click . You cannot delete the Home or system screens.
- To rearrange the screen's order in the list, select the screen name, then click ↑ or ↓.

To add navigation

To give a user the ability to move from one screen to another:
1. Add a linked Button, Text, or Image control.
2. In the Control Properties window, select a screen from the Link to Screen drop-down list.
   **NOTE** The Link to Screen field is located on either the control's Properties window or on its Link tab.
3. To test the navigation, hold F9 and click the linked control.

To save, assign, and download the touchscreen file

1. Save the .touch or .bacview file to a convenient location on your computer.
   Then, in the i-Vu® interface:
2. Right-click the controller and select Driver Properties to attach the screen file.
3. Download All Content to the controller.

**NOTE** If the controller has an Router Config Mode DIP switch, make sure that this DIP switch is off when connecting a touchscreen device.
Adding controls to Equipment Touch screens

You can add controls to a touchscreen that allow you to display such things as date and time, text and graphics, and information about microblock properties.

To add a control

1. Click the Add Control tab in the Tools window.
2. Select the control you want to add.
3. Click in the workspace where you want to add the control.
   
   **NOTE** To cancel the action, press Esc before clicking the workspace.
4. Edit properties for the control in the Control Properties window.

**TIPS**

- To move a control, click and drag it to another location.
- To create a copy of a control, hold Alt while dragging the control.
- To add a control multiple times, select the control, then Shift+click the workspace for each copy.
- To delete a control, select the control and click or press Delete.
- See Equipment Touch screen controls and their properties (page 110) for a description of each control.

**NOTE** Many factors affect how many controls you can put on a screen before exceeding memory limitations. You may be able to put as many as 130 simple controls (numbers, text, etc.) on a screen.
Selecting controls on the workspace

You can select a control on the workspace by simply clicking on it.

If you have added multiple controls stacked on top of each other (at the same x, y co-ordinates), you can use the Control Selection tab to shuffle through the controls and select one from the stack.

To select a control from a stack

1. Click the Control Selection tab in the Tools window.
2. Select the control from the list.
3. View or edit the properties in the Control Properties window.

TIPS

- To move a control, click and drag it to another location.
- To create a copy of a control, hold Alt while dragging the control.
- To add a control multiple times, select the control, then Shift+click the workspace for each copy.
- To delete a control, select the control and click or press Delete.
**Equipment Touch screen controls and their properties**

Each control, its usage, and the properties you define are described in the tables below. Many controls share the following properties and may appear on their own tab in the **Control Properties** window.

### Condition
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See *Setting items on a touchscreen to show/hide* (page 133).

### Font
Select font size, color, and alignment.

### Link to Screen
Select a screen in the drop-list so that the control becomes a link to that screen. Hold F9 and click the control to test the link. See *Linking Equipment Touch screens* (page 130).

**NOTE** If a control will reference a BACnet Object, the point must be set as **Network Visible** in the Snap or i-Vu® application.

### Controls

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text</strong></td>
<td>Display text. See <em>Text and images on an Equipment Touch screen</em> (page 112).</td>
</tr>
<tr>
<td><strong>Text List</strong></td>
<td>Display text based on a list of text values which are assigned to conditional values. The condition is tested against either a number, text, or a microblock property's value. The value whose <strong>Condition</strong> is true displays. See <em>Text and images on an Equipment Touch screen</em> (page 112) to add a <strong>Text List</strong> control to add conditions to the list.</td>
</tr>
<tr>
<td><strong>Number</strong></td>
<td>Display any numerical value from an analog microblock. Example: Zone temperature. See <em>Number control on an Equipment Touch screen</em> (page 115).</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Display a time period. Example: Override time remaining. See <em>Duration control on an Equipment Touch screen</em> (page 116).</td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td>Display a navigation button that links to another screen. See <em>Linked button on an Equipment Touch screen</em> (page 116).</td>
</tr>
<tr>
<td><strong>On-Off-Auto</strong></td>
<td>Provide a method to lock a binary input or output on, lock it off, or let the control program control it (Auto). Example: To control fans or pumps. See <em>On-Off-Auto control on an Equipment Touch screen</em> (page 117).</td>
</tr>
<tr>
<td><strong>Timed Local Override</strong></td>
<td>Provide a method to view or edit a Timed Local Override. See <em>Timed Local Override control on an Equipment Touch screen</em> (page 118).</td>
</tr>
<tr>
<td><strong>Image</strong></td>
<td>Display an image. See <em>Text and images on an Equipment Touch screen</em> (page 112).</td>
</tr>
<tr>
<td>Use this control...</td>
<td>To...</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
</tr>
<tr>
<td><strong>Checkbox</strong></td>
<td>Provide a method to choose between two states. &lt;br&gt;See Checkbox control on an Equipment Touch screen (page 118).</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Display time of day. &lt;br&gt;See Time control on an Equipment Touch screen.</td>
</tr>
<tr>
<td><strong>Text Toggle</strong></td>
<td>Display active and inactive text values for a binary microblock. &lt;br&gt;Example: Chiller is enabled or disabled. &lt;br&gt;See Text Toggle control on an Equipment Touch screen (page 119).</td>
</tr>
<tr>
<td><strong>View Port</strong></td>
<td>Add controls or images to a resizable, scrollable container. &lt;br&gt;See View Port on an Equipment Touch screen (page 120).</td>
</tr>
<tr>
<td><strong>Setpoint</strong></td>
<td>Provide a method to view or edit setpoints. &lt;br&gt;See Setpoint control on an Equipment Touch screen (page 122).</td>
</tr>
<tr>
<td><strong>Image List</strong></td>
<td>Shows various states of an analog microblock using images. &lt;br&gt;See Text and images on an Equipment Touch screen (page 112) to add an Image List control and define conditions.</td>
</tr>
<tr>
<td><strong>Radio Button</strong></td>
<td>Provide a method to select one option from a set of alternatives. &lt;br&gt;Example: Manual and Auto. &lt;br&gt;See Radio buttons on an Equipment Touch screen (page 123).</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Displays: &lt;br&gt;• System date from the controller. &lt;br&gt;• A date, typically read from a History microblock. &lt;br&gt;Example: Date of the highest zone temperature. &lt;br&gt;See Date control on an Equipment Touch screen (page 123).</td>
</tr>
<tr>
<td><strong>Multi-State</strong></td>
<td>Display the text values for multi-state microblocks. The Preview Text drop-list can also display the active and inactive text values for a binary microblock. &lt;br&gt;Example: Units of measure (°F). &lt;br&gt;See Multi-State control on an Equipment Touch screen (page 124).</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Add controls or images to a resizable, scrollable table. &lt;br&gt;See Working with tables on an Equipment Touch screen (page 125).</td>
</tr>
<tr>
<td><strong>Primary Value</strong></td>
<td>Display any numerical value from an analog microblock in a larger font than other controls for readability. &lt;br&gt;See Primary Value control on an Equipment Touch screen (page 128).</td>
</tr>
</tbody>
</table>
Text and Images on Equipment Touch screens

You can add Text and Image controls to a touchscreen file.

Customize the Text control

- Make it a link to another screen on the Link tab. See Linking Equipment Touch screens (page 130).
- Change the font size, color, and alignment on the Font tab.
- Set the control to show or hide based on password levels, a microblock property’s value, or the existence of its path on its Condition tab. See Setting items on a touchscreen to show/hide (page 133).

Customize the Image control

- Make it a link to another screen on the Link tab. See Linking Equipment Touch screens (page 130).
- Set the control to show or hide based on password levels, a microblock property’s value, or the existence of its path on its Condition tab. See Setting items on a touchscreen to show/hide (page 133).

Text and Image Lists

You can also create lists of either text or images to assign different conditions to multiple values. Each condition is evaluated, one after another, and the first one to be evaluated as true is displayed on the touchscreen device. If none of the values are true, default text or a default image is displayed.

Text

To add text

1. Select the Add Control tab, click Text Field, then click in the screen.
2. Double-click on Preview text inside the control’s field, select the text to delete it, then type the text to be displayed on the touchscreen.
   Optional: Copy text from another application, then paste it in the field.
3. Select Word Wrapping if text overflows the text field.
4. NOTE Text cannot extend past the constraint of the width of the control and borders of the display.
5. Click OK.
To add a Text List

1. Select the Add Control tab, click Text List, then click in the screen.

2. In the Default Value field, type the text that will display if none of the conditions are true. Select one:
   - Static Text and type text to display.
   - Path To Microblock Property to display the Preview Text.

3. Click .

4. Select one:
   - Static Text and type text to display if the condition is true.
   - Path To Microblock Property and type the path to display the value from the microblock.

5. Select a condition or add a new one. See Setting items on a touchscreen to show/hide (page 133).

6. Check Autosize to adjust the size of the control to the length of the longest condition value displayed. To manually adjust the width of the control, grab a handle on the left or right side of the control box:

7. Repeat steps 4–6 for additional conditions.

NOTES

- The Text List can be set up to use different text for each condition and can have different font style properties assigned to each one.
- See Conditional items in a list (page 114) to arrange the conditions according to which displays.

Images

To add an image

1. Select the Add Control tab, click Image, then click in the screen.

2. Select a new image or click the Active Images tab to see images already used in the .touch file.

3. Click OK.

4. Click in the screen.

5. Click and drag a corner to resize it.

NOTE Hold Shift as you drag to maintain the image's proportions.
To add an Image List

1. Select the Add Control tab, click Image List, then click in the screen.
2. Select a new image or click the Active Images tab to see images already used in the .touch file.

   This is the Default Image displayed when none of the other conditions is true or when a communication problem or issue occurs.
3. Click OK.
4. Click in the screen.
5. Click and drag a corner to resize it.
   
   **NOTE** Hold Shift as you drag to maintain the image's proportions.
6. Click to add an image that the control displays under normal conditions.
7. Select an image, then click OK.
8. Select a condition or add a new one. See Setting items on a touchscreen to show/hide (page 133).
9. Repeat steps 6–8 for additional conditions.

See Conditional items in a list (page 114) to arrange the conditions according to when each should display.

### Conditional Items In a List

**Purpose:**

Text List and Image List allow the operator to assign text or images to indicate different conditions. Each condition in the list is evaluated, one after another, and the first one to be evaluated as true will be displayed on the touchscreen device. If no expression returns true, the Default Text or Default Image is displayed.

For example, a damper can be displayed as Closed, Half-open, or Open depending on the Show/Hide conditions assigned to a microblock's property. Either or can be used to show these states.

1. Create a text list or image list.
2. Arrange your conditions using and to reorder the list.

**TIPS**

- The control property's window does not automatically expand, so you can resize it to display all items in the list.
- Click to delete an image from the list.
- Click to change the image assigned to a condition.
Number control on Equipment Touch screens

Purpose:
Display any numerical value from an analog microblock.
Example: Zone temperature.

Properties:

Path to Microblock Property—Enter the path to the microblock property you want the control to read from or write to. See Defining paths for the touchscreen (page 131).

Format—Select the appropriate number formatting, such as decimal places and comma separators.

Scaling Factor—To display a microblock property's value in a different format, type the necessary multiplication factor.
Example: To display watts as kilowatts, type .001 in this field.

Show Units—Check to display the unit associated with the property in the control program. The selected unit's value in the list are just to estimate size.

Editable—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.

Autosize—Check to adjust the size of the control to the length of the value displayed.
To manually adjust the width of the control, grab a handle on the left or right side of the control box:

Can Force CCN Value—UPC Open controller only - Check to allow the option in Equipment Touch to Force a CCN value. A Forced value is always outlined in yellow. When you check this option, the yellow outline appears in ViewBuilder so you can gauge the amount of extra room that the outline will take on your Equipment Touch screen.

Limits—To display a minimum/maximum range of values defined in the microblock or in the custom values fields.

Font tab:
Change the font size, color, and alignment on the Font tab.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)
Duration control on Equipment Touch screens

Purpose:
Display a time period.
Example: Override time remaining.

Properties:
- **Path to Microblock Property**—Enter the path to the microblock property you want the control to read from or write to. See *Defining paths for the touchscreen* (page 131).
- **Microblock Unit**—Select the microblock value's unit.
- **Editable**—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.
- **Display Format**—Select to display the format of the duration.
- **Autosize**—Check to adjust the size of the control to the length of the value displayed.
To manually adjust the width of the control, grab a handle on the left or right side of the control box:

![Module Status](image)

**NOTES**
- The **Duration** control must reference an analog value.
- This control's **Microblock Unit** must match the unit of the microblock value.
- Wire Lock microblocks output a value in milliseconds.

Linked button on Equipment Touch screens

Purpose:
Display a navigation button that links to another screen.

Properties:
- **Link to Screen**—Select screen that you want the button to link to.
- **Use Custom Link Name**—Select to use a custom name on the button.
- **Custom Link Name**—Enter the name you want to appear on the link button. Resize the width of the button as needed.
NOTE  Width of the control can be adjusted by grabbing a handle on the left or right side of the control box:

Font tab:
Change the font size, color, and alignment on the Font tab.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)

---

On-Off-Auto control on Equipment Touch screens

Purpose:
Provide a method to lock a binary input or output on, lock it off, or let the control program control it (Auto).
Example: To control fans or pumps.

Properties:
- **Path to Binary Microblock**—Type the path in this field if this control is to read only one microblock.
- **Show As**—Select the default to display on the touchscreen: On, Off, or Auto.
- **Use Advanced Path**—Check if you want this control to read two microblocks, one for Auto and one for On/Off (Hand/Off). Enter the microblocks in the following fields.
  - **Automatic Microblock Path**—The microblock that contains the Auto values.
  - **Manual Microblock Path**—The microblock that contains the On/Off values.

TIP  Best use for this control is when the Equipment Touch will serve as the front-end for the controller. If your system will have a i-Vu® front end and you use this control in both your .touch file and a .view file for the same equipment, the graphic in the i-Vu® system may not reflect changes made at the Equipment Touch unless the user initiates a parameter upload from the controller.
Timed Local Override control on Equipment Touch screens

Purpose:
Provide a method to override the occupied or unoccupied state of a piece of equipment from the touchscreen device.

Properties:
- Path to Binary Microblock—Type the path in this field if this control is to read only one microblock.
- Display Format—Choose to display time in AM/PM or 24 hour.
- Always show time to next schedule transition (if unchecked, this will only show when overridden)—Select to always show next transition.
- Show As—Select one of the following states to display on the equipment:
  - Occupied
  - Unoccupied
  - Occupied Override

Checkbox control on Equipment Touch screens

Purpose:
Provide a graphical method to show or choose between two states.

Properties:
- Path to Microblock Property—Enter the path to the microblock property you want the control to read from or write to. See Defining paths for the touchscreen (page 131).
- Editable—When selected, the control is editable on the touchscreen device.
- Show Selected—When selected, the control displays as "selected" in ViewBuilder
  NOTE This doesn't affect how the control displays on the touchscreen device.
- Can Force CCN Value—UPC Open controller only - Check to allow the option in Equipment Touch to Force a CCN value. A Forced value is always outlined in yellow. When you check this option, the yellow outline appears in ViewBuilder so you can gauge the amount of extra room that the outline will take on your Equipment Touch screen.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)
Time control on Equipment Touch screens

Purpose:
Display time of day.

Properties:

Use System Time—Check to use the time coming from the controller instead of the time pulled from the microblock.

Display Format—Choose to display various time formats such as AM/PM, 24 hour, or minutes and seconds.

Editable—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.

<table>
<thead>
<tr>
<th>For this type...</th>
<th>use this path...</th>
</tr>
</thead>
<tbody>
<tr>
<td>equipment</td>
<td>~device/driver/device/local_time</td>
</tr>
<tr>
<td>area</td>
<td>&lt;equipment_ref_name&gt;/~device/driver/device/local_time</td>
</tr>
</tbody>
</table>

Autosize—Check to adjust the size of the control to the length of the value displayed. To manually adjust the width of the control, grab a handle on the left or right side of the control box:

Font tab:
Change the font size, color, and alignment on the Font tab.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)

Text Toggle control on Equipment Touch screens

Purpose:
Display active and inactive text values for a binary microblock.
Example: Chiller is enabled or disabled.
Properties:

**Path to Microblock Property**—Enter the path to the microblock property you want the control to read from or write to. See Defining paths for the touchscreen (page 131).

**Editable**—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.

**Preview Text**—Text that is displayed only in ViewBuilder to help you place the control. Type the preview text or select from the drop-down list.

**Autosize**—Check to adjust the size of the control to the length of the value displayed.

To manually adjust the width of the control, grab a handle on the left or right side of the control box:

**Can Force CCN Value**—UPC Open controller only - Check to allow the option in Equipment Touch to Force a CCN value. A Forced value is always outlined in yellow. When you check this option, the yellow outline appears in ViewBuilder so you can gauge the amount of extra room that the outline will take on your Equipment Touch screen.

**Font tab:**

Change the font size, color, and alignment on the Font tab.

**Condition tab:**

Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)

---

View Port on Equipment Touch screens

**Purpose:**

Increase the viewing area of a touchscreen device's window. The View Port's canvas can hold many more controls than the touchscreen can display at one time.

Controls and text are added to the canvas and horizontal and vertical scrollbars appear, as needed, allowing you to view the other areas of the canvas.

**NOTE** When the View Port control is initially placed on the canvas, the width is set to take up the full width of the screen and the height is set to fit between the header bar and buttons at the bottom of the screen.

**Properties:**

**View Port window**—Display area, including scrollbars, seen on the touchscreen device. The scrollbars allow the designer to see what the layout looks like on the touchscreen device.
To move the View Port window, click and drag the window.
To change the size of the View Port control, drag one of the green corner markers.

**View Port Editor**—The area outlined in white is the canvas design area and the area outlined in yellow is the display area visible on the touchscreen. The display area includes horizontal and vertical scrollbars.

### To add a View Port

1. Select the **Add Control** tab, click ☰, then click in the screen.
2. Click in the workspace to add the View Port.
3. Select a background color and click **Change**.
4. Uncheck **Border Enabled** if you do not want the borders to display.
To navigate in the View Port window

Scrollbars appear in the View Port window to allow you to navigate around to the areas outside of the visible area. To navigate to regions outside of the display window, do one of the following:

- Hold down F9 while clicking the up and down or right and left arrows.
- Hold down F9 while dragging the black slider up and down or side to side.

To customize a View Port

To add content to the View Port control:

1. Double-click inside it to open the View Port Editor.
2. Drag and drop controls or images into the canvas.
3. Click Close View Port Editor to return to the touchscreen.

NOTE Any controls that are added to the main screen and not while in the View Port Editor, are not actually a part of the View Port, but are layered above or below the View Port control.

Setpoint control on Equipment Touch screens

Purpose:

Provide a method to view or edit setpoints from the touchscreen device.

1. Select the Add Control tab, click , then click in the screen.
2. Type the Path to Setpoint Microblock (this is the path to the Setpoint Microblock itself, not a property).
3. In the Adjust section, select to adjust either the Setpoint Offset or Base Setpoint:

<table>
<thead>
<tr>
<th>Setpoint Offset</th>
<th>Select from Options to display or edit:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Temperature Offset</td>
<td>Display Temperature Offset.</td>
</tr>
<tr>
<td>Show Effective Setpoint</td>
<td>Select to display Always or When Adjusting.</td>
</tr>
<tr>
<td>Show Both</td>
<td>Display Temperature Offset and Effective Setpoint.</td>
</tr>
</tbody>
</table>

| Base Setpoint            | Select to display the Effective Setpoint always or only when user is adjusting the setpoint. |

4. Type the Path To Occupied Status—a path to a microblock property that provides the occupied state of a zone.
5. Type the Path To HVAC Mode—a path to a microblock property that provides the current mode of the HVAC system. For example, is it in Heat or Cool mode?
Radio buttons on Equipment Touch screens

**Purpose:**

Provide a method of selecting one option from a set of alternatives.
Example: Manual and Auto.

Enter the same **Path to Microblock Property** for each radio button in the set.

**Properties:**

- **Path to Microblock Property**—Enter the path to the microblock property you want the control to read from or write to. See *Defining paths for the touchscreen* (page 131).
- **Editable**—When selected, the radio buttons are interactive on the touchscreen device.
- **Radio Button Value**—Type the value that represents the active or true state for this radio button.
  - For an analog microblock, type the specific value the button is to represent.
  - For a binary microblock, type `true` or `1` (depending on the property) for one button's value and `false` or `0` for the other button's value.
- **Show Selected**—When selected, the control displays as "selected" in ViewBuilder.

**NOTE** This doesn't affect how the control displays on the touchscreen device.

**Condition tab:**

Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See *Setting items on a touchscreen to show/hide* (page 133)

Date control on Equipment Touch screens

**Purpose:**

Display a date, typically read from a History microblock.
Example: Date of the highest zone temperature.

**Properties:**

- **Path to Microblock Property**—Enter the path to the microblock property you want the control to read from or write to. See *Defining paths for the touchscreen* (page 131).
- **Use System Date**—Check to use the System date, retrieved from the controller, instead of the date pulled from the microblock.
- **Date Format**—Select the appropriate format.

<table>
<thead>
<tr>
<th>For this type...</th>
<th>use this path...</th>
</tr>
</thead>
<tbody>
<tr>
<td>equipment</td>
<td>~device/driver/device/local_date</td>
</tr>
<tr>
<td>area</td>
<td>&lt;equipment_ref_name&gt;/~device/driver/device/local_date</td>
</tr>
</tbody>
</table>
Editable—When selected, the control is editable on the touchscreen device.

Autosize—Check to adjust the size of the control to the length of the value displayed.

To manually adjust the width of the control, grab a handle on the left or right side of the control box:

Font tab:

Change the font size, color, and alignment on the Font tab.

Condition tab:

Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)

Multi-State control on Equipment Touch screens

Purpose:

Display the text values for multi-state microblocks. The Preview Text drop-list can also display the active and inactive text values for a binary microblock.

Example: Units of measure (°F).

Properties:

Path to Microblock Property—Enter the path to the microblock property you want the control to read from or write to. See Defining paths for the touchscreen (page 131).

Editable—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.

Preview Text—Text that is displayed only in ViewBuilder to help you place the control. Type the preview text or select from the drop-down list.

Autosize—Check to adjust the size of the control to the length of the value displayed.

To manually adjust the width of the control, grab a handle on the left or right side of the control box:

Use Custom Defined States—Select to add analog values and display names to the list.

Font tab:

Change the font size, color, and alignment on the Font tab.
Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)

Working with tables on Equipment Touch screens

You can add a table to a touchscreen and then add controls or images in the table cells. To customize the table:

- Select the table to move it within the touchscreen display area.
- Adjust the size of the table by selecting the table and dragging one of the green corner markers.
- Change the background and border colors by clicking Change.

To add a table

1. Select the Add Control tab, click , then click in the screen.
2. Click in the workspace where you want to add the table.
3. Click Change to select a different background color.
4. Uncheck Border Enabled if you do not want the borders to display.

Adjusting the table

NOTE To add, delete, or adjust rows and columns, double-click inside the table to open the Table Editor.

To add a row or column to the end of a table:
1. Right-click anywhere in the table.
2. Select Insert Row or Insert Column.

To add a row or column before the last one:
1. Click column or row gray header bar to select it.
2. Right-click the gray header bar to insert one before the selected row or column.
3. Select Insert Row or Insert Column.

To delete a row or column:
1. Right-click its gray header bar.
2. Select Delete Row or Delete Column.
To adjust column width:

Drag the ends of the column's gray header bar.

**NOTES**

- A dashed yellow box outlines the perimeter of the table.
- As more controls are added, the table may become larger than will display on the touchscreen. Horizontal or vertical scrollbars appear and can be used to simulate what the user will be able to view in the table by pressing F9 and dragging the black box or scrollbars.
- Minimum width and height is 25 pixels.
- Row height is determined by the tallest control in the row.

**To add a control to a table cell**

1. Double-click the table in the touchscreen to open the **Table Editor**.

   **TIP** If gray bars do not appear above each column and to the left of each row, the table is not active and cannot be edited. See note below.

2. Click the control in the **Tools** window.

3. Click the cell where you want to add the control.

   **NOTE** Cell resizes to the area needed to display the control.

4. Enter the control’s properties.

5. Click **Close Table Editor** to return to the touchscreen.

   **NOTE** Adding controls to the touchscreen without opening the **Table Editor** places the control directly on the touchscreen—not in the table. The table will not resize accordingly and the control will be on a different layer than the table. See step 1 above.

**TIPS**

- To move an object and its condition, click and drag the item.
- To copy an object and its condition, hold down **Alt** as you drag the item.
- Objects moved or added into cells that have a show/high condition may or may not assume the condition. If you do not get the results you want, change the show/hide condition or click **undo** to undo the action.
- Placing objects in a cell that already contains a control replaces the original object.
To align objects in a table

To align a control within its cell:
1 Double-click the control in the table to open the **Table Editor**.
2 Right-click a control and then select **Align**.
3 Select how you want to align it from the list.

**TIP** Ctrl-click to select multiple objects to align.

To align all controls within a row or column:
1 Select the row or column's gray bar.
2 Right-click and then select **Align**.
3 Select how you want to align it from the list.

To hide objects in a table

If you hide part of a row, the cells will be blank when the screen is viewed in the touchscreen device.
If you hide an entire row, the row will not appear on the screen when viewed in the touchscreen device.

**Hide a control in a cell**
1 Double-click the table to open the **Table Editor**.
2 Select the control you want to hide under certain circumstances.
3 In the **Control Properties** window, click the **Condition** tab.
4 Select an existing condition from the list or create a new one.

**Hide a row in a table**
1 Double-click the table to open the **Table Editor**.
2 Select the gray bar of the row you want to hide under certain circumstances.
3 In the **Control Properties** window, click the **Row Condition** tab.
4 Select an existing condition from the list or create a new one.
Primary Value control on Equipment Touch screens

Purpose:
Display any numerical value from an analog microblock in a larger font than other controls for readability. Example: Zone temperature.

Properties:
Path to Microblock Property—Enter the path to the microblock property you want the control to read from or write to. See Defining paths for the touchscreen (page 131).
Format—Select the appropriate number formatting, such as decimal places and comma separators.
Show Units—Check to display the unit associated with the property in the control program. The selected unit's value in the list are just to estimate size.

Font tab:
Change the font size, color, and alignment on the Font tab.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 133)
Changing a property on multiple items of the same control type

If you have multiple instances of a text field, text list, or button image on a screen, you can change the properties of any of them all at once. For example, to change the color of the font in the screen below, select all of the controls to be changed, then edit the property.

1. Select any controls on the screen’s workspace.
2. Edit any properties, and click OK.

**NOTE** Only the fields that you edited are changed. All other fields in all the controls remain as they were.
Linking Equipment Touch screens

The **Link to Screen** drop-down list, which is located on either of the **Link** tabs ( ![Link icon] or ![Link icon]), provides a way of moving from one screen to another in the touchscreen file by selecting a screen from the list. The link can be a button, text, or image.

1. Select the screen to link to, then save the file.
2. Hold **F9** and click the text, button, or image to test the link.
A path tells the i-Vu® application the route through the system hierarchy to an item in the system. For example, a path tells the i-Vu® application where to find a microblock property value to display on a graphic or where to jump to when the operator clicks a link on a graphic.

In ViewBuilder, you use paths in controls and conditional expressions.

You can do one of the following to get the path:

- In the ViewBuilder interface, navigate to the point using the System dialog box.
- In the i-Vu® interface, determine the path yourself (page 81).

A path consists of the reference name of each tree item included in the path, separated by a forward slash (/). For example, first_floor/zone_1/lstat.

NOTES

- If this field is outlined in red, you entered invalid syntax or characters.
- See Defining i-Vu® paths (page 79) for more information on paths.

To define paths for .touch file

A path consists of the control program number, reference name, and property separated by a forward slash (/). Example: cp1/zone_temp/zone_value.

You can determine the path in ViewBuilder or in the i-Vu® interface.

In ViewBuilder

The following applies only to an i-Vu® Pro database.

1. Click System on the toolbar.
2. Select the database, then click Next.
3. Enter or select your username and password, then click Next.
4. Select a device, then click Show Device.
5. Expand the control program, then select the point.

   NOTE If the path appearing in the Microblock Path field contains a point different from the one needed, select from the Property drop-down list. If the point you need is not available in the list, determine the path from the i-Vu® interface; see below.

6. Click Close System.
7. Close the System window.
8. Right-click in the Path To Microblock Property field and click Set Path Value.
In the i-Vu® interface

Paths can be found on the **Properties**, or **Graphics** pages in the i-Vu® interface.

1. Right-click a value, then select **Global Modify**.

2. Copy the microblock and property from the **Expression** field, then paste into ViewBuilder's Show/Hide Conditional window's **Path to Microblock Property** field.

3. Place your cursor in front of the path and type the control program number followed by a "/" into the **Path to Microblock Property** field.
Setting items on an Equipment Touch to show/hide

You can set a control, or an item in a control such as a table row or cell, to show or hide on the touchscreen device based on the user’s password level or by creating a conditional expression that tests the value of a microblock property.

You can also create a set of expressions using the Text List or Image List controls to indicate different conditions of the microblock property. See Conditional items in a list (page 114).

EXAMPLE To display various states in a damper, you can create a series of expressions ranging from Open to Closed with various states in between. These states could be displayed in various ways:

- Using a Text List: Closed, Half-Open, Open
- Using a Text List with colored font: Closed indicated by red, Half-Open by yellow, Open by green
- Using an Image List using images of the damper in each of the states

To set items to show/hide

Based on the user’s password level

1. Select the item(s) you want to show/hide.
2. Click the Condition tab.
3. From the Condition drop-down list, select one of the following:
   - Logged In as User to show the items only when user is logged in with the User password
   - Logged In as Admin to show the items only when user is logged in with the Admin password

   NOTE See Password-protecting a touchscreen (page 136) for information on the Admin and User passwords.
4. Click OK.

Based on a microblock property's value

1. Select the item(s) you want to show/hide.

   TIP To add conditional expressions to the list, see To add a condition to an Equipment Touch screen (page 134).
2. Click the Condition tab.
3. From the Condition drop-down list, select a custom condition to show when the condition is true.
4. Click OK.
To add a condition to an Equipment Touch screen file

1. In the Control Properties window, click the Condition tab.
2. Click .
3. Type the path to the microblock's property; see To define paths for .touch file (page 131).
4. Select an operator (page 135) from the drop-down list.
5. Optional: If selecting an operator other than is TRUE or is FALSE, select an option in the Value 2 field and enter a value in the box.
6. Click OK.

To edit a show/hide condition

1. Select the control whose condition you want to edit or remove.
2. Click the Condition tab.
3. Select the condition to edit from the Condition drop-down list.
4. Click the Condition button.
5. In the Value 1 field, enter the path to the microblock property.
6. Select an operator from the drop-down list.
7. In the Value 2 field, select an option and enter the value.
   NOTE This field is active only if you selected an operator other than is TRUE or is FALSE in step 6.
8. Select one of the following:
   ○ Selected Item Only to have the change apply only to the item you opened the Show/Hide Condition window from. The new condition is added to the Condition list when you close the window.
   ○ Wherever Used to have the change apply to all controls using this condition.
9. Click OK.

To remove a condition from a control

1. Select the control whose condition you want to remove.
2. Click the Condition tab.
3. Select None from the Condition drop-down list.
   NOTE You cannot remove a condition from the list. But, if it is not assigned to anything, ViewBuilder removes it from the list the next time you close the file.
Operators

An operator defines how each piece of an expression is to be handled. For example, an operator can compare or perform an action between the value of a microblock property, a literal value, or the result of an expression. The following table lists operators that can be used in expressions.

**NOTE** Only one operator can be used at a time. For example, it is not possible for the touchscreen to put "">30 and <60".

<table>
<thead>
<tr>
<th>Operators that return true/false</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>is TRUE</td>
<td>Is true</td>
</tr>
<tr>
<td>Equal to</td>
<td>Compares data. Returns true if the value of the expression or condition is equal.</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal to</td>
</tr>
<tr>
<td>Greater than</td>
<td>Compares numeric data. Returns true if the value to the left of the operator is greater than the value to the right.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>Less than</td>
<td>Compares numeric data. Returns true if the value to the left of the operator is smaller than the value to the right.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>Compares numeric data. Returns true if the value to the left of the operator is smaller than or equal to the value to the right.</td>
<td></td>
</tr>
</tbody>
</table>
Password-protecting an Equipment Touch

To provide security for your touchscreen device, you can assign different password levels to your screens and to individual controls, values, or objects. Security levels are set on the Tools > Screens dialog box and on the control's Condition tab.

<table>
<thead>
<tr>
<th>A user with this password level...</th>
<th>Can view or gain access to all screens, controls, values, or objects...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Factory</td>
<td>regardless of security levels assigned.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This password is intended for a factory-authorized technician and can only be changed in the ViewBuilder application.</td>
</tr>
<tr>
<td>Admin</td>
<td>except those that have Factory assigned.</td>
</tr>
<tr>
<td>User</td>
<td>except those that have Factory or Admin assigned.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> A touchscreen device has a single User password shared by its operators.</td>
</tr>
<tr>
<td>None</td>
<td>that have no security level assigned to them.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> No password required.</td>
</tr>
</tbody>
</table>

To assign a security level to a control

1. With a control selected, click the Condition tab in the Tools window.
2. Select a security level from the Condition drop-list.
3. Click File > Save.
Example: Duration control set to Admin.

To assign a security level to a screen

1. On the Tools > Screens dialog box, select the screen.
2. Select one of the password levels.
3. Click File > Save.
Example: **Module Status** screen set to **User**.

![Module Status Screen](image)

To create a Factory password for a touchscreen

1. Select **Configure > View Properties**.
2. Type a valid password in the **Factory Password** field and confirm it.
3. Click **OK**.

Create, edit, or lock the **Admin** and **User** passwords using the instructions below.

**To allow password management on a touchscreen**

To allow passwords to be changed on a touchscreen device:

1. Select **Configure > View Properties**.
2. Check **Allow password management on touchscreen**.
3. Check the **Reset touchscreen to these passwords**.
4. Type or edit valid passwords in the **User** and **Admin Password** fields.
5. Click **OK**.
To lock passwords on a touchscreen

To lock the User and Admin passwords on a touchscreen device:

1. Select Configure > View Properties.
2. Check Always use these passwords.
3. Type or edit valid passwords in the User and Admin Password fields.
4. Click OK.
Setting up alarms for Equipment Touch devices

The touchscreen device's buzzer sounds when the alarm is set up in the .touch file with the **Horn** option selected. You set up an alarm on the **Alarms** tab in the **Tools** window. A user can view the alarm description on the **ALARM** screen.

To set up an alarm:

1. Click the **Alarms** tab in the **Tools** window.
2. Click the ![Alarm](image) to add an alarm.
   - **TIP** To add all alarms from a control program, click ![Open](image), select the control program, then click **Open**.
3. Double-click that alarm's **Alarm ID** cell, then change the existing text to the alarm's BACnet Object ID.
4. Double-click the alarm's **Description** cell, then change the existing text to the description you want to appear on the **ALARM** screen.
5. Double-click to check the **Use Horn?** option; this allows the touchscreen device to audibly notify an operator when it receives an alarm.

**NOTES**

- To delete an alarm, select the alarm, then click ![Delete](image).
- Click a column heading on the **Alarms** tab to sort the alarms.
- You should enable each alarm's **Return to Normal** field in the i-Vu® interface to prevent the Alarm buzzer from remaining on until an operator can clear the alarm.
NOTE  If the non-English language uses non-ASCII characters, the names of your touchscreen file and any inserted image files must contain only ASCII characters.

To create a touchscreen file that can show multiple languages, use one of the following methods to create the non-English screens in ViewBuilder.

○  Add the non-English text in the ViewBuilder interface (page 140)
○  Export a language file, translate the terms, then import the new language file (page 141)

To add non-English text in the ViewBuilder interface

1  Select Configure > View Properties.

2  Under Supported Languages, select the languages you want to use in the touchscreen file. The languages you select will appear in the droplist on ViewBuilder’s toolbar.

   CAUTION  Do not uncheck English. Although you may not use this language in your screen file, some versions of the touchscreen device's firmware require that English be checked.

3  Click OK.

4  On ViewBuilder's toolbar, select the active language you want to use.

5  Create the screens, typing all static text in the language you selected in step 4.

6  If you want the touchscreen device to display multiple languages, select another language in the active language droplist.

7  Select each control in the project and type its text in the new language.

   TIP  You can switch back and forth between the languages in the droplist to verify the current screen’s text in the different languages.

8  Save your touchscreen file.

   NOTE  Some controls, such as the Date control, have formatting that might differ in various parts of the world. Be sure to select the appropriate format for the active language you selected.
To export/import language files

1. On ViewBuilder's toolbar, select the active language you want to use.

2. Create the screens, typing all static text in the language you selected in step 1.

3. Select Configure > View Properties > Languages.

4. In the Supported Languages section, select the language to be exported and click [Export].

   The file is exported to i-Vu_Pro_x.x\webroot\language_resources\language.map, where language is the actual name of the language. For example, english.map.

   **TIP** In the window that appears, highlight the path, and then press Ctrl+C to copy it. You can later paste it into Windows Explorer to locate the file.

5. Click OK.

6. In Windows Explorer, locate and open the language.map file in a text editor such as Notepad.

7. Translate each term into the language you want to use.

8. Save the file to i-Vu_Pro_x.x\webroot\language_resources\language.map, replacing language with the actual language name. For example, french.map.

9. Repeat steps 5–7 for any other languages the touchscreen device is to display.

10. Select Configure > View Properties > Languages.

11. In the Supported Languages section, click Import.

12. Browse to the language file(s) stored in step 8 above.

13. Select the language file(s) to be imported and click Import.
14 The import process adds the language(s) to the project's supported languages and to the toolbar droplist. Select each language in the droplist and then view each screen to verify the controls are spaced correctly and do not overlap.

15 Save your touchscreen file.
CUSTOM EQUIPMENT TOUCH SCREENS
ViewBuilder's Custom Equipment Touch feature allows you to create custom-sized Equipment Touch screens to display on mobile devices, such as a cellphone or tablet.

In ViewBuilder, you:

- Create the screens that the touchscreen application displays
- Test the navigation between screens
- Save the screens in a single .touch file that will be displayed in the Equipment Touch app on a mobile device

To create your screens

1. Make a new touchscreen file or open an existing file (page 147).
2. Edit the Home screen (page 149).
3. Add controls (page 154).

The following features can be added to your screens in much the same manner as to the Equipment Touch screens:

- Make additional screens (page 107).
- Add navigation (page 107).
- Set up alarms (page 139).
- Add support for multiple languages (page 140).
- Link touchscreens (page 130) to move from one screen to another in the touchscreen file using a button, an image, or text.
- Defining paths for a touchscreen (page 131) to use paths and conditional expressions in the touchscreen file.
- Set items to show/hide (page 133) in the touchscreen file.
- Password-protecting a touchscreen file (page 136).
- Save, assign, and download the touchscreen file (page 107).
Getting to know ViewBuilder's custom touchscreen interface

You make a touchscreen file in ViewBuilder using a simulation of the touchscreen device. You design your screens directly in the display area, and you set up linked buttons to navigate between the screens.
Creating screens for custom-sized devices

When you select Custom Equipment Touch view type, you can specify the width, height and pixel density of the device the screen is being created for. Changing the screen area dimensions allows you to take advantage of any extra real estate the target device offers. The file created is downloaded to an ALC module and can be displayed on a mobile device using the Equipment Touch application.

The Equipment Touch app is available through Google Play™ store and iTunes®. The Custom Equipment Touch file removes many of the limitations of the standard Equipment Touch file size while allowing alpha-transparency. If animated .gifs are used, the animation does not run.

To set the screen size

1. **File > New**, then select **Custom Equipment Touch**.
2. Select an item from the **Target Device** list.
   - **NOTE** If you need a size not listed, you can add a custom size (see below).

3. Click **OK**.

   **TIP** Rearrange the order of the items in the list by selecting an item and clicking ↑ or ↓.

To create a new Target Device item

1. Click the + to add a new mobile device size.
2. Enter the device name, width, height, and resolution.
3. Rearrange the order of the items in the list, if needed.
4. Click **OK**.
Creating a new Custom Equipment Touch screen file or opening an existing file

1  Do one of the following:

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new touchscreen file</td>
<td>File &gt; New, then select <strong>Custom Equipment Touch</strong>.</td>
</tr>
<tr>
<td>Open an existing touchscreen file created in ViewBuilder</td>
<td>File &gt; Open, then select the file.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> If the file is not listed, verify that the <strong>Files of Type</strong> selection lists Touchscreen files.</td>
</tr>
</tbody>
</table>

2  Select **File &gt; Save As**.

3  Browse to `|Vu_Pro_x.x\webroot\<system_name>\views\touchscreens`.

4  Type a **File name**, then click **Save**. ViewBuilder adds the `.touch` extension to your file name.

**NOTE** To record information about the file, select **Configure &gt; View Properties**, then type your name and comments on the **Summary** tab. **Revision History** shows each time the file was saved and the workstation it was saved on.

Custom Equipment Touch screen types

Every touchscreen file contains both custom and system screens. To navigate between the screens, you must provide a **Button**, **Text**, or **Image** control to act as a screen link. See **Custom Equipment Touch controls and their properties** (page 156).

**NOTE** The **Home** and custom screens are editable; system screens are not editable. System screens are easily identified by their name appearing in blue in the Screens list.

Custom screens

<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby</td>
<td>If included in the touchscreen file, the Standby screen displays when the Equipment Touch has had no user activity for the time specified on the <strong>Inactivity Timeout</strong> screen. This screen is not interactive, and as soon as the user touches the screen, the <strong>Home</strong> screen displays. To include this screen in your file, check <strong>Include Standby Screen</strong> on the <strong>Screen Properties</strong> window. <strong>NOTE</strong> If you do not include a Standby screen, the Home screen displays after a period of inactivity.</td>
</tr>
<tr>
<td>untitled</td>
<td>A blank screen that you design, configure, and name. Add controls and buttons that link to the other screens.</td>
</tr>
</tbody>
</table>
### System screens

<table>
<thead>
<tr>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home</strong></td>
<td>A screen that you design and configure. If you do not include a Standby screen (see above), the Home screen displays after a period of inactivity.</td>
</tr>
<tr>
<td><strong>Module Status</strong></td>
<td>Displays the following sections of a Module Status report: Device Data, Driver Data, Reset Counters, System Errors, Warnings, Information, Hardware, Database, Network.</td>
</tr>
<tr>
<td><strong>Schedule</strong></td>
<td>Lets the user view, add, edit, or delete BACnet schedules in the controller.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>The controller firmware has a setting to disallow adding, editing, or deleting schedules from the touchscreen device, limiting the user to only viewing schedules entered in the server.</td>
</tr>
<tr>
<td><strong>Login</strong></td>
<td>Displays if the screen the operator selected requires a password.</td>
</tr>
<tr>
<td><strong>Alarm</strong></td>
<td>Lets the user view alarms from the controller. You must define the alarms in ViewBuilder to have them display. See Setting up alarms (page 139).</td>
</tr>
<tr>
<td><strong>Browser</strong></td>
<td>Provides links to the following network-visible BACnet object types found in the controller: AI, AO, AV, BI, BO, BV, MSI, MSO, MSV. Each list shows the BACnet Object Name, Current Value, and BACnet Object Instance number.</td>
</tr>
<tr>
<td><strong>IP</strong></td>
<td>Lets the user view or edit network addresses, if enabled by the driver.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>If the controller's driver does not support this screen, the button on the Module Setup screen will be inactive.</td>
</tr>
<tr>
<td><strong>Router</strong></td>
<td>Lets the user view or edit the router's ARC156, MS/TP, or Ethernet network number.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>If the controller's driver does not support this screen, the button on the Module Setup screen will be inactive.</td>
</tr>
<tr>
<td><strong>Communication</strong></td>
<td>Lets the user edit the following: BACnet Device Instance number, Base BACnet Device ID number, Auto Generate Device ID - Yes/No, Number of Max Masters, Number of Max Info Frames</td>
</tr>
<tr>
<td><strong>Time Master</strong></td>
<td>If the controller can be a BACnet Time Master, this screen lets a technician configure how it sends time synchronization broadcasts.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>If the controller's driver does not support this screen, the button on the Module Setup screen will be inactive.</td>
</tr>
<tr>
<td><strong>Module Setup</strong></td>
<td>Displays links to the Set Time and Date, Communication, Router, IP, and Time Master screens.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Lets the user change the Admin or User password.</td>
</tr>
<tr>
<td><strong>Schedule Groups</strong></td>
<td>Lets the user create or delete Schedule Groups in the system.</td>
</tr>
<tr>
<td><strong>Sensor Setup</strong></td>
<td>Lets the user set up System Touch temperature and humidity sensors.</td>
</tr>
<tr>
<td><strong>Trends</strong></td>
<td>Lets the user view trends for points that have trending enabled.</td>
</tr>
</tbody>
</table>

**NOTE** System screens are a part of the touchscreen firmware. If a screen in the firmware is changed between releases of ViewBuilder, the ViewBuilder screen may look different than the actual touchscreen screen.
To customize the Home screen

1. Click the **Screens** tab in the **Tools** window.
2. Select **Home** from the list of screens.
3. Add or delete the standard items that will appear on the header by selecting or clearing the checkbox; all can be removed except the **Back** button.
4. Arrange the standard items in the **Header Aspects** list:
   - The **Alarm** button on the touchscreen appears red if in alarm state and gray if not.
   - Re-order the selected items as they appear on the header using the up and down arrows. The **Screen Title**, **Date**, and **Time** aspects can be re-ordered.
   - If you add the **Connection** button to the header, press and hold **F9** and the **Connection** button to test the link to the new **Connection** screen.
5. Add Custom Buttons to the header, if needed. Custom Buttons appear to the right.
6. Password-protect this screen, if necessary.
7. Add controls to the screen as necessary.
8. Edit the font and alignment in the **Control Properties** window for the currently selected control. If no control is selected, the **Properties** window is empty.

To add a Custom Button to the screen header

You can add up to two custom buttons to the header of a screen by assigning a graphic, a name, and screen the button links to.

1. In ViewBuilder, select **Configure > View Properties > Header**.
2. Type the button name that will appear in the **Header Aspects** list on the **Screens** tab in the **Tools** window.
3. Click the image placeholder, browse to the image file, then select the file.
4. Select a screen from the **Link to Screen** droplist, then click **OK**.
5. Repeat steps 1-4 if you are adding a second **Custom Button**.

**NOTE** Custom Buttons appear on the right side of the header and their order cannot be re-arranged.
To create and apply a theme

1. In the system `resources` folder, create subfolder called `touchview`, and another inside of it called `themes`. You must store your custom images here in either subfolders or in .zip files.

   Example: Below are two new custom themes: Custom Blue and ABC Company.

![Custom Blue and ABC Company themes](image)

2. Using an SVG editor, create customized versions of images and place them in the `themes` folder.

   **NOTES**
   - To determine the filenames and dimensions of the images, see "To create a themed image" below
   - Follow the guidelines provided in `Supporting .svg files` (page 160) regarding filenames, height, width, and aspect ratio restrictions
   - Themed images are not required to be .svg format, but is recommended for scalability

3. Add any additional images; follow the guidelines provided in `Supporting .svg files` (page 160).

4. Restart ViewBuilder.

5. Select the theme from the **Theme** selector droplist to view the changes.

![Default and new custom theme files](image)
To create a themed image

You can create different images for each theme. For example, you can create a blue version of the default wireless image shown below.

1. Select the image control on the workspace.
2. To view the image name and dimensions, click Configure > View Properties > Active Images. Note the filename and dimensions at the bottom of the control's dialog.
3. Create a new image with the same name and dimensions for the new theme. Save the new image in the appropriate theme folder or .zip file.
To create additional screens

1. Click the **Screens** tab in the **Tools** window.
2. Do one of the following:
   - In the **Screens** list, double-click **untitled**, then type a descriptive screen name.
   - Click ± to add a new blank screen, then change its name.
   - Select an existing screen, click ± to make a copy of it, then change the copy's name.
   
   **NOTE** You cannot copy a system screen.
3. Edit the header and password level at the bottom.
4. Add controls.

**NOTES**
- To delete a screen, select the screen name, then click ±. You cannot delete the Home or system screens.
- To rearrange the screen's order in the list, select the screen name, then click ↑ or ↓.

To add navigation

To give a user the ability to move from one screen to another:

1. Add a linked **Button**, **Text**, or **Image** control.
2. In the **Control Properties** window, select a screen from the **Link to Screen** drop-down list.

   **NOTE** The **Link to Screen** field is located on either the control's **Properties** window or on its **Link** tab.
3. To test the navigation, hold **F9** and click the linked control.

To prevent the .touch file from downloading to a controller

1. Save the .touch file to a convenient location on your computer.
2. In the i-Vu® interface, right-click the controller and select **Driver Properties** to attach the screen file.
3. **Download All Content** to the controller.

**NOTES**
- If the controller has an **Router Config Mode** DIP switch, make sure that this DIP switch is off when connecting a touchscreen device.
• If the .touch file contains many screens or large images that cause the file to become too large for the controller's memory, you can download only the name of the .touch file to the controller instead of the entire file. Go to Configure > View Properties, and check Exclude source from download on the General tab. If you check this box, you will need to manually copy the .touch file to your device using a USB drive. If the device is an EQT2, the device will copy the file to the correct location. If the device is a handheld mobile Android device, you will need to copy the file to the Device Storage > Touchfiles folder.
Adding controls to Custom Equipment Touch screens

You can add controls to a touchscreen that allow you to display such things as date and time, text and graphics, and information about microblock properties.

To add a control

1. Click the **Add Control** tab in the **Tools** window.
2. Select the control you want to add.
3. Click in the workspace where you want to add the control.
   - **NOTE** To cancel the action, press **Esc** before clicking the workspace.
4. Edit properties for the control in the **Control Properties** window.

**TIPS**

- To move a control, click and drag it to another location.
- To create a copy of a control, hold **Alt** while dragging the control.
- To add a control multiple times, select the control, then **Shift+click** the workspace for each copy.
- To delete a control, select the control and click **Delete** or press **Delete**.
- See *Custom Equipment Touch screen controls and their properties* (page 156) for a description of each control.

**NOTE** Many factors affect how many controls you can put on a screen before exceeding memory limitations. You may be able to put as many as 130 simple controls (numbers, text, etc.) on a screen.
Selecting controls on the workspace

You can select a control on the workspace by simply clicking on it.

If you have added multiple controls stacked on top of each other (at the same x, y co-ordinates), you can use the Control Selection tab to shuffle through the controls and select one from the stack.

To select a control from a stack

1. Click the Control Selection tab in the Tools window.
2. Select the control from the list.
3. View or edit the properties in the Control Properties window.

TIPS

- To move a control, click and drag it to another location.
- To create a copy of a control, hold Alt while dragging the control.
- To add a control multiple times, select the control, then Shift+click the workspace for each copy.
- To delete a control, select the control and click or press Delete.
## Custom Equipment Touch screen controls and their properties

Each control, its usage, and the properties you define are described in the tables below. Many controls share the following properties and may appear on their own tab in the **Control Properties** window.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Condition</strong></td>
<td>Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See <em>Setting items on a custom touchscreen to show/hide</em> (page 133).</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Select font size, color, and alignment.</td>
</tr>
<tr>
<td><strong>Link to Screen</strong></td>
<td>Select a screen in the drop-list so that the control becomes a link to that screen. Hold F9 and click the control to test the link. See <em>Linking Equipment Touch screens</em> (page 130).</td>
</tr>
</tbody>
</table>

**NOTE** If a control will reference a BACnet Object, the point must be set as **Network Visible** in the Snap or i-Vu® application.

### Controls

**Custom Equipment Touch controls are the same as those used for the Equipment Touch except for the additional Hotspot control below.**

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Hotspot**         | Create a resizable hot spot that links to another screen; lay the hot spot on top of any non-linkable control, such as an image.  
**NOTE** This control is only available for a Custom Equipment Touch file. See *Hotspot control on a Custom Equipment Touch* (page 158). |
| **Text**            | Display text.  
See *Text and images* (page 112) control. |
| **Text List**       | Display text based on a list of text values which are assigned to conditional values. The condition is tested against either a number, text, or a microblock property's value. The value whose **Condition** is true displays.  
See *Text and images* (page 112) control to add a **Text List** control to add conditions to the list. |
| **Number**          | Display any numerical value from an analog microblock. Example: Zone temperature.  
See *Number* (page 115) control. |
| **Duration**        | Display a time period. Example: Override time remaining.  
See *Duration* (page 116) control. |
| **Button**          | Display a navigation button that links to another screen.  
See *Linked button* (page 116). |
<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Off-Auto</td>
<td>Provide a method to lock a binary input or output on, lock it off, or let the control program control it (Auto). Example: To control fans or pumps. See On-Off-Auto (page 117) control.</td>
</tr>
<tr>
<td>Timed Local Override</td>
<td>Provide a method to view or edit a Timed Local Override. See Timed Local Override (page 118) control.</td>
</tr>
<tr>
<td>Image</td>
<td>Display an image. See Text and images (page 112) control.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Provide a method to choose between two states. See Checkbox (page 118) control.</td>
</tr>
<tr>
<td>Time</td>
<td>Display time of day. See Time control.</td>
</tr>
<tr>
<td>Text Toggle</td>
<td>Display active and inactive text values for a binary microblock. Example: Chiller is enabled or disabled. See Text Toggle (page 119) control.</td>
</tr>
<tr>
<td>View Port</td>
<td>Add controls or images to a resizable, scrollable container. See View Port (page 120) control.</td>
</tr>
<tr>
<td>Setpoint</td>
<td>Provide a method to view or edit setpoints. See Setpoint (page 122) control.</td>
</tr>
<tr>
<td>Image List</td>
<td>Shows various states of an analog microblock using images. See Text and images (page 112) control to add an Image List control and define conditions.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays:</td>
</tr>
<tr>
<td></td>
<td>• System date from the controller</td>
</tr>
<tr>
<td></td>
<td>• A date, typically read from a History microblock. Example: Date of the highest zone temperature. See Date (page 123) control.</td>
</tr>
<tr>
<td>Multi-State</td>
<td>Display the text values for multi-state microblocks. The Preview Text drop-list can also display the active and inactive text values for a binary microblock. Example: Units of measure (°F). See Multi-State (page 124) control.</td>
</tr>
<tr>
<td>Table</td>
<td>Add controls or images to a resizable, scrollable table. See Working with tables (page 125).</td>
</tr>
<tr>
<td>Primary Value</td>
<td>Display any numerical value from an analog microblock in a larger font than other controls for readability. See Primary Value (page 128) control.</td>
</tr>
</tbody>
</table>
Hotspot control on Custom Equipment Touch screens

Purpose:
Create a resizable hot spot that links to another screen; lay the hot spot on top of any non-linkable control, such as an image.

Properties:

**Link to Screen**—Select screen that you want the hotspot to link to.

Drag the magenta-outlined box to correct location, then resize as needed. If magenta outline disappears, move it to the top layer: *Tools > Arrange > Bring to Front.*

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See *Setting items on a touchscreen to show/hide* (page 133).

To test the navigation
Hold down F9 and click the area where the hotspot is placed. Although the rectangular border does not display, the area you selected is active and takes you to the screen.
Changing a property on multiple items of the same control type

If you have multiple instances of a text field, text list, or button image on a screen, you can change the properties of any of them all at once. For example, to change the color of the font in the screen below, select all of the controls to be changed, then edit the property.

1. Select any controls on the screen's workspace.
2. Edit any properties, and click **OK**.

**NOTE** Only the fields that you edited are changed. All other fields in all the controls remain as they were.
You can tailor a screen to a theme or brand by customizing the images used for
- Button and image controls
- Checkboxes and radio buttons
- Header buttons and scrollbars
- Image list

After creating or re-creating the files as .svg, you must create a folder, `resources/touchview/themes`, and place the .svg images in it, then restart ViewBuilder to see the new files.

### .svg examples

Any custom image that replaces an existing standard image must use the same filename and meet the standards in the SVG File Specifications (page 161). Below are some common examples.

#### Image that respects its aspect ratio

Example: The `header_homebutton` image must be 48 x 41. So the code will look like this:

```xml
<svg
    width="48"
    height="41"
    viewBox="0 0 48 41"
>
</svg>
```

#### Image that does not respect its aspect ratio

Example: The `button-center` image must be 40 x 36 with no aspect ratio, otherwise it may appear to be distorted if it is not designed to stretch. So the code will look like this:

```xml
<svg
    width="40"
    height="36"
    viewBox="0 0 40 36"
    preserveAspectRatio="none"
>
</svg>
```
Image that activates on click or touch

Example: The checkbox image can have four different images that display based on its state:

- `checkbox`
- `checkbox_selected`
- `checkbox_editable`
- `checkbox_editable_selected`

**.svg file specifications**

**Button control images**

Button controls consist of three images.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Width</th>
<th>Height</th>
<th>preserveAspectRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>button_left</td>
<td>5</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td><img src="image" alt="button_left" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>button_center</td>
<td>40</td>
<td>36</td>
<td>&quot;none&quot;</td>
</tr>
<tr>
<td><img src="image" alt="button_center" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>button_right</td>
<td>5</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td><img src="image" alt="button_right" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

left / center / right

**Checkbox images**

Checkboxes have four images.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Width</th>
<th>Height</th>
<th>preserveAspectRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="checkbox" /></td>
<td>checkbox</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
<tr>
<td><img src="image" alt="checkbox" /></td>
<td>checkbox_selected</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
<tr>
<td><img src="image" alt="checkbox" /></td>
<td>checkbox_editable</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
<tr>
<td><img src="image" alt="checkbox" /></td>
<td>checkbox_editable_selected</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
</tbody>
</table>
### Radio button images
Radio buttons have four images.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Width</th>
<th>Height</th>
<th>preserveAspectRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>radio</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>radio_selected</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>radio_editable</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>radio_editable_selected</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
</tbody>
</table>

### Image control and Image List images
These images are supplied by the user; the images in the theme must match the name, width, and height of that user supplied image. This information can be found on the **View Properties > Active Images** tab.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Width</th>
<th>Height</th>
<th>preserveAspectRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td>varies</td>
<td>Matches the name of the file added by the user</td>
<td>varies</td>
<td>varies</td>
<td>varies</td>
</tr>
</tbody>
</table>

### Header button images
Header buttons are a single button image each.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Width</th>
<th>Height</th>
<th>preserveAspectRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>header_background</td>
<td>480</td>
<td>41</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>header_homebutton</td>
<td>48</td>
<td>41</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>header_system_touch_home</td>
<td>48</td>
<td>41</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>header_backbutton</td>
<td>48</td>
<td>41</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>header_alarmbutton</td>
<td>48</td>
<td>41</td>
<td>n/a</td>
</tr>
<tr>
<td>varies</td>
<td>varies (see image control)</td>
<td>48</td>
<td>41</td>
<td>n/a</td>
</tr>
<tr>
<td>varies</td>
<td>varies (see image control)</td>
<td>48</td>
<td>41</td>
<td>n/a</td>
</tr>
</tbody>
</table>
Scrollbar images
Scrollbar images consist of eight images, four for the vertical scrollbars and four for the horizontal.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Width</th>
<th>Height</th>
<th>preserveAspectRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>scrollbar_horizontal_left</td>
<td>36</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>scrollbar_horizontal_center</td>
<td>36</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>scrollbar_horizontal_right</td>
<td>36</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>scrollbar_horizontal_slider</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>scrollbar_vertical_top</td>
<td>36</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>scrollbar_vertical_center</td>
<td>36</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>scrollbar_vertical_bottom</td>
<td>36</td>
<td>36</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>scrollbar_vertical_slider</td>
<td>30</td>
<td>30</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Background images
The background image can be any size, it is used as a tiled background for the screens.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Width</th>
<th>Height</th>
<th>preserveAspectRatio</th>
</tr>
</thead>
<tbody>
<tr>
<td>varies</td>
<td>view_background</td>
<td>any</td>
<td>any</td>
<td>n/a</td>
</tr>
</tbody>
</table>
Working with System Touch screens

The System Touch is a touchscreen device that lets you control your HVAC equipment, view alarms, or link to screens for individual controllers on the network.

In ViewBuilder, you:

- Create the screens that the touchscreen displays
- Test the navigation between screens
- Save the screens in a single .stv file that will be installed in the System Touch

**NOTE** The System Touch must have v2.00-015 or later firmware to display screens created in ViewBuilder.

Perform as many of the actions below, as needed, to create your screens.

1. Make a new touchscreen file or open an existing file (page 168).
2. Edit the Home screen (page 170).
3. Make additional screens (page 171).
4. Add controls (page 172).
5. Add navigation (page 171).
6. Password-protect the screens (page 196).
7. Add support for multiple languages (page 199).
You make a touchscreen file in ViewBuilder using a simulation of the touchscreen device. You design your screens directly in the display area, and you set up linked buttons to navigate between the screens.

To move objects

To move a selected object(s):

- Click and drag the object to the new location. Hold down \texttt{Shift} as you drag an object to constrain its movement to horizontal or vertical.

- Use the arrow keys to nudge the selected object one pixel at a time, or hold down \texttt{Shift} while using the arrow keys to move the object ten pixels at a time.
To align, group, and layer objects

Select the objects that you want to align or reorder (front to back), then use the right-click menu commands or the options on the Add Control tab in the Tools window.

NOTES
- Objects align in relationship to the last selected object, the one with the green handles.
- You can select an individual control in a group to edit its properties in the Control Properties window.

To copy an object

Alt+click and drag a control to create a copy of it on the same screen.

To copy a selected object(s) from one screen to another:

1 Select the object(s), then click.
2 On the new screen, click.
3 Click and drag the object(s) to the desired location.

To lock or unlock controls

To lock a selected object(s) so you cannot select or move it, right-click the object, then select Lock.
To unlock an object, Ctrl+right-click the object, then select Unlock.

NOTE To unlock all locked objects simultaneously, right-click anywhere in the workspace and select Unlock All.

To undo or redo actions

Click on the toolbar as many times as necessary to undo actions that you performed, beginning with the most recent action. Click to redo the action.

You can also click the drop-down arrow to the right of the Undo or Redo button to select an action from a list that begins with the most recent action. Selecting an action will undo or redo that action, plus all actions above it in the list.
Creating a new System Touch screen file or open an existing file

1. Do one of the following:

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new touchscreen file</td>
<td>File &gt; New, then select Touchscreen.</td>
</tr>
<tr>
<td>Open an existing touchscreen file created</td>
<td>File &gt; Open, then select the file.</td>
</tr>
<tr>
<td>in ViewBuilder</td>
<td>NOTE If the file is not listed, verify that the Files of Type selection lists Touchscreen files.</td>
</tr>
</tbody>
</table>

2. Select File > Save As.

   NOTE If using i-Vu® Pro, browse to \Vu_Pro_x.x\webroot\<system_name>\views\touchscreens.

3. Type a File name, then click Save. ViewBuilder adds the .touch extension to your file name.

NOTES

- To record information about the file, select Configure > View Properties, then type your name and comments on the Summary tab. Revision History shows each time the file was saved and the workstation it was saved on.
- A .stv file (including all text, screens, images, and controls) is comprised of a set of compressed files and cannot exceed 512KB. In addition, the total size of the uncompressed files cannot exceed 1MB and the size of any single uncompressed file cannot exceed 512KB.

System Touch screen types

Every touchscreen file contains both custom and system screens. To navigate between the screens, you must provide a Button, Text, or Image control to act as a screen link. See System Touch controls and their properties (page 174).

NOTE The Home and Custom screens are editable; System screens are not editable. System screens are easily identified by their name appearing in blue in the Screens list.
Custom screens

**CAUTION** All Custom screens must link to either a System screen or another Custom screen that links to a System screen. See Linking System Touch screens (page 191).

<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Standby     | If included in the touchscreen file, the Standby screen displays when the System Touch has had no user activity for the time specified on the Inactivity Timeout screen. This screen is not interactive, and as soon as the user touches the screen, the Home screen displays. To include this screen in your file, check Include Standby Screen on the Screen Properties window.  

**NOTE** If you do not include a Standby screen, the Home screen displays after a period of inactivity. |
| untitled    | A blank screen that you design, configure, and name. Add controls and buttons that link to the other screens. |
| Home        | A screen that you design and configure. If you do not include a Standby screen (see above), the Home screen displays after a period of inactivity. |

System screens

<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Manager</td>
<td>Lets the user view all alarms in the system.</td>
</tr>
</tbody>
</table>
| Communication   | Lets the user select the baud rate of the MS/TP network that the System Touch is on.  

Lets the user edit the following:  
My Network number  
My address number  
Destination Network number |
| Schedule Groups | Lets the user create or delete Schedule Groups in the system. |
| System View     | Displays the BACnet device instance number, the controller's time, temperature read from the System Touch sensor, and zone color.  

Provides links to the Alarm, Schedules, and Setup screens. |
<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touchscreen Setup</td>
<td>Screen links:</td>
</tr>
<tr>
<td></td>
<td>About - Displays information about the touchscreen firmware.</td>
</tr>
<tr>
<td></td>
<td>Inactivity Timeout - Lets the user define the time it will take for the</td>
</tr>
<tr>
<td></td>
<td>touchscreen device to return to the Standby screen and log out the user</td>
</tr>
<tr>
<td></td>
<td>when no activity is detected.</td>
</tr>
<tr>
<td></td>
<td>Sensor Setup - Lets the user set up System Touch temperature and humidity</td>
</tr>
<tr>
<td></td>
<td>sensors.</td>
</tr>
<tr>
<td></td>
<td>Clean Screen - Displays a screen with a one-minute countdown timer so that</td>
</tr>
<tr>
<td></td>
<td>the user can clean fingerprints from the display window without touching</td>
</tr>
<tr>
<td></td>
<td>something that would affect equipment operation.</td>
</tr>
<tr>
<td></td>
<td>Key Click Off/On - A button that turns the sound for screen touches off.</td>
</tr>
<tr>
<td></td>
<td>Alarm Sound Off/On - For future use.</td>
</tr>
<tr>
<td></td>
<td>Reload Firmware - Erases the current firmware so that the user can load</td>
</tr>
<tr>
<td></td>
<td>new firmware through the USB port.</td>
</tr>
<tr>
<td></td>
<td>Language - If optional languages are defined in ViewBuilder when the</td>
</tr>
<tr>
<td></td>
<td>touchscreen file is created, the Language screen lets the user select the</td>
</tr>
<tr>
<td></td>
<td>language for displaying system screens. If custom screens are included in</td>
</tr>
<tr>
<td></td>
<td>the touchscreen file, they will display in the language in which they are</td>
</tr>
<tr>
<td></td>
<td>created.</td>
</tr>
<tr>
<td></td>
<td>Passwords - Lets the user change the Admin or User password, if allowed.</td>
</tr>
<tr>
<td></td>
<td>Calibrate Touch Panel - Lets the user recalibrate the screen by touching</td>
</tr>
<tr>
<td></td>
<td>targets.</td>
</tr>
<tr>
<td>Language</td>
<td>Displays languages used in the system. Select language to display on the</td>
</tr>
<tr>
<td></td>
<td>touchscreen.</td>
</tr>
<tr>
<td>Login</td>
<td>Displays if the screen the operator selected requires a password.</td>
</tr>
</tbody>
</table>

**NOTE** System screens are a part of the touchscreen firmware. If a screen in the firmware is changed between releases of ViewBuilder, the ViewBuilder screen may look different than the actual touchscreen screen.

**To customize the Home screen**

1. Click the **Screens** tab in the **Tools** window.
2. Select **Home** from the list of screens.
3. Arrange the header items in the **Header Aspects** list:
   - Add or delete items by selecting or clearing the checkbox; all can be removed except the **Back** button.
   - Re-order the selected items as they appear on the header using the up and down arrows.
   - The **Alarm** button on the touchscreen appears red if in alarm state and gray if not.
4. **Password-protect** (page 196) this screen, if necessary.
5. **Add controls** (page 172) to the screen as necessary.
6. Edit the font and alignment in the **Control Properties** window for the currently selected control. If no control is selected, the properties window is empty.
To create additional screens

1. Click the **Screens** tab in the **Tools** window.
2. Do one of the following:
   - In the **Screens** list, double-click **untitled**, then type a descriptive screen name.
   - Click ![+] to add a new blank screen, then change its name.
   - Select an existing screen, click ![+] to make a copy of it, then change the copy's name.
   **NOTE** You cannot copy a system screen.
3. Edit the header and password level at the bottom.
4. Add controls.

**NOTES**
- To delete a screen, select the screen name, then click ![−]. You cannot delete the Home or system screens.
- To rearrange the screen's order in the list, select the screen name, then click ![↑] or ![↓].

To add navigation

To give a user the ability to move from one screen to another:

1. Add a linked **Button**, **Text**, or **Image** control.
2. In the **Control Properties** window, select a screen from the **Link to Screen** drop-down list.

   **NOTE** The **Link to Screen** field is located on either the control's **Properties** window or on its **Link** tab.
3. To test the navigation, hold **F9** and click the linked control.


### Adding controls to System Touch screens

You can add controls to a touchscreen that allow you to display such things as date and time, text and graphics, and information about microblock properties.

**To add a control**

1. Click the **Add Control** tab in the **Tools** window.
2. Select the control you want to add.
3. Click in the workspace where you want to add the control.
   - **NOTE** To cancel the action, press **Esc** before clicking the workspace.
4. Edit properties for the control in the **Control Properties** window.

**TIPS**

- To move a control, click and drag it to another location.
- To create a copy of a control, hold **Alt** while dragging the control.
- To add a control multiple times, select the control, then **Shift+click** the workspace for each copy.
- To delete a control, select the control and click **Delete** or press **Delete**.
- See System Touch controls (page 174) and their properties for a description of each control.

**NOTE** Many factors affect how many controls you can put on a screen before exceeding memory limitations. You may be able to put as many as 130 simple controls (numbers, text, etc.) on a screen.
Selecting controls on the workspace

You can select a control on the workspace by simply clicking on it.

If you have added multiple controls stacked on top of each other (at the same x, y co-ordinates), you can use the Control Selection tab to shuffle through the controls and select one from the stack.

To select a control from a stack

1. Click the Control Selection ( ) tab in the Tools window.
2. Select the control from the list.
3. View or edit the properties in the Control Properties window.

TIPS

- To move a control, click and drag it to another location.
- To create a copy of a control, hold Alt while dragging the control.
- To add a control multiple times, select the control, then Shift+click the workspace for each copy.
- To delete a control, select the control and click or press Delete.
System Touch screen controls and their properties

Each control, its usage, and the properties you define are described in the tables below. Many controls share the following properties and may appear on their own tab in the Control Properties window.

**Condition**
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 193).

**Font**
Select font size, color, and alignment.

**Link to Screen**
Select a screen in the drop-list so that the control becomes a link to that screen. Hold F9 and click the control to test the link. See Linking System Touch screens (on page 191).

**NOTE** If a control will reference a BACnet Object, the point must be set as Network Visible in the Snap or i-Vu® application.

## Controls

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Text Field**      | Display text.  
See Text and images on a System Touch (page 175) screen. |
| **Text List**       | Display text based on a list of text values which are assigned to conditional values. The condition is tested against either a number, text, or a microblock property's value. The first value whose **Condition** is true displays.  
See Text and images on a System Touch (page 175) screen to add a **Text List** control to add conditions to the list. |
| **Number**          | Display any numerical value from an analog microblock. Example: Zone temperature.  
See Number control on a System Touch (page 178) screen. |
| **Text Toggle**     | Display active and inactive text values for a binary microblock. Example: Chiller is enabled or disabled.  
See Text Toggle control on a System Touch (page 179) screen. |
| **View Port**       | Add controls or images to a resizable, scrollable container.  
See View Port on a System Touch (page 180) screen. |
| **Image**           | Display an image.  
See Text and images on a System Touch (page 175) screen. |
| **Checkbox**        | Provide a method to choose between two states.  
See Checkbox control on a System Touch (page 182) screen. |
| **Time**            | Display time of day.  
See Time control on a System Touch (page 182) screen. |
Use this control... To...

- **Multi-State**
  - Display the text values for multi-state microblocks. The Preview Text drop-list can also display the active and inactive text values for a binary microblock.
  - Example: Units of measure (°F).
  - See Multi-State control on a System Touch (page 183) screen.

- **Table**
  - Add controls or images to a resizable, scrollable table.
  - See Working with tables on a System Touch (page 184) screen.

- **Image List**
  - Shows various states of an analog microblock using images.
  - See Text and images on a System Touch (page 175) screen to add an Image List control and define conditions.

- **Radio Button**
  - Provide a method to select one option from a set of alternatives.
  - Example: Manual and Auto.
  - See Radio buttons on a System Touch (page 187) screen.

- **Date**
  - Displays:
    - System date from the controller
    - A date, typically read from a History microblock.
      - Example: Date of the highest zone temperature.
  - See Date control on a System Touch (page 187) screen.

- **Button**
  - Display a navigation button that links to another screen.
  - See Linked button on a System Touch (page 188) screen.

- **Primary Value**
  - Display any numerical value from an analog microblock in a larger font than other controls for readability.
  - See Primary Value control on a System Touch (page 189) screen.

---

**Text and images on System Touch screens**

You can add **Text** and **Image** controls to a touchscreen file.

**Customize the Text control**

- Make it a link to another screen or to a BACnet Device Id on the **Link** tab. See Linking System Touch screens (page 191).
- Change the font size, color, and alignment on the **Font** tab.
- Set the control to show or hide on its **Condition** tab based on password levels, a microblock property's value, or if a path exists. See Setting items on a touchscreen to show/hide (page 193).
Customize the Image control

- Make it a link to another screen or to a BACnet Device Id on the Link tab. See Linking System Touch screens (page 191).
- Set the control to show or hide based on password levels, a microblock property's value, or the existence of its path on its Condition tab. See Setting items on a touchscreen to show/hide (page 193).

Text and Image Lists

You can also create lists of either text or images to assign different conditions to multiple values. Each condition is evaluated, one after another, and the first one to be evaluated as true is displayed on the touchscreen device. If none of the values are true, default text or a default image is displayed.

Text

To add text

1. Select the Add Control tab, click Text Field, then click in the screen.
2. Double-click on Preview text inside the control's field, select the text to delete it, then type the text to be displayed on the touchscreen.
   Optional: Copy text from another application, then replace Preview text.
3. Select Word Wrapping if text overflows the text field.
4. NOTE Text cannot extend past the constraint of the width of the control and borders of the display.
5. Click OK.

To add a Text List

1. Select the Add Control tab, click Text List, then click in the screen.
2. In the Default Value field, type the text that will display if none of the conditions are true. Select one:
   - Static Text and type text to display.
   - Path To BACnet Property to display the Preview Text.
3. Click .
4. Select one:
   - Static Text and type text to display if the condition is true.
   - Path To BACnet Property and type the path to display the value from the microblock.
5. Select a condition or add a new one. See Setting items on a touchscreen to show/hide (page 193).
6. Check Autosize to adjust the size of the control to the length of the longest condition value displayed.
To manually adjust the width of the control, grab a handle on the left or right side of the control box:

7 Repeat steps 4–6 for additional conditions.

NOTES

• The Text List can be set up to use different text for each condition and can have different font style properties assigned to each one.

• See Conditional items in a list (page 178) to arrange the conditions according to which displays.

Images

To add an image

1 Select the Add Control tab , click Image, then click in the screen.

2 Select a new image or click the Active Images tab to reuse images already used in the .touch file.

3 Click OK.

4 Click in the screen.

5 Click and drag a corner to resize it.

NOTE Hold Shift as you drag to maintain the image's proportions.

To add an Image List

1 Select the Add Control tab , click Image List, then click in the screen.

2 Select a new image or click the Active Images tab to see images already used in the .touch file.

This is the Default Image displayed when none of the other conditions is true or when a communication problem or issue occurs.

3 Click OK.

4 Click in the screen.

5 Click and drag a corner to resize it.

NOTE Hold Shift as you drag to maintain the image's proportions.

6 Click to add an image that the control displays under normal conditions.

7 Select an image, then click OK.

8 Select a condition or add a new one. See Setting items on a touchscreen to show/hide (page 193).

9 Repeat steps 6–8 for additional conditions.

See Conditional items (page 178) in a list to arrange the conditions according to when each should display.
Conditional items in a list

Text List and Image List allow the operator to assign text or images to indicate different conditions. Each condition in the list is evaluated, one after another, and the first one to be evaluated as true will be displayed on the touchscreen device. If no expression returns true, the Default Text or Default Image is displayed.

For example, a damper can be displayed as Closed, Half-open, or Open depending on the Show/Hide conditions assigned to a microblock’s property. Either or can be used to show these states.

1. Create a text list or image list.
2. Arrange your conditions using and to reorder the list.

TIPS
- The control property’s window does not automatically expand, so you can resize it to display all items in the list.
- Click to delete an image from the list.
- Click to change the image assigned to a condition.

Number control on System Touch screens

Purpose:
Display any numerical value from an analog microblock.
Example: Zone temperature.

Properties:
Path to BACnet Property—Enter the path to the BACnet property you want the control to read from or write to. See Defining paths for the touchscreen (page 192).
Format—Select the appropriate number formatting, such as decimal places and comma separators.
Scaling Factor—To display a microblock property's value in a different format, type the necessary multiplication factor.
  Example: To display watts as kilowatts, type .001 in this field.
Show Units—Check to display the unit associated with the property in the control program. The selected unit’s value in the list are just to estimate size.
Editable—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.
Autosize—Check to adjust the size of the control to the length of the value displayed. To manually adjust the width of the control, grab a handle on the left or right side of the control box:

Limits—To display a minimum/maximum range of values defined in the microblock or in the custom values fields.

Font tab:
Change the font size, color, and alignment on the Font tab.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 193).

Text Toggle control on System Touch screens

Purpose:
Display active and inactive text values for a binary microblock. Example: Chiller is enabled or disabled.

Properties:

Path to BACnet Property—Enter the path to the BACnet property you want the control to read from or write to. See Defining paths for the touchscreen (page 192).

Editable—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.

Preview Text—Text that is displayed only in ViewBuilder to help you place the control. Type the preview text or select from the drop-down list.

Autosize—Check to adjust the size of the control to the length of the value displayed. To manually adjust the width of the control, grab a handle on the left or right side of the control box:

Font tab:
Change the font size, color, and alignment on the Font tab.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 193).
View Port on System Touch screens

**Purpose:**

Increase the viewing area of a touchscreen device's window. The View Port's canvas can hold many more controls than the touchscreen can display at one time.

Controls and text are added to the canvas and horizontal and vertical scrollbars appear, as needed, allowing you to view the other areas of the canvas.

**NOTE** When the View Port control is initially placed on the canvas, the width is set to take up the full width of the screen and the height is set to fit between the header bar and buttons at the bottom of the screen.

**Properties:**

**View Port window**—Display area, including scrollbars, seen on the touchscreen device. The scrollbars allow the designer to see what the layout looks like on the touchscreen device.

To move the **View Port** window, click and drag the window.

To change the size of the View Port control, drag one of the green corner markers.
View Port Editor—The area outlined in white is the canvas design area and the area outlined in yellow is the display area visible on the touchscreen. The display area includes horizontal and vertical scrollbars.

To add a View Port

1. Select the Add Control tab, click \( \text{Add Control} \), then click in the screen.
2. Click in the workspace to add the View Port.
3. Select a background color and click Change.
4. Uncheck Border Enabled if you do not want the borders to display.

To navigate in the View Port window

Scrollbars appear in the View Port window to allow you to navigate around to the areas outside of the visible area. To navigate to regions outside of the display window, do one of the following:

- Hold down F9 while clicking the up and down or right and left arrows.
- Hold down F9 while dragging the black slider up and down or side to side.
To customize a View Port

To add content to the View Port control:

1. Double-click inside it to open the View Port Editor.
2. Drag and drop controls or images into the canvas.
3. Click Close View Port Editor to return to the touchscreen.

NOTE Any controls that are added to the main screen and not while in the View Port Editor, are not actually a part of the View Port, but are layered above or below the View Port control.

Checkbox control on System Touch screens

Purpose:

Provide a graphical method to show or choose between two states.

Properties:

Path to BACnet Property—Enter the path to the BACnet property you want the control to read from or write to. See Defining paths for the touchscreen (page 192).

Editable—When selected, the control is editable on the touchscreen device.

Show Selected—When selected, the control displays as "selected" in ViewBuilder

NOTE This doesn't affect how the control displays on the touchscreen device.

Condition tab:

Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 193).

Time control on System Touch screens

Purpose:

Display time of day.

Properties:

Use System Time—Check to use the time coming from the controller instead of the time pulled from the microblock.

Display Format—Choose to display various time formats such as AM/PM, 24 hour, or minutes and seconds.
**Editable**—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.

<table>
<thead>
<tr>
<th>For this type...</th>
<th>use this path...</th>
</tr>
</thead>
<tbody>
<tr>
<td>equipment</td>
<td>~device/driver/device/local_time</td>
</tr>
<tr>
<td>area</td>
<td>&lt;equipment_ref_name&gt;/~device/driver/device/local_time</td>
</tr>
</tbody>
</table>

**Autosize**—Check to adjust the size of the control to the length of the value displayed. To manually adjust the width of the control, grab a handle on the left or right side of the control box:

**Font tab:**
Change the font size, color, and alignment on the **Font** tab.

**Condition tab:**
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See *Setting items on a touchscreen to show/hide* (page 193).

---

**Multi-State control on System Touch screens**

**Purpose:**
Display the text values for multi-state microblocks. The **Preview Text** drop-list can also display the active and inactive text values for a binary microblock. Example: Units of measure (°F).

**Properties:**

**Path to BACnet Property**—Enter the path to the BACnet property you want the control to read from or write to. See *Defining paths for the touchscreen* (page 192).

**Editable**—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.

**Preview Text**—Text that is displayed only in ViewBuilder to help you place the control. Type the preview text or select from the drop-down list.

**Autosize**—Check to adjust the size of the control to the length of the value displayed. To manually adjust the width of the control, grab a handle on the left or right side of the control box:
Use Custom Defined States—Select to add analog values and display names to the list.

Font tab:
Change the font size, color, and alignment on the Font tab.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 193).

Working with tables on System Touch screens

You can add a table to a touchscreen and then add controls or images in the table cells. To customize the table:

- Select the table to move it within the touchscreen display area.
- Adjust the size of the table by selecting the table and dragging one of the green corner markers.
- Change the background and border colors by clicking Change.

To add a table

1. Select the Add Control tab, click , then click in the screen.
2. Click in the workspace where you want to add the table.
3. Click Change to select a different background color.
4. Uncheck Border Enabled if you do not want the borders to display.

Adjusting the table

NOTE To add, delete, or adjust rows and columns, double-click inside the table to open the Table Editor.

To add a row or column to the end of a table:
1. Right-click anywhere in the table.
2. Select Insert Row or Insert Column.

To add a row or column before the last one:
1. Click column or row gray header bar to select it.
2. Right-click the gray header bar to insert one before the selected row or column.
3. Select Insert Row or Insert Column.
To delete a row or column:
1 Right-click its gray header bar.
2 Select Delete Row or Delete Column.

To adjust column width:
Drag the ends of the column's gray header bar.

NOTES
• A dashed yellow box outlines the perimeter of the table.
• As more controls are added, the table may become larger than will display on the touchscreen. Horizontal or vertical scrollbars appear and can be used to simulate what the user will be able to view in the table by pressing F9 and dragging the black box or scrollbars.
• Minimum width and height is 25 pixels.
• Row height is determined by the tallest control in the row.

To add a control to a table cell
1 Double-click the table in the touchscreen to open the Table Editor.

TIP  If gray bars do not appear above each column and to the left of each row, the table is not active and cannot be edited. See note below.
2 Click the control in the Tools window.
3 Click the cell where you want to add the control.

NOTE  Cell resizes to the area needed to display the control.
4 Enter the control’s properties.
5 Click Close Table Editor to return to the touchscreen.

NOTE  Adding controls to the touchscreen without opening the Table Editor places the control directly on the touchscreen—not in the table. The table will not resize accordingly and the control will be on a different layer than the table. See step 1 above.

TIPS
• To move an object and its condition, click and drag the item.
• To copy an object and its condition, hold down Alt as you drag the item.
• Objects moved or added into cells that have a show/high condition may or may not assume the condition. If you do not get the results you want, change the show/hide condition or click to undo the action.
• Placing objects in a cell that already contains a control replaces the original object.
To align objects in a table

To align a control within its cell:
1. Double-click the control in the table to open the Table Editor.
2. Right-click a control and then select Align.
3. Select how you want to align it from the list.

**TIP** Ctrl-click to select multiple objects to align.

To align all controls within a row or column:
1. Select the row or column’s gray bar.
2. Right-click and then select Align.
3. Select how you want to align it from the list.

To hide objects in a table

If you hide part of a row, the cells will be blank when the screen is viewed in the touchscreen device.
If you hide an entire row, the row will not appear on the screen when viewed in the touchscreen device.

**Hide a control in a cell**
1. Double-click the table to open the Table Editor.
2. Select the control you want to hide under certain circumstances.
3. In the Control Properties window, click the Condition tab.
4. Select an existing condition from the list or create a new one.

**Hide a row in a table**
1. Double-click the table to open the Table Editor.
2. Select the gray bar of the row you want to hide under certain circumstances.
3. In the Control Properties window, click the Row Condition tab.
4. Select an existing condition from the list or create a new one.
Radio buttons on System Touch screens

Purpose:
Provide a method of selecting one option from a set of alternatives.
Example: Manual and Auto.

Enter the same **Path to BACnet Property** for each radio button in the set.

Properties:
- **Path to BACnet Property**—Enter the path to the BACnet property you want the control to read from or write to. See *Defining paths for the touchscreen* (page 192).
- **Editable**—When selected, this field is outlined by a white box on the screen. When selected on the touchscreen device, a numeric keypad pops up allowing the user to enter a value.
- **Radio Button Value**—Type the value that represents the active or true state for this radio button.
  - For an analog microblock, type the specific value the button is to represent.
  - For a binary microblock, type *true* or *1* (depending on the property) for one button's value and *false* or *0* for the other button's value.
- **Show Selected**—When selected, the control displays as “selected” in ViewBuilder.

**NOTE** This doesn't affect how the control displays on the touchscreen device.

Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See *Setting items on a touchscreen to show/hide* (page 193).

Date control on System Touch screens

Purpose:
Display a date, typically read from a History microblock.
Example: Date of the highest zone temperature.

Properties:
- **Path to BACnet Property**—Enter the path to the BACnet property you want the control to read from or write to. See *Defining paths for the touchscreen* (page 192).
- **Use System Date**—Check to use the System date, retrieved from the controller, instead of the date pulled from the microblock.
- **Date Format**—Select the appropriate format.
For this type... use this path...

<table>
<thead>
<tr>
<th>equipment</th>
<th>~device/driver/device/local_date</th>
</tr>
</thead>
<tbody>
<tr>
<td>area</td>
<td>&lt;equipment_ref_name&gt;/~device/driver/device/local_date</td>
</tr>
</tbody>
</table>

**Editable**—When selected, the control is editable on the touchscreen device.

**Autosize**—Check to adjust the size of the control to the length of the value displayed.

To manually adjust the width of the control, grab a handle on the left or right side of the control box:

![Module Status](image1)

**Font tab:**

Change the font size, color, and alignment on the **Font** tab.

**Condition tab:**

Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See **Setting items on a touchscreen to show/hide** (page 193).

---

**Linked button control on System Touch**

**Purpose:**

Display a navigation button that links to another screen.

**Properties:**

- **Link to Screen**—Select screen that you want the button to link to.
- **Link to BACnet Device Id**—Enter the path.
- **Use Custom Link Name**—Select to use a custom name on the button.
- **Custom Link Name**—Enter the name you want to appear on the link button. Resize the width of the button as needed.

**NOTE** Width of the control can be adjusted by grabbing a handle on the left or right side of the control box:

![Module Status](image2)

**Font tab:**

Change the font size, color, and alignment on the **Font** tab.
Condition tab:
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 193).

---

**Primary Value control on System Touch screens**

**Purpose:**
Display any numerical value from an analog microblock in a larger font than other controls for readability. Example: Zone temperature.

**Properties:**
- **Path to Microblock Property**—Enter the path to the microblock property you want the control to read from or write to. See Defining paths for the touchscreen (page 131).
- **Format**—Select the appropriate number formatting, such as decimal places and comma separators.
- **Show Units**—Check to display the unit associated with the property in the control program. The selected unit's value in the list are just to estimate size.

**Font tab:**
Change the font size, color, and alignment on the Font tab.

**Condition tab:**
Set controls in a screen to show or hide based on password levels, a microblock property's value, or the existence of its path. See Setting items on a touchscreen to show/hide (page 193).
Changing a property on multiple items of the same control type

If you have multiple instances of a text field, text list, or button image on a screen, you can change the properties of any of them all at once. For example, to change the color of the font in the screen below, select all of the controls to be changed, then edit the property.

1. Select any controls on the screen's workspace.
2. Edit any properties, and click **OK**.

**NOTE** Only the fields that you edited are changed. All other fields in all the controls remain as they were.
**Linking System Touch screens**

**CAUTION** At least one Custom screen must link out to a System screen. All other Custom screens must link to either:

- A System screen
- Another Custom screen that links to a System screen

Otherwise, you will **not** be able to navigate to any of the System screens when you install the .stv file.

The **Link to Screen** drop-down list, which is located on either of the **Link** tabs ( or ), provides a way of moving from one screen to another in the touchscreen file by selecting a screen from the list. The link can be a button, text, or image.

1. Select the screen to link to, then save the file.
2. Hold **F9** and click the text, button, or image to test the link.

The **Link to BACnet Device Id** field, which is located on either of the **Link** tabs ( or ), provides a way of moving from one screen to another screen by typing a BACnet Device Id in the field. The link can be a button, text, or image.

1. Type the BACnet Device Id to link to, then save the file.
2. Hold **F9** and click the text, button, or image to test the link.
A path tells the i-Vu® application the route through the system hierarchy to an item in the system. For example, a path tells the i-Vu® application where to find a microblock property value to display on a touchscreen device or where to jump to when the user touches a link on a touchscreen device.

In ViewBuilder, you use paths in controls and conditional expressions.

You can do one of the following to get the path:

- In the ViewBuilder interface, navigate to the point using the System dialog box.
- In the i-Vu® interface, determine the path yourself (page 81).

A path consists of the BACnet Device Id number, microblock reference name, and property, separated by a forward slash (/). For example, 240101/sat/present_value.

**NOTE** If this field is outlined in red, you entered invalid syntax or characters.

### To define paths for .stv file

A path consists of the BACnet Device Id number, microblock reference name, and property, separated by a forward slash (/). For example, 240101/sat/present_value.

You can determine the path in ViewBuilder or in the i-Vu® interface:

**In ViewBuilder**

1. Click System on the toolbar.
2. Select the database, then click Next.
3. Enter or select your username and password, then click Next.
4. Select a device, then click Show Device.
5. Expand the control program, then select the point.
   
   **NOTE** If the path appearing in the Path to BACnet Property field contains a point different from the one needed, select from the Property drop-down list. If the point you need is not available in the list, determine the path from the i-Vu® interface; see below.
6. Click Close System.
7. Close the System window.
8. Right-click in the Path to BACnet Property field and click Set Path Value.

   **NOTE** If the path does not appear in the field, the point selected is not a valid BACnet point.

**In the i-Vu® interface**

Paths can be found on the Properties, or Graphics pages in the i-Vu® interface.

1. Right-click a value, then select Global Modify.
2. Copy the microblock and property from the Expression field, then paste into ViewBuilder's control window's Path to BACnet Property field.
3. Place your cursor in front of the path and type the control program number followed by a "/" into the Path to BACnet Property field.
You can set a control, or an item in a control such as a table row or cell, to show or hide on the touchscreen device based on the user’s password level or by creating a conditional expression that tests the value of a microblock property.

You can also create a set of expressions using the **Text List** or **Image List** controls to indicate different conditions of the microblock property. See *Conditional items in a list* (page 178).

**EXAMPLE** To display various states in a damper, you can create a series of expressions ranging from Open to Closed with various states in between. These states could be displayed in various ways:

- Using a **Text List**: Closed, Half-Open, Open
- Using a **Text List** with colored font: Closed indicated by red, Half-Open by yellow, Open by green
- Using an **Image List** using images of the damper in each of the states

### To set items to show/hide

#### Based on the user’s password level

1. Select the item(s) you want to show/hide.
2. Click the **Condition** tab.
3. From the **Condition** drop-down list, select one of the following:
   - **Logged In as User** to show the items only when user is logged in with the User password
   - **Logged In as Admin** to show the items only when user is logged in with the Admin password

   **NOTE** See *Password-protecting a touchscreen* (page 196) for information on the Admin and User passwords.
4. Click **OK**.

#### Based on a microblock property's value

1. Select the item(s) you want to show/hide.

   ![TIP](image.png) *To add conditional expressions to the list, see *To add a condition to a System Touch screen* (page 194).*
2. Click the **Condition** tab.
3. From the **Condition** drop-down list, select a custom condition to show when the condition is true.
4. Click **OK**.
To add a condition to a System Touch screenfile

1. In the Control Properties window, click the Condition tab.
2. Click .
3. Type the path to the microblock's property; see To define paths for .stv file (page 192).
4. Select an operator (page 195) from the drop-down list.
5. Optional: If selecting an operator other than is TRUE or is FALSE, select an option in the Value 2 field and enter a value in the box.
6. Click OK.

To edit a show/hide condition

1. Select the control whose condition you want to edit or remove.
2. Click the Condition tab.
3. Select the condition to edit from the Condition drop-down list.
4. Click the Condition button.
5. In the Value 1 field, enter the path to the microblock property.
6. Select an operator from the drop-down list.
7. In the Value 2 field, select an option and enter the value.
   NOTE This field is active only if you selected an operator other than is TRUE or is FALSE in step 6.
8. Select one of the following:
   ○ Selected Item Only to have the change apply only to the item you opened the Show/Hide Condition window from. The new condition is added to the Condition list when you close the window.
   ○ Wherever Used to have the change apply to all controls using this condition.
9. Click OK.

To remove a condition from a control

1. Select the control whose condition you want to remove.
2. Click the Condition tab.
3. Select None from the Condition drop-down list.
   NOTE You cannot remove a condition from the list. But, if it is not assigned to anything, ViewBuilder removes it from the list the next time you close the file.
Operators

An operator defines how each piece of an expression is to be handled. For example, an operator can compare or perform an action between the value of a microblock property, a literal value, or the result of an expression. The following table lists operators that can be used in expressions.

**NOTE** Only one operator can be used at a time. For example, it is not possible for the touchscreen to put ">30 and <60".

<table>
<thead>
<tr>
<th>Operators that return true/false</th>
<th>Is true</th>
<th>Is false</th>
<th>Equal to</th>
<th>Not equal to</th>
<th>Greater than</th>
<th>Greater than or equal to</th>
<th>Less than</th>
<th>Less than or equal to</th>
</tr>
</thead>
<tbody>
<tr>
<td>is TRUE</td>
<td>Compares data. Returns true if the value of the expression or condition is true.</td>
<td>Compares data. Returns true if the value of the expression or condition is false.</td>
<td>Compares data. Returns true if the value on both sides of the operator are equal.</td>
<td>Compares data. Returns true if the value to the left of the operator does not match the value to the right.</td>
<td>Compares numeric data. Returns true if the value to the left of the operator is larger than the value to the right.</td>
<td>Compares numeric data. Returns true if the value to the left of the operator is larger than or equal to the value to the right.</td>
<td>Compares numeric data. Returns true if the value to the left of the operator is smaller than the value to the right.</td>
<td>Compares numeric data. Returns true if the value to the left of the operator is smaller than or equal to the value to the right.</td>
</tr>
<tr>
<td>is FALSE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Password-protecting a System Touch

To provide security for your touchscreen device, you can assign different password levels to your screens and to individual controls, values, or objects. Security levels are set on the **Tools > Screens** dialog box and on the control's **Condition** tab.

<table>
<thead>
<tr>
<th>A user with this password level...</th>
<th>Can view or gain access to all screens, controls, values, or objects...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Factory</td>
<td>regardless of security levels assigned. <strong>NOTE</strong> This password is intended for a factory-authorized technician and can only be changed in the ViewBuilder application.</td>
</tr>
<tr>
<td>Admin</td>
<td>except those that have Factory assigned.</td>
</tr>
<tr>
<td>User</td>
<td>except those that have Factory or Admin assigned. <strong>NOTE</strong> A touchscreen device has a single User password shared by its operators.</td>
</tr>
<tr>
<td>None</td>
<td>that have no security level assigned to them. <strong>NOTE</strong> No password required.</td>
</tr>
</tbody>
</table>

To assign a security level to a control

1. With a control selected, click the **Condition** tab in the **Tools** window.
2. Select a security level from the **Condition** drop-list.
3. Click **File > Save**.

Example: **Duration** control set to **Admin**.

To assign a security level to a screen

1. On the **Tools > Screens** dialog box, select the screen.
2. Select one of the password levels.
3. Click **File > Save**.
Example: *Module Status* screen set to *User*.

![Image of Module Status screen with options for User, Admin, and Factory levels]

**To create a Factory password for a touchscreen**

1. Select **Configure > View Properties**.
2. Type a valid password in the Factory **Password** field and confirm it.
3. Click **OK**.

Create, edit, or lock the **Admin** and **User** passwords using the instructions below.

---

**To allow password management on a touchscreen**

To allow passwords to be changed on a touchscreen device:

1. Select **Configure > View Properties**.
2. Check **Allow password management on touchscreen**.
3. Check the **Reset touchscreen to these passwords**.
4. Type or edit valid passwords in the **User** and **Admin Password** fields.
5. Click **OK**.
To lock passwords on a touchscreen

To lock the User and Admin passwords on a touchscreen device:

1. Select **Configure > View Properties**.
2. Check **Always use these passwords**.
3. Type or edit valid passwords in the **User** and **Admin Password** fields.
4. Click **OK**.
Creating a non-English System Touchscreen

**NOTE** If the non-English language uses non-ASCII characters, the names of your touchscreen file and any inserted image files must contain only ASCII characters.

To create a touchscreen file that can show multiple languages, use one of the following methods to create the non-English screens in ViewBuilder.

- Add the non-English text in the ViewBuilder interface (page 140)
- Export a language file, translate the terms, then import the new language file (page 200)

To add non-English text in the ViewBuilder Interface

1. Select **Configure > View Properties**.
2. Under **Supported Languages**, select the languages you want to use in the touchscreen file. The languages you select will appear in the droplist on ViewBuilder's toolbar.
   
   **CAUTION** Do not uncheck **English**. Although you may not use this language in your screen file, some versions of the touchscreen device's firmware require that English be checked.
3. Click **OK**.
4. On ViewBuilder's toolbar, select the active language you want to use.

5. Create the screens, typing all static text in the language you selected in step 4.
6. If you want the touchscreen device to display multiple languages, select another language in the active language droplist.
7. Select each control in the project and type its text in the new language.
   
   **TIP** You can switch back and forth between the languages in the droplist to verify the current screen's text in the different languages.
8. Save your touchscreen file.
NOTE Some controls, such as the Date control, have formatting that might differ in various parts of the world. Be sure to select the appropriate format for the active language you selected.

To export/import language files

1. On ViewBuilder's toolbar, select the active language you want to use.

2. Create the screens, typing all static text in the language you selected in step 1.

3. Select Configure > View Properties > Languages.

4. In the Supported Languages section, select the language to be exported and click [Export].

   The file is exported to i-Vu_Pro_x.x\webroot\language_resources\language.map, where language is the actual name of the language. For example, english.map.

   TIP In the window that appears, highlight the path, and then press Ctrl+C to copy it. You can later paste it into Windows Explorer to locate the file.

5. Click OK.

6. In Windows Explorer, locate and open the language.map file in a text editor such as Notepad.

7. Translate each term into the language you want to use.

8. Save the file to i-Vu_Pro_x.x\webroot\language_resources\language.map, replacing language with the actual language name. For example, french.map.
9 Repeat steps 5–7 for any other languages the touchscreen device is to display.

10 Select Configure > View Properties > Languages.

11 In the Supported Languages section, click Import.

12 Browse to the language file(s) stored in step 8 above.

13 Select the language file(s) to be imported and click Import.

14 The import process adds the language(s) to the project's supported languages and to the toolbar droplist. Select each language in the droplist and then view each screen to verify the controls are spaced correctly and do not overlap.

15 Save your touchscreen file.
A BACview device is a combination keypad/display that you can attach to a controller to view or change its property values or its real-time clock without having to access the system's server. BACview devices are available in the two sizes shown below.

The Virtual BACview application is a software version of the large BACview device shown below. The Virtual BACview application runs on a laptop connected to a controller's Local Access port, and it has the same functionality as the BACview device.

In ViewBuilder, you:
- Create the screens that a BACview device or the Virtual BACview application will display
- Test the navigation between screens
- Save the screens in a single .bacview file
Follow the process below to create screens.

1. Make a new BACview file or open an existing file (page 208).
2. Make the BACview screens (page 209).
3. Add text, controls, headers, and footers (page 212).
4. Add navigation (page 218).
5. Password-protect the screens (page 221).
6. Set up alarms (page 222).
7. Save, assign, and download the BACview file (page 223).
Getting to know ViewBuilder's BACview® interface

When you make a BACview file in ViewBuilder, ViewBuilder displays a simulation of a BACview device. You make your screens directly in the simulation's display, and you click the simulation's keys to test the navigation between screens.
To move the cursor in a screen

Use your keyboard's arrow keys to move the cursor in the screen. You can also use the following keys on your keyboard.

<table>
<thead>
<tr>
<th>Press...</th>
<th>To jump to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>The first cell of the line the cursor is in</td>
</tr>
<tr>
<td>End</td>
<td>The last cell of the line the cursor is in</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>The first cell of the screen's first line</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>The last cell of the screen's last line</td>
</tr>
</tbody>
</table>

**NOTE** Hold down **Shift** while pressing the above keys to select everything from the cursor's current position to the new position.

To add lines to a screen

1. Click the **Screens** tab in the **Tools** window.
2. In the **Number Of Lines** field, click to add a line below the line the cursor is in.

**NOTES**
- Click to delete the line the cursor is in.
- To see all of a screen that exceeds the length of the BACview display, select **Extended View**.

To select or move objects

Objects on a screen are either text that you typed on the screen or controls that you added to the screen. See *Adding text, controls, headers, and footers (page 212)*.

You must select an object to perform any action on it.
- Click a control to select it.
- Click and drag across text to select it.
- Click and drag across multiple objects in a screen to select the objects.

To move a selected object, click and drag it to a new location in the screen.
**To copy an object**

Alt+click and drag a control to create a copy of it on the same screen.

To copy a selected object(s) from one screen to another:

1. Select the object(s), then click 📦.
2. On the new screen, click 📦.
3. Click and drag the object(s) to the desired location.

**To undo or redo actions**

Click ⚡ on the toolbar as many times as necessary to undo actions that you performed, beginning with the most recent action. Click ⚡ to redo the action.

You can also click the drop-down arrow to the right of the Undo or Redo button to select an action from a list that begins with the most recent action. Selecting an action will undo or redo that action, plus all actions above it in the list.
### To create a new BACview® file or open an existing file

1. Do one of the following:

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
</table>
| Create a new BACview file | **File > New**, then select one of the following:  
  - **BACview (4x40)** to make screens for a large BACview device  
  - **BACview (2x16)** to make screens for a small BACview device |
| Open an existing BACview file created in ViewBuilder | **File > Open**, then select the file.  
**NOTE** If the file is not listed, verify that the **Files of Type** selection lists BACview files. |
| Import a BACview HTML file that was not created in ViewBuilder | **File > Import > BACview HTML**, then select the file.  
**NOTES**  
  - If the HTML file is for a small BACview (2x16), add `type="small"` to the HTML file's `<BODY>` tag before importing.  
  - **EXAMPLE**: `<BODY type="small">`  
  - If ![ appears in ViewBuilder's lower right corner, click the triangle to see import errors or warnings. These details are available until you save the file.  
  - If your BACview file was created in BACview Artist, export it to HTML in BACview Artist, then import the HTML file in ViewBuilder. |

2. Select **File > Save As**.

3. Browse to a convenient location on your computer.

4. Type a **File Name**, then click **Save**. ViewBuilder adds the `.bacview` extension to your file name.

**NOTE** To record information about the file, select **Configure > View Properties**, then type your name and comments on the **Summary** tab. **Revision History** shows each time the file was saved and the workstation it was saved on.
Making BACview® screens

A .bacview file includes the default screens listed below and any screens that you create in ViewBuilder.

Default screens

Every BACview file contains the screens listed below. The standby and home screens automatically display in the BACview device, but you must provide navigation to a system screen to have it display. See Adding navigation (page 218). The home and standby screens are editable; system screens are not editable.

NOTE The Clockset and Comm screens contain links to other screens that are not listed in the Tools window in ViewBuilder because you do not edit them or provide navigation to them. These linked screens are also shown below.

<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>standby</td>
<td>Displays when the BACview device has had no operator activity for the time specified in the Keypad Inactivity timeout field in the controller driver. Leave this screen blank or add controls or text (page 212) to display information such as the date and time. Do not add lines to the standby screen.</td>
</tr>
<tr>
<td>home</td>
<td>Displays when an operator presses a key while the BACview device is in standby mode.</td>
</tr>
<tr>
<td></td>
<td>CAUTION Because this is the first screen that you see when the BACview device is activated, you must add navigation (page 218) to other screens in the system.</td>
</tr>
</tbody>
</table>

System screens

Displays if the screen the operator selected requires a password.

<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGIN</td>
<td>Displays if the screen the operator selected requires a password.</td>
</tr>
<tr>
<td>USERPW</td>
<td>Lets the administrator set the user-level password.</td>
</tr>
</tbody>
</table>

NOTE The Clockset and Comm screens contain links to other screens that are not listed in the Tools window in ViewBuilder because you do not edit them or provide navigation to them. These linked screens are also shown below.
<table>
<thead>
<tr>
<th>Screen name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALARM</td>
<td>Displays alarms received by the controller. You must define the alarms in ViewBuilder to have them display. See Setting up alarms (page 222).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Module Event History (100 most recent)</th>
</tr>
</thead>
<tbody>
<tr>
<td>========= ACTIVE ALARMS =========</td>
</tr>
<tr>
<td>None in buffer.</td>
</tr>
<tr>
<td>========= ACTIVE FAULTS =========</td>
</tr>
<tr>
<td>None in buffer.</td>
</tr>
<tr>
<td>====== RETURNED-TO-NORMAL (RTN) ======</td>
</tr>
<tr>
<td>None in buffer.</td>
</tr>
<tr>
<td>====== MANUALLY CLEARED (CLR) ======</td>
</tr>
<tr>
<td>None in buffer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CLOCKSET</th>
<th>Lets an operator adjust the current time and date in the controller’s real-time clock.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Set Current Time/Date (24 hr clock)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time (hh:mm:ss): [22]: 02 : 12</td>
</tr>
<tr>
<td>Date (dd-mm-mm-yyyy): 01 - Nov - 09</td>
</tr>
</tbody>
</table>

The [->DST] link jumps to the following screen where an operator can adjust the beginning and ending dates for daylight savings time. |

<table>
<thead>
<tr>
<th>DST</th>
<th>Start Time: [02]: 00</th>
<th>Amount: 060</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry#</td>
<td>Beg (mm-dd-yyyy)</td>
<td>End (mm-dd-yyyy)</td>
</tr>
<tr>
<td>0</td>
<td>Mar 08 2009 Nov 01 2009</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Mar 14 2010 Nov 07 2010</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Mar 13 2011 Nov 06 2011</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Mar 11 2012 Nov 04 2012</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Mar 10 2013 Nov 03 2013</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Mar 09 2014 Nov 02 2014</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Mar 08 2015 Nov 01 2015</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Mar 13 2016 Nov 06 2016</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Mar 12 2017 Nov 05 2017</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Mar 11 2018 Nov 04 2018</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>KEYPAD</th>
<th>Lets an operator define:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The amount of time of inactivity before the standby screen is displayed</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** This time can also be defined in the driver. |

• The priority (1–16) the BACview device uses to write to BACnet properties. 1 is the highest priority, 16 is the default. |

<table>
<thead>
<tr>
<th>========= Keypad Configuration =========</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactivity Timeout: [10] minutes</td>
</tr>
<tr>
<td>BACnet Write Priority: 0</td>
</tr>
</tbody>
</table>

**NOTE** System screens are a part of the BACview firmware. If a screen in the firmware is changed between releases of ViewBuilder, the ViewBuilder screen may look different than the actual BACview screen.
To add new screens

1. Click the Screens tab in the Tools window.
2. Do one of the following:
   - In the screen list, double-click "untitled", then type a descriptive name.
   - Click to add a new blank screen, then change its name.
   - Select an existing screen, click to make a copy of it, then change the copy's name. You cannot copy a system screen (page 209).

**NOTE** To delete a screen, select the screen name, then click . You cannot delete any default screen (page 209).
Adding text, controls, headers, and footers to BACview® screens

You can add text, controls, headers, and footers to a BACview screen. If needed, you can increase the size of a screen by adding up to 100 lines.

⚠️ CAUTION Typing text or placing a control on top of an existing control deletes the existing control.

To add text

Click in the cell where you want the text, then begin typing.

You can also copy text from another application and then paste it into a BACview screen.

To delete text, click and drag across the text to select it, then click ✗ or press Delete.

To add a BACview control

1. Click the Add Control tab in the Tools window.
2. Select a control. See BACview controls and their properties for a description of each control.
3. Click on the screen where you want the control.
   
   NOTE If you select a control and then decide you do not want to add it to the screen, press Esc.
4. Edit properties for the control in the Control Properties window. See BACview controls and their properties.
5. Click on the screen or press Enter on your keyboard to apply the properties.

   NOTE To copy a control or text:
   • Press Ctrl+c to copy the item and Ctrl+v to paste it on the same screen or a different screen.
   • Press Alt as you drag the item to a new location on the same screen.
## BACview controls and their properties

Each control, its usage, and the properties you define are described in the table below. The first three controls have the following properties in common.

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Name</td>
<td>Use ViewBuilder's System window to <strong>insert the Object Name</strong> (page 215) in this field. Or, you can find the point's Object Name in the i-Vu® interface on the point's <strong>Properties</strong> page &gt; <strong>Details</strong> tab, under BACnet Configuration.</td>
<td><strong>NOTE</strong> You must check <strong>Network Visible</strong> on the point's <strong>Details</strong> tab.</td>
</tr>
<tr>
<td>Editable</td>
<td>Select to make the control editable in the BACview device.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0 Number</td>
<td>Display any numerical value from an analog microblock.</td>
<td><strong>Digits Left (or Right) of Decimal</strong> - Type the maximum number of digits that can appear to the left (or right) of the decimal. <strong>Show Degree Symbol</strong> - Select to display with a temperature. <strong>Range for Value</strong> - Type a <strong>Minimum</strong> and <strong>Maximum Value</strong> to define the acceptable range of values for the control.</td>
</tr>
</tbody>
</table>

| TT Multi-State Control | Display the status of a microblock. | **Field Width** - Select **Use the length of the longest display value** to have the full text from the **Display** column shown in the BACview device, or select **Use the following value** and then type a number to have ViewBuilder truncate the displayed text to that number of characters. In the **Value-Display** table, edit the entries in the **Value** column to show the actual values that the microblock will produce. Click + to add a row to the table or - to delete a row. For each value, change the **Display** column text to what you want that value to display in the BACview device. **NOTE** If this control is used in a large BACview device, it is editable, and the operator has selected it, the softkeys give him the following options: OK, CANCEL, DECR(EMENT), INCR(EMENT). |


<table>
<thead>
<tr>
<th>Use this control...</th>
<th>To...</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-State Control (Large BACview device only)</td>
<td>Display the status of a microblock and assign point values to softkeys.</td>
<td><strong>Field Width</strong> - Select <em>Use the length of the longest display value</em> to have the full text from the <strong>Display</strong> column shown in the BACview device, or select <em>Use the following value</em> and then type a number to have ViewBuilder truncate the displayed text to that number of characters. In the <strong>Value-Display-Softkey</strong> table, edit the entries in the <strong>Value</strong> column to show the actual values that the microblock will produce. Click to add a row to the table or to delete a row. For each value, change the <strong>Display</strong> column text to what you want that value to display in the BACview device. <strong>NOTE</strong> The last value, NOP, gives the operator a means to cancel editing the control. You cannot delete this row. If you make the control editable, you can assign values to softkeys that the BACview operator can use to edit the point's value. To do this, select a <strong>Softkey</strong> in the table for each value. Click to add values to the table, or to delete values.</td>
</tr>
<tr>
<td>Date</td>
<td>Display the date in the controller's real-time clock.</td>
<td><strong>Date Format</strong> - Choose how to display the date.</td>
</tr>
<tr>
<td>Time</td>
<td>Display the time in the controller's real-time clock.</td>
<td><strong>Time Format</strong> - Choose how to display the time.</td>
</tr>
<tr>
<td>Link</td>
<td>Add a link to another screen.</td>
<td>See <em>To add a link to a screen</em> (page 218).</td>
</tr>
</tbody>
</table>

**NOTE** If editing a control's property causes the control to overlap another control or to expand past the edge of the screen, the control appears in red to indicate the error. Drag the control to a new location.  

**EXAMPLE** In the figure below, the date format was changed from MM/YYYY to MM/DD/YYYY.
To have ViewBuilder insert object names

Use the System window to insert the Object Name in the Control Properties window.

1. If you do not see the System window, click  on the toolbar.
2. In the System window, select the system you want from the drop-down list.
3. Click Next.
4. In the Name field, select your user name from the drop-down list.
5. Type your Password.
6. Click Next.
7. In the system tree, select the point for the control you want to program.
8. Do one of the following:
   - Right-click the Object Name field in the Control Properties window, then select Set Object Name.
   - Select Edit > Set Object Name in ViewBuilder’s menu.

To add headers and footers

A header is an area at the top of a screen that does not scroll; a footer is at the bottom.

1. Click the Screens tab in the Tools window.
2. Set the number of rows for a header or footer in the Header or Footer field.

   EXAMPLE  Set the Header field to 1 to have the first row be a header; set the Footer field to 2 to have the last 2 rows of the screen be a footer.

   NOTE  The total number of lines you can use for a header and footer are 3 on large BACview device and 1 on a small BACview device.
Setting items on a BACview screen to show/hide

You can set controls, text, or complete rows on a BACview® screen to show or hide based on one of the following:

- The value of a microblock property
- The password level of the user

**EXAMPLE** You want to create a single control program and screen file that can be used in multiple applications. In the control program, you enable a microblock for one application, but disable it for another application. In the screen file, you set information that applies to that microblock to show when the microblock is enabled and hide when it is disabled.

To set items to show/hide

**Based on a microblock property's value**

1. Select the item(s) you want to show/hide.
2. Click the button on the toolbar.
3. In the **Object Name** field, type the microblock property's object name or select it from the drop-down list. You can use ViewBuilder's **System** window to find the object name (page 215).
4. In the **Show When** field, select:
   - True to show the information when the value of a binary microblock is 1 or the value of an analog microblock is anything other than 0.
   - False to show the selection when the value is 0.
5. Click **OK**.

**Based on the user’s password level**

1. Select the item(s) you want to show/hide.
2. Click the button on the toolbar.
3. In the **Object Name** field, select one of the following from the drop-down list:
   - Sys.Exec.IsAdminLevel to show/hide the selected items to a user logged in with the Admin password
   - Sys.Exec.IsUserLevel to show/hide the selected items to a user logged in with the User password

**NOTE** See Password-protecting a BACview screen (page 221) for information on the Admin and User passwords.
4. In the **Show When** field, select True.
5. Click **OK**.
NOTES

- The cells that you assigned the show/hide condition to are highlighted by a color. A different color is used for each unique condition.
- To move an item and its condition, hold down Ctrl as you drag the item.
- To copy an item and its condition, hold down Alt as you drag the item.
- Items moved or added into cells that have a show/high condition may or may not assume the condition. If you do not get the results you want, change the show/hide condition or click \( \text{undo} \) to undo the action.
- If you hide part of a row, the cells will be blank when the screen is viewed in a BACview device. If you hide an entire row, the row will be completely removed from the screen. Design your screen so that a large BACview device will never have less than 4 rows and a small BACview device will never have less than 2 rows.

To edit or remove a show/hide condition

1. Select the cells whose condition you want to edit or remove.
2. Click \( \text{on the toolbar.} \)
3. Do one of the following:
   - To edit a condition, change the Object Name or Show When field.
   - To remove a condition, delete the text in the Object Name field.
4. In the Apply To field, select:
   - Selections only to have the changes apply only to the selected cells.
   - Wherever Used to have the changes apply everywhere that the condition is used.
5. Click OK.
Adding navigation to BACview® screens

You can give an operator the following methods of moving from one screen to another:

<table>
<thead>
<tr>
<th>When you provide a...</th>
<th>The operator...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link</td>
<td>Uses the arrow keys to select the link, then presses <strong>Enter</strong> to go to the linked screen</td>
</tr>
<tr>
<td>Softkey link (Large BACview device only)</td>
<td>Presses the softkey below the link</td>
</tr>
<tr>
<td>Hotkey (Large BACview device only)</td>
<td>Presses <strong>FN</strong> plus the number key assigned to a particular screen</td>
</tr>
</tbody>
</table>

To add a link

If you place a link on a screen, the operator can use the arrow keys to select the link, and then press **Enter** to go to the linked screen.

To add a link:

1. Click the **Add Control** tab in the **Tools** window.
2. Select **Link**.
3. Click in the screen where you want the link.
4. In the **Control Properties** window, do one of the following:

<table>
<thead>
<tr>
<th>If you want the link to go to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A specific screen</td>
<td>In the <strong>Link to Screen</strong> field, select the screen the link will jump to.</td>
</tr>
<tr>
<td>The previous screen</td>
<td>Check <strong>Previous Screen</strong>.</td>
</tr>
</tbody>
</table>

5. In the **Link text** field, type the text that you want your screen to show for the link.

**NOTE** This field is not editable if you link to a system screen (page 209).
To add a softkey link

If you assign a softkey number to the link directly above the softkey, the operator can press that softkey to jump to the linked screen.

To add a softkey link:

1. Click the **Add Control** tab in the **Tools** window.
2. Select **Link**.
3. Click in the screen directly above the softkey that you want to be the link. See figure below.
4. In the **Control Properties** window, do one of the following:

   **If you want the link to go to...** | **Then...**
   --|---
   A specific screen | In the **Link to Screen** field, select the screen the link will jump to.
   The previous screen | Check **Previous Screen**.

5. In the **Link text** field, type the text that you want your screen to show for the link.
   **NOTE** This field is not editable if you link to a system screen (page 209).

6. Select the softkey number in the **Assign to Softkey** field.
To assign a hotkey to a screen

If you assign a hotkey number to a screen, an operator can press FN plus that number to jump to the screen.

<table>
<thead>
<tr>
<th>If you want a hotkey to go to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A specific screen</td>
<td>1  Click the Screens tab in the Tools window.</td>
</tr>
<tr>
<td></td>
<td>2  Select the screen name.</td>
</tr>
<tr>
<td></td>
<td>3  Select the hotkey number in the Hotkey field.</td>
</tr>
<tr>
<td>The previous screen</td>
<td>Select a hotkey number in the Previous Screen Hotkey field.</td>
</tr>
</tbody>
</table>

💡 TIP  Create a screen that shows all the hotkeys and their destinations.

To test the navigation

<table>
<thead>
<tr>
<th>To test a...</th>
<th>Click anywhere outside the BACview screen and then click...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link</td>
<td>The arrow keys to select the link (the link will have brackets around it). Then click Enter.</td>
</tr>
<tr>
<td>Softkey link</td>
<td>The softkey below the link.</td>
</tr>
<tr>
<td>(Large BACview device only)</td>
<td></td>
</tr>
<tr>
<td>Hotkey link</td>
<td>FN and then the hotkey number assigned to a screen.</td>
</tr>
<tr>
<td>(Large BACview device only)</td>
<td></td>
</tr>
</tbody>
</table>
## Password-protecting a BACview® screen

To provide security for your i-Vu® system, you can assign a password level to a screen on the Screens tab in the Tools window.

<table>
<thead>
<tr>
<th>A screen with this password level...</th>
<th>Can be accessed by...</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Anyone, but to edit a field in this screen, the operator must log in with either the User or Admin password.</td>
</tr>
<tr>
<td>User</td>
<td>An operator logged in with the User or Admin password.</td>
</tr>
<tr>
<td>Admin</td>
<td>An operator logged in with the Admin password.</td>
</tr>
</tbody>
</table>

Create the 4-digit Admin and User passwords using the instructions below.

### To create the Admin password

1. In ViewBuilder's menu, select **Configure > View Properties**.
2. Type any 4-digit number in the **Admin Password** field.

### To create the User password

A BACview device has a single User password shared by its operators. You do not create this password in ViewBuilder. The person with the Admin password creates the User password on the BACview device after the .bacview file has been downloaded to the controller.

To create the User password:

1. Navigate to the **USERPW** screen on the BACview device.
2. Log in with the Admin password.
3. Type any 4-digit number as the User password.
Setting up alarms for a BACview® device

The BACview Alarm LED turns on (and the BACview horn may sound) when its controller receives a BACnet alarm that you set up on the Alarms tab in the Tools window. An operator can view the alarm description on the ALARM screen.

To set up an alarm:

1. Click the Alarms tab in the Tools window.

2. Click the + to add an alarm.

3. Double-click that alarm’s Alarm Name cell, then change the existing text to the alarm’s BACnet Object Name.

4. Double-click the alarm’s Description cell, then change the existing text to the description that you want to appear on the ALARM screen.

5. Check Use Horn? to have the BACview device audibly notify an operator when it receives an alarm.

NOTES

- To delete an alarm, select the alarm, then click -.
- Click a column heading on the Alarms tab to sort the alarms.
- You should enable each alarm’s Return to Normal field in the i-Vu® interface to prevent the Alarm LED and horn from remaining on until an operator can clear the alarm.
**To save, assign, and download the BACview® file**

1. Save the .touch or .bacview file to a convenient location on your computer. Then, in the i-Vu® interface:
2. Right-click the controller and select **Driver Properties** to attach the screen file.
3. **Download All Content** to the controller.

**NOTE** If the controller has an **Router Config Mode** DIP switch, make sure that this DIP switch is off when connecting a touchscreen device.
## Document revision history

Important changes to this document are listed below. Minor changes such as typographical or formatting errors are not listed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Topic</th>
<th>Change description</th>
<th>Code*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>No changes yet</td>
<td></td>
</tr>
</tbody>
</table>

* For internal use only